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=========================== Introduction 

INTRODUCTION 

All tbe neat things you can do with your Mac can 
become overwhelming at times! How can you possi­
bly remember everything from how to type a • (bullet) 
to what's the difference between the Save and Save As 
commands? 

How often do you ask yourself ... 

How do I get my document to print ... Do I check the 
Control Panel? Is it the Chooser that affects 
printing ... How do I copy a new typeface onto my 
system? Should I use the Font/DA Mover? How do I 
save that make-or-break-my-career document to a 
floppy disk to take home? What is data conversion? I 
keep hearing about it. Is it something that I should 
know about? And System 7. Should I avoid it like the 
plague? Should I wait? 

You can wait. Or, you can read The Little Mac Book. 

What you're looking for is right here at your finger­
tips. No more dragging out the documentation or 
seeking out the company Mac-head. No more scary 
trial-and-error attempts. OK, well maybe some trial­
and-error, but less of it ... 

,-Jf ow This Book Is Different t 
The Little Mac Book is unique for several reasons: 

• It's little. 
• It's convenient. 
• It's concise. 
• It's versatile. 
• It's task-oriented . 

Never mind bits and bytes-how do you make things 
happen? 



The Little Mac Book ========== 

The Little Mac Book is a quick reference guide to the 
Macintosh family of computers. This book helps you 
learn the skills you need to get more out of any Mac. 
Because this book is organized alphabetically, it en­
ables you to locate information quickly on many 
aspects of the Macintosh computer. 

The Little Mac Book is organized into five parts. 

• The first section, "Macintosh Topics," discusses 
important terms and conceptS so that you can 
get your Mac to do what you want it to do. 

• The second section, "System 7 First Look," gets 
you started with Apple's new operating 
system. 

• The third section, the "Quick Key Guide," tells 
you how to make all those neat characters­
from bullets to shadow boxes. The guide then 
lists the important keyboard shortcutS for 
some of the major Macintosh applications. 

• The fourth section contains an informative 
glossary of common Macintosh terms. 

• The final section, the index, provides an 
extensive cross-reference of topics. 
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, How To Use This Book a.I;;;;;;;;;;;;;;;;;;;;;; 

The Little Mac Book is organized so that you easily can 
find the topic you want. Entries appear in alphabeti­
cal order. If you have a topic such as copying, look 
under C. For startup screen, look under S. (You get 
the idea.) To find out what System 7 brings, refer to 
the second part of the book. To create a registered 
trademark symbol, ®, consult the Special Characters 
section of the "Quick Key Guide." To see how to align 
text using Filemaker Pro, look under Program­
Specific section of the "Quick Key Guide." As you read 
this book and find terms with which you are not 
familiar, consult the glossary. The comprehensive 
index provides a further detailed guide to the topics 
contained in this book. 

Using a Macintosh computer is easy, and the conven­
tions chosen for this book reflect the ease of opera­
tion. 

Keystrokes you must type and menus you select 
appear in boldfaced blue type. With many Macin­
tosh commands, you press and hold one key and then 
press another key. For example, you press and hold 
the Command key (38) and press the S key to save. In 
this book, the operation is presented as 38-S. 

Almost everything you read about in this book applies 
to every Macintosh. To learn more about any feature 
or topic in this book, consult The Big Mac Book, 2nd 
Edition, also published by Que Corporation. 

Good luck, take your time, and have fun! 
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MACINTOSH TOPICS 

The following section contains a listing of major 
topics related to owning and operating a Macintosh 
computer. The topics are listed alphabetically so that 
you easily can find the information you need. In 
addition, cross-references are provided so that you 
can find information of additional interest. Although 
you may want to browse through this entire section, 
feel free to start with any topic. 

, Alarm Clocklm-iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii;;;; 

Located under the Apple w menu, this desk accessory 
displays an on-screen clock. The Mac retains Alarm 
Clock information when you turn off the power as 
long as you have a working battery in your computer. 
The clock provides the time, the date, and an alarm. 
Like other desk accessories, the Alarm Clock is available 
at any time while you are using your Mac. 

To change the Alarm Clock settings 
1. From the Apple w menu, select Alarm Clock. 

2. Click on the toggle switch on the right side of 
the Alarm Clock (see fig. A.1). (The toggle 
switch opens a closed box and closes and open 
box.) 

3. Click on the appropriate icon for the clock, the 
alarm, or the date. 

4. Click on a specific time, date, or alarm setting 
in the middle panel. A small set of arrows 
appears to the right of the current setting. 

5. Click the up arrow to advance the setting or 
the down arrow to retard it. You also can type 
any new information. 
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Notes 

Click here to activate the alarm 

I D 6:00:24 PM~ I 

Click the toggle switch to 
open/close the alarm 
clock box. 

Time Date Alarm 

Fig. A 1. The Alarm Clock. 

6. To activate the alarm setting, click on the 
switch to the left in the middle panel. The 
alarm clock should resemble the flashing alarm 
clock in Figure A. l. 

7. When you finish changing the settings, click 
the small toggle lever to the right in the top 
panel and click the close box. 

You can set only one alarm. If the time set for the 
alarm passes when your Mac is turned off, you hear 
the alarm beep the next time you tum on your Mac. 
If the sound is set to zero, the menu bar flashes. The 
apple in the menu bar flashes until you open the 
Alarm Clock from the Apple menu. 

See also Clock and Desk Accessories. 

-j Alert Boxes l a; iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii-

You will make mistakes, but your Mac does every­
thing it can to prevent you from making them. The 
Alert Box warns you when you are about to do 
something risky. You find Alert Boxes throughout 
Macintosh activities. Alert Boxes contain the follow­
ing elements: 

• A question asking if you really want to proceed 
with a particular action. 
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• A button that enables you to complete the 
procedure (see fig. A.2) . 

• A button that enables you to cancel the proce­
dure. 

• Some other option, depending on the part of 
the system with which you are working. 

[( OK 

Are you sure you want to remoue the 
11ppllc11tlon "Microsoft Word"? 

]J [Cancel J 

Fig. A2. An Alert Box. 

To respond to an alert 
Click OK if you are ready to take the plunge 

or 

Click Cancel to re-evaluate the situation. 

Notes 
To select the default (the button with the dark bor­
der) , you also can press the Return or Enter key. 

To cancel certain operations, you also can try press­
ing 3€-. (period). 

If in doubt, the safest response to most Alert Boxes is 
to select the default. 

See also Dialog Box. 

An alignment setting determines how the left and 
right margins of text line up on a page. 
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The term "alignment" also is used in drawing pro­
grams to refer to objects lining up in relation to each 
other across a horizontal or vertical grid. 

Most programs provide a particular set of menu 
commands or keystrokes that align text. Many word 
processing programs enable you to align text or 
graphics using more than one technique, such as 
selecting alignment or justification under the Format 
menu or selecting an alignment box on the ruler line 
(see figs. A.3 and A.4). 

This text is left-justified. This text 

is left-justified. This text is left­

justified. 

This text is right-justified. This 

text is right-justified. This text is 

right-justified. 

This text is centered. This text is 

centered. This text is centered. This 

text is centered. 

This text is justified. This text is 

justified. This text Is justified. This 

text is justified. This text is justified. 

Fig. A3. Four different types of alignment. 

Ht ~ t. I •1=i l=I •= J..&.J 

Microsoft Word alignment 
options appear on the 
ruler line. 

Fig. A 4. Selecting alignment options from the ruler. 

See also Centering Text and the "Quick Key Guide." 

~AppleShare a;;;I ~~~~~ 
A network is a group of computers that can share 
information and equipment. For example, a network 
enables three PCs to use one printer. For your net­
work to work, you need software to coordinate the 
communications among different devices along the 
network. 
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AppleShare is a network operating system developed 
by Apple Computer, Inc. that transforms a Macintosh 
computer into a centralized file server for an Apple­
Talk network. A file server is a computer that cannot 
be used for anything other than supporting the net­
work. 

AppleShare offers unique features, such as file lock­
ing, speed, and the capability to restrict access to 
certain parts of the network. 

See also AppleTalk and Networking. 

, Apple Talk 1~====iiiiiiiiiiiiiii 
Apple Talk is a local area network standard developed 
by Apple Computer, Inc. AppleTalk combines hard­
ware and software so that a Macintosh computer can 
communicate with other computers. LocalTalk is the 
hardware, and Apple Talk is the set of software network 
protocols that run over the LocalTalk cables. 

Apple Talk is priced right, because every Mac includes 
an AppleTalk network port. The only hardware re­
quirement for an AppleTalk network is a set of con­
nectors and cables. The physical connections among 
the computers and peripherals are made by Apple's 
LocalTalk hardware or third-party hardware such as 
PhoneNet (from Farallon Computing). 

If you are consideringAppleTalk, you can save money 
and extend an AppleTalk network's capabilities by 
usingPhoneNet hardware. Afterequippingeach node 
with a PhoneNet connector (instead of a LocalTalk 
connector), you can wire the network using ordinary 
telephone cables, considerably cheaper than LocalTalk 
cable. In some circumstances, you can use existing 
telephone wiring to create the network. A PhoneNet 
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network can transmit data three thousand feet­
three times the distance of a LocalTal.k network. 

Apple Talk networks are slow compared to high-speed 
systems like EtherNet. However, AppleTal.k's simplic­
ity and low cost make it an attractive option for 
networks of modest size and use. 

See also AppleShare and Networking. 

Adobe Type Manager (ATM) is a Macintosh utility 
from Adobe Systems that displays outline fonts with­
out distortion. This combination control panel de­
vice and INIT is useful especially for large type (greater 
than 12 point-the text in this parapgraph is 10 
point) because it gets rid of the dreaded jaggies (see 
fig. A.S). 

Without ATM 

With ATM 
Fig. A5. A line of type without A1M (top) and with ATM 
(bottom). 

Normally, the Macintosh uses bit-mapped fonts for 
the screen display. For desktop publishing applica­
tions, however, this display technique has drawbacks. 
If you try to display a font in a size not matched by a 
complete set of bit-mapped characters in the System 
Folder, you see grossly distorted characters on-screen. 
ATM tackles this problem by using outline font tech­
nology to display fonts. Because outline fonts are 
constructed from mathematical formulas, they can be 
scaled to any size without distortion. 
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Notes 
ATM has its drawbacks. The program affects the 
appearance of Adobe fonts only. Even Adobe fonts are 
not affected unless you have (in the System Folder) a 
special screen display file for each font you want to 
display. The program comes with Times Roman and 
Helvetica; the user must purchase an expensive add­
in program to obtain screen fonts for the rest of the 
typefaces normally included with PostScript laser 
printers. 

See also Fonts, PostScript, Printing, and System. 

According to Paul Mace, backup guru, there are two 
types of people: those who have lost their data and 
those who will. Regardless of how competent you are 
with your Macintosh, you may someday lose your 
data. You may inadvertently delete an important file 
or suffer from a hardware failure. In any case, be 
prepared for any catastrophe by establishing a regular 
backup procedure. 

Backup procedures 
The simplest backup procedure involves nothing 
more than copying files to a floppy disk. This proce­
dure requires no special software, and you can per­
form it at the end of your work session. 

You can make a backup of your entire hard disk, but 
when you finish, you do not want to repeat this time­
consuming task. Routine backups generally fall into 
two categories. Adifferentialbackup includes all files 
that have changed since the last time you did a 
backup. An incremental backup includes all files that 
you have changed since a certain date. 
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Backup programs 
You also can use one of the many software programs 
available, such as Fastback, Redux, or CAT•BACK. 
These programs permit you to define certain pa­
rameters you want to apply to your backup-such as 
files changed today, or those files beginning with a 
certain name. These programs also permit you to set 
an automatic backup so that you can back up your 
entire hard disk on a regular basis. You determine the 
time increment. You can backup your data to a variety 
of media including floppy disks, tape, hard drives, 
and optical drives. 

Finally, some backup software compresses a file while 
it saves, and therefore can place two, three, or even 
five times more information on a disk or tape. 

To back up aftle by copying itfrom a hard disk to a 
floppy disk 

1. Insert a floppy disk into the floppy drive slot. 

2. Select the file on the Desktop that you want to 
copy. 

3. Drag the file icon on top of the destination 
floppy disk icon. 

4. When the destination icon reverses color, 
release the mouse button. 

To back up more than one file by copying themfrom 
a hard disk to a floppy disk 

1. Insert a floppy disk into the floppy drive slot. 

2. Open the folder or window on the desktop 
containing the file(s) you want to copy. 

3. Press 3C-A to select all the files in the active 
window 

or 

Click on one of the files you want to copy. 
Press and hold the Shift key and click on 



The Little Mac Book ==================== 

another file. Continue until you select all the 
files you want to copy. 

4. Point to one of the highlighted file icons and 
press the mouse button and drag it on top of 
the destination floppy disk icon. 

5. When the icon of the destination disk reverses 
color, release the mouse button. 

To back up the contents of a floppy disk to another 
floppy disk using only one floppy drive (method 1) 

1. Insert the disk containing the files you want to 

copy. 

2. Press a€-E to eject the original disk but leave 
the icon of that disk on the desktop. 

3. Insert the disk you want to copy the files to. 

4. Drag the gray disk icon over the icon of the 
disk you want to copy the files to. 

5. When the icon of the destination disk reverses, 
release the mouse button. 

6. Select Yes to the prompt that asks if you are 
sure (are you?) that you want to replace the 
contents of the destination disk with the 
contents of the source disk. 

To back up the contents of a floppy disk to another 
floppy disk using only one floppy drive (method 2) 

1. Insert the floppy disk containing the files you 
want to copy. 

2. Press a€-N to create a new folder on your hard 
drive. 

3. Double-click on the icon of the floppy disk 
containing the files you want to copy and 
select all files by pressing ag.A. 

4. Drag these files to the new folder. When the 
icon of the new folder reverses, release the 
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mouse button. The files copy to the new folder 
your hard disk. 

5. Drag the icon of the floppy disk to the trash 
can to eject it (it's safe-trust me) . 

6. Insert the disk you want to copy the files to . 

7. Double-click on the new folder on your hard 
disk to open it. 

8. Press 3€-A to select all the files in the new 
folder. 

9. Point to one of the highlighted icons and press 
the mouse button. Drag the highlighted icon 
on top of the icon of the disk you want to copy 
the files to. (The rest of the selected files move 
with the one you drag.) 

10. When the icon of the floppy disk highlights, 
release the mouse button. 

You may then throwaway the new folder you created 
on your hard disk and drag the floppy disk icon to the 
trash to eject it. Put the floppy disk away for safekeep­
ing. 

To back up the contents of a floppy disk to another 
floppy disk using two floppy drives 

1. Insert the floppy disk you want to copy from 
into a floppy drive slot. 

2. Insert the floppy disk you want to copy to into 
the other floppy drive slot. 

3. Drag the icon of the disk containing the files 
you want to copy from on top of the icon 
representing the disk you want to copy to. 

4. Select Yes to the Alert Box prompt asking if 
you are sure (are you?) that you want to 
replace the contents of the destination disk 
with the contents of the source disk. 
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Notes 

It doesn't matter which floppy disk you insert in 
which slot. The important thing is to be certain you 're 
dragging the correct source floppy on top of the 
correct destination floppy. 

Make sure that you lock your source disk by sliding 
the black square in the corner of the floppy disk to the 
open position. Then, if you inadvertently err, you do 
not erase the original disk containing your valuable 
data. 

Be cautious as you copy disks. When you drag one 
disk icon over another, the contents of the source 
disk completely replace the existing contents of the 
destination disk. (This contrasts with sliding individ­
ual files from one disk to another, which does not 
replace data on the destination disk unless the files 
have the same name in both locations.) 

See also Copying, Disks, Ejecting Disks, and Files. 

Many people don't even know that there 's a battery in 
their Mac. They should, because it plays an important 
role. The battery is what keeps all the system settings 
(such as time, date, and the desktop pattern) in force. 
All of this information (and more) is stored in what 
the Mac calls parameter RAM (PRAM). When the 
battery goes, you can still use your Mac, but you will 
have to adjust Control Panel settings each time you 
power up if you want the proper date/time informa­
tion recorded in your files. 
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To check to see if you need a new battery 

If everything works fine on your Mac except for 
incorrect date and time settings, you may need to 
replace the battery. Reset the clock to the correct date 
and time. If the date and time are still incorrect after 
time passes, try replacing the battery. 

To replace the battery in a Mac 128K, 512K, 512Ke or 
Plus 

1. Shut down your machine. 

2. Remove the battery cover located on the back 
of the machine. 

3. Replace the battery and then replace the 
battery cover. 

The battery should last two years. 

To replace the battery in a Mac Classic, LC, Si, Ilcx, 
/lei, and Jlfx 

The battery pops in a logic board inside the machine 
and is relatively easy to replace. Follow these steps: 

1. Shut down your machine and unplug it. 

2. Open the system case by removing the retain­
ing screw located in the center of the back 
panel. Press the tabs on each side of the panel 
and lift gently. Lift the front edge of the cover 
away from the base of the Mac. 

3. Replace the battery located on the logic board. 

4. Close the system and replace the screw. 

The battery should last two years. 

To replace the battery in a Mac SE, SE/30, II, llx 
lfyou own an SE, SE/30, II, or llfx, the battery must be 
soldered onto the logic board. Therefore, if you own 
one of these models, you must go to your nearby 
certified Apple dealer for battery replacement. A 
soldered battery lasts about five years. 
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Note: Your Apple dealer may not be able to perform 
this operation. The dealer may want to replace the 
entire motherboard. 

To replace the battery in a Mac Portable 
The battery in the ponable Macintosh is similar to the 
battery in the Plus. Simply replace it by talcing out the 
old battery from the compartment located on the 
bottom of the unit and snap in a new 9-volt battery. 
The battery should last about two years. 

Notes 
You can use your Mac without the battery, but you 
have to go to the Control Panel to set things such as 
the time and date each time you boot up. 

If you do want to stan fooling around with the inside 
of your Mac and change the battery, remember, you 
may be voiding your warranty. So, read the fine print 
and proceed with caution. 

See also Clock, Control Panel, and RAM. 

The Macintosh alens you in a variety of ways that it is 
operating and all is well (or isn't well!). An audio 
signal is just one of the ways in which a Mac alens you 
that an event has taken place, or that the computer 
requires an action before it can continue. A beep tells 
you that your Macintosh needs attention. 

You control bo~ the type of beep and volume setting 
for the beep via the Control Panel desk accessory. 

To adjust the beep volume 
1. From the Apple w menu, select Control Panel 

(see fig. B.l). 
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2. Select the General icon (scroll if necessary). 

3. Press and drag the speaker volume bar to the 
desired volume. A setting of zero causes the 
menu bar to flash rather than sounding a beep. 

4. Click the close box to register the new settings. 

Control Panel 

; :::::: • R~~~;:s~:n 

Kt11bo•rd 

~ @ 12hr. 0 24hr. 

Monitors 

.. ~ 

"""""""Mo_u•_• _ .... ~-ii RAM Coello l 256K I [;) ~ :, 
3.3 .1 

Fig. B.1. The volume control. 

To change the beep sounds 

2 -
1 
0 -

Sptak•r 
Vol\Jme ......____. 

l. From the Apple 9 menu, select Control 
Panel. 

2. Select the Sound icon (scroll if necessary). 

A selection of sounds appears that includes 
such beep selections as boing, a monkey 
screech, or a clink-dank sound. 

3. Click on the sound you want. 

4. Change the beep volume, if you want. 

5. Click the close box to register the new settings . 

To eliminate the beep sounds 
The easiest way to eliminate sounds is to set the 
volume control to 0. Whenever your Mac needs to 
communicate with you, it will flash the menu bar to 



The Little Mac Book ==================== 

get your attention. You also can insert a headphone 
jack into the audio port on the back of your Mac to 
turn off the beep without fussing with the control 
panel. 

See also CDEVs, Control Panel, and Scrolling. 

-j Bulletin Boards l m;; ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;___, 

A bulletin board system (BBS) is a messaging system 
that is maintained on a computer and can be accessed 
through a modem. You can use bulletin boards to 
disperse information, receive information, down­
load public domain and shareware programs, or have 
interactive chats. For example, the WELL (Whole 
Earth Lectronic Link) has forums on topics such as the 
Mac, Computers, Writing, Baseball, Politics, plus more 
than 50 other topics. Larger, commercial bulletin 
boards, such as CompuServe, have over 500,000 
subscribers. 

See also Modems and Telecommunications. 

{ Buying Hardware lliiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii;;;; 

How in the world can you decide which Mac model to 
buy? The following is a list of questions you should try 
to answer before you go shopping: 

• What do you plan to do with your Macintosh? 

• What types of software do you intend to buy 
(word processing, financial, page layout, and 
so on)? 

• What are the system requirements of the 
software you want to use? 
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• How much money do you have available for 
the complete system purchase? 

• What is the most important feature to you? 
Speed? Expandability? Reliability? 

• Do you need color? 

• What types of printing will you be doing? 
Drafts? Finished work? Envelopes? Mailing 
labels? 

• How much disk storage do you need? What 
will you be saving, and for how long? 

• ·How much money can you afford to spend on 
your backup system? 

• What kind of storage device do you need? Do 
you need a hard disk? 

• Do you plan on celecommunicating? Will you 
need a modem? What speed and features do 
you need? 

• How flexible do you wane your Macintosh to 
be? As hard as it is, try to buy a Macintosh that 
can grow with your needs. 

• What about memory? lM is a safe minimum, 
but 2M may more realistic for memory-inten­
sive programs. 

When you are ready co make a purchase, remember 
the following guidelines: 

• Make sure you understand the terms of your 
warranty and any service contract you sign. 

• Inquire about who to call for help if you have a 
problem or question with your new equip­
ment. 

• Check to see if free training is available with 
your purchase. 

Remember that people are an important resource. 
Talk to friends, clients, and neighbors, and attend a 
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local Macintosh user group to talk to some unbiased 
(and some quite biased) Mac experts. There are 
dozens of Macintosh-related magazines in your near­
by bookstore. Many magazines contain articles and 
informative advertisements that will help you in your 
search. 

It also is important to try a piece of equipment before 
you buy it. Test the software to see that it is truly "user­
friendly" and compatible with your other software. 

The Big Mac Book, 2nd Edition, also by Que Corpo­
ration, contains many tables comparing and contrast­
ing Macintosh hardware and software. The book also 
contains an extensive vendor list and information 
about user groups. 

See also Macintosh Systems, Maintenance, Periph­
erals, and Upgrading. 

Whether you are in the market for an inexpensive 
utility program or an expensive page layout program, 
you should follow some purchasing guidelines in 
order to select software that will meet your needs. 
Although these guidelines cannot guarantee that you 
will not make a mistake, they can help. Before you 
purchase any software, follow these guidelines: 

• Know what you need before you start looking. 
Do your homework and list the features and 
functions you want. Then consult a person 
who currently uses that program to see 
whether the program suits your needs. 

• Read reviews in popular periodicals of both 
the software you think you want and its 
competitor's products. 
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Notes 

• Make sure that you have the hardware to run 
the program (such as a hard drive or sufficient 
memory) . If your local dealer does not know 
what you need, call the manufacturer or a 
computer consultant. 

• If possible, try the package before you buy it. 
Any reputable dealer should permit you to sit 
down and work with the software. 

• Review the documentation that comes with the 
software to ensure that the instructions are 
understandable. 

• Inquire about the software vendor's technical 
support and update policies. Does the manu­
facturer have a toll-free telephone support? 
Can you purchase subsequent upgrades to the 
software for a nominal fee? 

• Make sure that you purchase the latest version 
of the software. Call the manufacturer if you 
are in doubt. Be sure that a major version 
release (from 4.0 to 5.0, as opposed to a minor 
release from 4.1to4.2) isn't right around the 
corner. 

• Be wary of large price cuts in software. Such 
cuts may indicate that a new version of the 
product is imminent or already released, and 
the vendor is trying to sell the old product 
inventory. You may find, however, that some­
times it is cheaper to buy the old version and 
then buy an upgrade. 

Be sure to investigate public domain software, share­
ware, and freeware. There are thousands of programs 
available for little more than the cost of a floppy disk. 
Many are free! Check magazines and your local user 
group for more information. 

See also Database Programs, Desktop Publishing, 
Financial Programs, Graphics Programs, Spread-
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sheet Programs, Utilities, and Word Processing Pro­
grams. 

This standard desk accessory functions as a hand­
held calculator. Like other desk accessories, you may 
access the Calculator whenever you need it. 

You can type the calculations directly from your 
numeric keypad, regular alphanumeric keypad, or 
use the mouse to click on the desired bunons on­
screen. 

Key(s) Action 

+ Add 
Subtract 

* Multiply 

I Divide 
Decimal point 

= , Enter Equals 

c , Clear Clear 

To use the calculator 

1. From the Apple 9 menu, select Calculator. 

2. Type the numbers and operands you want to 
calculate 

or 

Click on the calculator buttons (see fig. C.1) . 

For example, enter 85/96. 

3. Type = , click on the equal sign, or press 
Enter for the result. 
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Fig. C.l. 'The Calculator desk accessory. 

Notes 

You can cut or copy the computed value into any 
other application using the standard Cut, Copy, and 
Paste features. 

See also Copying, Cutting, Desk Accessories, and 
Pasting. 

A Control Panel Device (CDEV) is a utility set, and is 
invoked and controlled through the Control Panel 
desk accessory under the Apple menu. The standard 
CDEVs supplied by Apple are as follows: 

• General 
•Keyboard 
•Mouse 
•Sound 
• Color 
• Monitor 

Although the preceding devices are standard, hun­
dreds of other devices are available that range from 
mini word processors to games. 
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The following chart describes the function of each 
device: 

CDEV 

General 

Keyboard 

Mouse 

Sound 

Startup 
Device 

Color 

Monitor 

What it sets 

Desktop pattern 
Rate of insertion point blinking 
Time and date 
Rate of menu blinking 
Speaker volume 
Size of RAM cache 

Repeat rate for keys; delay 
between pressed key repeat 
How quickly mouse tracks or the 
cursor follows mouse movement, 
and how long your Mac waits 
between clicks when double­
clicking 

Speaker volume; type of sound 
(Beep, Boing) 

Sets which SCSI drive the Mac 
boots from (not available on the 
Plus) 
Hue, saturation, and brightness of 
selected color 

Number of colors or shades of 
gray that appear on the monitor 

To change a CDEV setting 

1. From the Apple • menu, select Control 
Panel. 

2. Select the icon that represents the device you 
want to change (scroll if necessary) . 

3. Make your changes. 

4. Click the close box to register the new settings. 

To copy a new CDEV to your system 

1. Insert the floppy disk containing the new 
CDEV into the floppy drive. 
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2. Double-dick on the icon of the floppy disk to 

reveal the icon of the CDEV you want to 
transfer to your system. 

3. Drag the icon of the CDEVyou want to copy 
on top of the icon of the System Folder on 
your hard disk or startup disk. 

4. When the System Folder icon reverses, release 
the mouse button. 

The initial set of CDEVs are installed with your sys­
tem. Depending on the nature of the device, you may 
have to restart your Mac for the CDEV to be operation­
al. 

See also Contro!Parzel, Copying, DeskAccessories, and 
IN/Ts. 

, Centering Text a;;I ===== 
There are several ways to center text. Usually, once 
you begin typing a letter or creating a report, you may 
decide to center a line of text. All you have to do is 
click somewhere on the line you want to center. 
Then, you can center the text from the ruler, from a 
menu selection, or from the keyboard using a key­
board shortcut. In Microsoft Word and PageMaker, 
you can use the following keyboard equivalents to 
control a lignment: 

Keys Action 

I- I 3€-Shift-L Align Left 

1= 1 3€-Shift-C Center 

1 - 1 3€-Shift-A Align Right 

I I 3€-Shift-J Justify 
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To center a line of text 
1. With your word processing document open 

on-screen, press 3€-R to reveal the ruler, or 
look for a Show Rulers command from one of 
the menus. You see a ruler like the one in 
Figure C.2. 

0 t .1 t I 

Fig. C.2. Centering text using a ruler. 

2 Click anywhere on the line you want to center. 

3. On the ruler bar, look for the little icons 
representing alignment options, and click on 
the icon with the centered lines or press 
3€-Shift-C. 

Unselected paragraphs remain unchanged. 

To uncenter a line of text 
Repeat the preceding steps. Click on a different 
alignment icon in the menu bar, or choose an alter­
nate alignment selection from the Format menu. 

Notes 
Some programs will center the entire paragraph 
containing the selected line; others will center just 
the line you select. 

You may want to insert a hard carriage return to 
divide one paragraph into two, so that you can center 
one of them. 

See also Alignment and the "Quick Key Guide." 
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, Chooser l 1;;;; =====~ 
The Chooser desk accessory permits you to select the 
printer and other network devices that you use with 
your Macintosh. 

Many printing problems can be traced to the settings 
in the Chooser dialog box (see fig. C.3). You must 
select all the appropriate items in order to print. 

Important: all three 
items must be 
highlighted in order 
for you to print. If 
you are on a 
network, you also 
must select an 
Apple Talk Zone. 

Fig. C.3. The Chooser dialog box. 

To select a printer or to change printers 

3.5 

1. From the Apple • menu, select Chooser. 

2. Click on the icon for the printer driver you 
want to use. 

3. Click on the printer name in the dialog box to 
the right of the icon box. 

If no name appears, you may want to check 
cable connections and power supply, or 
reinstall your printer resource from your 
original Apple disk. 

If you are part of an active network, you also 
will see an AppleTal.k Zone section in the 
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lower left corner of the dialog box. Select a 
?:One if this box appears. 

4. Click the Close box. 

When to check the Chooser settings 
You must go through the Chooser to make changes at 
certain times. You should check your Chooser set­
tings at the following times: 

Notes 

• When you print from your Mac for the first 
time. 

• When you have problems printing. 

• When you change from one printer type to 
another. 

• When you want to select a device other than a 
printer, such as a plotter. 

• When you reconnect your printer cable to a 
different port on the back of your Mac. 

• When you want to become part of an active 
nc;:twork. You will see an additional AppleTalk 
Zone section in the lower left comer of the 
Chooser dialog box. 

You must select a printer through the Chooser before 
you can print your first document. 

See also Control Panel, Networking, Peripherals, and 
Printing. 

One of the reasons that the Mac is so popular is the 
ease with which you can use graphics, including all 
kinds of charts and images. But because most of us are 
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not Leonardos, Renoirs, or Picassos, much of our 
"art" simply doesn't do the job. 

That's where clip art comes in. Clip art is a collection 
of images on disk that save you the time and trouble 
of creating your own drawings. The term "clip art" 
originated more than 20 years ago. Designers and 
typesetters clipped the drawings they needed out of 
books and then pasted the art into the document. 

The selection ofavailable clip art these days is stagger­
ing, from subjects as diverse as athletics and educa­
tion (see fig. C.4). Inexpensive clip art is available 
through shareware libraries such as International 
Datawares. Other more expensive (and sometimes 
better quality) clip art is available, such as Cliptures™ 
(Dream Maker Software). Clip tu res are Encapsulated 
Postscript (EPS) files, making them ideal for high 
quality desktop publishing work. 

Fig. C.4. A clip art document. 

You usually can get clip art as regular Paint files, PICT 
files, or EPS (Encapsulated PostScript) files, which 
allow you to modify the image without losing any 
detail. 
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To use a clip art illustration 
1. Launch your favorite paint application (such as 

SuperPaint or MacPaint) by double-clicking on 
the icon of the application on the desktop. 

2. From within the paint program, open the clip 
art file containing the graphic you want to use. 

3. Using the lasso tool, draw a line around the 
graphic you want to use. 

4. From the Edit menu, select Copy. 

5. From the File menu, select New. 

6. From the Edit menu, select Paste. 

7. Save your new file with any modifications \}'ou 
want to make. 

You are now ready to copy the graphic to the Clip­
board or Scrapbook for use in another document. 

To copy artwork to the Scrapbook for future use 
1. Launch your favorite paint application. 

2. Open the clip art file containing the artwork 
you want to copy. 

3. Using the lasso tool, draw a line around the 
item you want to copy. 

4. From the Edit menu, select Copy. 

5. From the Apple 9 menu, select Scrapbook. 

6. Scroll to the desired location in the Scrapbook 
where you want to place the artwork. 

7. From the Edit menu, select Paste. 

8. Click the close box. 

The item is now in the Scrapbook for future use. 

Notes 
Always copy artwork from a clip art file rather than 
cut. This ensures that your original file remains intact 
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for future use. Also, it is always a good idea to make 
copies of your original disks and work from the 
copies. 

See also Clipboard, Copying, Cutting, Pasting, Desk­
top Publishing, Graphics Programs, and Scrapbook. 

The Clipboard is a buffer (temporary storage place) in 
which the last cut or copied text or graphics tempo­
rarily is stored. After you tum off a Macintosh, how­
ever, the contents of the Clipboard are lost. 

You use the Clipboard primarily to copy something 
from one location in a file to another (when you cut 
and paste and rearrange a letter, for example). Anoth­
er common use is copying something from one file 
and inserting it into another file, whether or not you 
have changed applications. Some applications, such 
as Microsoft Word, have a Show Clipboard command, 
which you can use to examine the contents of the 
Clipboard. 

Although the Clipboard holds only one item at a time, 
several commercial products, such as MultiClip, en­
able you to hold as many different items as you want. 
To save items from the Clipboard for reuse, you can 
paste text and graphics into the Scrapbook. The 
Scrapbook saves your work between sessions, and 
you can place more than one item in the Scrapbook 
at a time. 

You cut or copy to the Clipboard by pressing 00-X or 
00-C (respectively). To paste the Clipboard's con­
tents, use 00-V ("V'' for "Paste"--of course!) 

See also Copying, Cutting, Pasting, and Scrapbook. 
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Your Mac has an internal clock that is controlled by 
instructions contained in the memory of your com­
puter. After you set the clock, the time setting remains 
until the battery runs down or you remove the battery. 

To change the clock setting 

Notes 

1. From the Apple • menu, select Control 
Panel. 

2. Select the General icon (scroll if necessary). 

3. Click on the setting you want to change. 
Change the hour, minute, second, and AM/PM 
distinction by using the arrow keys to increase 
or decrease the current setting. You can also 
highlight what you want to change and type a 
new value. 

4. Click to select either the traditional 12-hour 
setting or the 24-hour military time option. 

5. Click on the Close box to exit the Control 
Panel and register the new settings. 

SuperClock is a popular time-keeping tool. Super­
Clock places a clock in the upper right corner of your 
screen, displays the time and date, and sets an alarm. 
It also sets the type of display you want to use. Unlike 
the regular Macintosh clock feature, you must pur­
chase SuperClock separately. 

See also Alarm Clock, Battery, CDEVs, and Control 
Panel. 
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, Close Boxl~====~ 
The close box is the small box in the upper left comer 
of the window that closes the window (see fig. C.5) . 

The close box is available in all Macintosh applica­
tions, from the desktop to alarm clock to individual 
document files. 

Click =--~~~~~~M~E~M~O~S~~~~g000§ 
here to 
close 
the 
window 

8items 2 13, 130K in disk 107 ,455K avail 

CJ CJ CJ 
APPLICATIONS DATA System Folder 

CJ CJ 
GAMES UTILITIES 

Fig. C.5. The close box 

To close the active window 
Click the small white box in the upper left comer of 
the window or press 3€-W. 

To close an inactive window 
1. Click on the window you want to make active. 

2. Click the close box in the upper left comer of 
that window. 

To close all of the open windows on the desktop 

1. Press and hold the Option key. 

2. Click the Close box in the upper left comer of 
the active window. 

or 

Press 3€-0ption-W. 
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Notes 
You do not have to close all of the open windows on 
the desktop in order to shut down your Mac. Which­
ever windows you leave open on the desktop will be 
open the next time you start up your Mac. 

If you close all your documents and want to return to 
the desktop, but find yourself in limbo instead, try 
selecting Quit from the File menu. 

See also Quitting, Shut Down, and Windows. 

To use color with your Macintosh, you must have a 
color monitor and the appropriate system hardware 
to support that monitor. You also need to tell your 
Mac that you will be using a color monitor by select­
ing the Colors option from the Monitor device on the 
Control Panel. Finally, you need to use the Color 
device (also on the Control Panel) to set the colors 
you want. 

To change the color of the desktop background 
1. From the Apple 9 menu, select Control 

Panel. 

2. Select the General icon (scroll if necessary). 

The General dialog box appears (see fig. C.6). 

3. In the Desktop Pattern box, there are two 
screens. Click on the left screen to edit the 
individual pixels. Notice the right screen has 
cwo tiny arrows at the top of the shaded box. 
Click on an arrow in the right screen to view 
other screen patterns. 

Click anywhere on the right screen to apply 
the new background pattern. 
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On color monitors, another Desktop Pattern 
option appears: colors. Change colors by 
double-clicking on a color box. 

Rate of Insertion 
Point Blinking 

· ... · 
... · .. 

®00 ,;:;: ; 

i\ Slow Fast 

::::::---------'------­
;::::: Menu Blinking Time (9 Keyboard 

1 Click here to edit the 
desktop pattern 

2 Click here to apply 
the pattern 

3 Click here to scroll 
through the patterns 

3:09:52 PM 

@ 12hr. 0 24hr. 

Date l!f!J 
12/ 26/90 

Fig. C.6. The Control Panel. 
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4. Click the close box when you finish your 
selections. 

To switch from color to black and white 
1. From the Apple 9 menu, select Control 

Panel. 

2. Select the Monitor icon (scroll if necessary). 

3. Click on Black & White. 

4. Click the close box. 

To switch from black and white to color, rep eat the 
process, but click the setting for the number of colors 
you want, e.g. Colors, 256. 

To change the hue, saturation, and brightness 
1. From the Apple 9 menu, select Control 

Panel. 

2. Select the Color icon (scroll if necessary). 
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3. Click on Change Color . The Color Picker 
dialog box appears. 

Change the hue by clicking around the edge of 
the Color Picker. Change the saturation by 
clicking from the outside of the wheel toward 
the center of the reverse. Change the bright­
ness by dragging the scroll box located on the 
right side of the Color Picker dialog box. 

4. Whe n you like what you see, click OK, then 
click the close box to register the new settings. 

See also Control Panel, Dialog Box, and Scrolling. 

, Control Panel .. , =====;;;;;; 

The Control Panel is a desk accessory that serves as 
your Mac's central device controller. With the Con­
trol Panel, you can change many of the settings that 
determine how your Macintosh operates (see fig. 
C.7). 

~o 

Keyboard 

Monitors 

...• 
(0 

Mouse 

Desktop Pattern 

Rate of Insertion 
Point Blinking 

... ·., 
@00 

Slow Fut i!i!ll 

llll--M-~-u-Bl-in-ki-ng~..-T~im-3-~~0~g_~-: SJ..::2~P~M~~~-i-=---I 
:11111 @ 0~0 1-o-~-te-

12

-~---~-
24

_h_r.~ ~ = 

iii!i: Off 1 2 3 12/26/90 0 -

mm RAM Cache I 256K I !;) @ On 

"'3""'_3..,._ 1----'-''-.f 0 Off 

Speaker 
Volume 

Fig. C. 7. The Control Panel. 
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You can change the following settings in the Control 
Panel: 

• Pattern of the screen background 
• Colors displayed 
• Speaker volume 
•Time 
•Date 
• Cursor blink rates 
• Keyboard responsiveness 
• Mouse responsiveness 
•RAM cache 
• Beep sounds 

The icons that you see along the left side of the screen 
when you select the Control Panel represent the 
control panel devices (CDEVs) in your System Folder. 

You change all the Control Panel settings in a similar 
way. The following steps provide an example of how 
to change a setting on the Control Panel. 

To change the menu blink rate 
1. From the Apple 9 menu, select Control 

Panel. 

2. Select General from the list of devices. You 
may need to use the scroll bar to find the 
device that you want. 

3. In the Menu Blinking box, click the various 
settings to select the blink rate you prefer. 

Notice that the little blinking menu corre­
sponds to the setting you select. 

4. Click the Close box when you are finished 
changing the settings. 
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Notes 
The Control Panel in System 7 will be significantly 
different in appearance and operation from the panel 
in previous systems. 

See also Beeps, CDEVs, Clock, Color, Desktop, Icons, 
IN/Ts, Monitors, Mouse, RAM Cache, Scrolling, and 
System. 

You find the Copy command on the Edit menu. The 
Copy command copies text or graphics from one 
location to another without affecting the copied 
material. 

To copy text or graphics 
1. Highlight the text or select the graphic you 

want to copy. 

2. From the Edit menu, select Copy 

or 

Press 3&-C. 

3. Scroll to the new location for your copied text, 
and click to tell the Mac where to place the 
copied item(s). 

4. From the Edit menu, select Paste 

or 

Press 3&-V. 
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To copy an item between applications 

Notes 

l. Highlight the text or select the graphic you 
want to copy. 

2. From the Edit menu, select Copy 

or 

Press 31l-C. 

3. Quit (don't forget to save!) your current 
application, and open the application in which 
you want the copied material placed. 

If you are operating under MultiFinder, switch 
to the new location. 

4. Locate the area where you want to paste the 
copied materials and click. 

5. From the Edit menu, select Paste 

or 

Press 31l-V. 

You do not need to leave blank spaces to be filled by 
pasted text. The text inserts automatically. New text 
does not overwrite the existing text, unless you 
highlight the text you want the pasted text to replace. 

All copied material remains in the Clipboard until you 
replace it by copying another selection, or when the 
Mac loses power. When material is copied, the orig­
inal stays intact in the current location. When a copy 
and paste operation is complete, two copies of the 
information exist. 

See Clipboard, Cutting, Highlighting Text, Keyboard 
Shortcuts, Pasting, and Scrapbook. 
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, Correcting Typos l .. iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii;;;;;;;; 

You can use several basic Macintosh techniques to 
correct typographical errors. 

To correct typos as you type 
1. Press the Delete or Backspace key to erase 

the character you just typed. 

2. Type the new text. 

To correct typos 
I. Highlight the characters you want to delete. 

Click at the beginning of an area of text, press 
and hold the mouse button, and drag the 
mouse until the very last word in your selec­
tion is highlighted. Then, release the mouse 
button. 

You also can double-dick to select words and 
shift-dick to select areas of text. 

2. Type the new text. 

You do not need to d elete the incorrect text first; you 
just need to replace it with something. 

To delete text 
1. Highlight the characters you want to delete. 

2. Press Delete. 

There are two delete keys on the extended keyboard; 
either key will work. On older keyboards, the delete 
key is labeled "Backspace." 

To delete text for use again 
1. Highlight the character you want to cut. 

2. From the Edit menu, select Cut. 
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The text is now in the Clipboard. You may go to where 
you want the cut material to be placed, or you may 
store it in the Scrapbook for safekeeping. 

Notes 

When you press the Delete/Backspace key, the char­
acter to the left of the blinking cursor disappears. If 
you highlight a character or set of characters, pressing 
the Delete/Backspace key removes all the highlighted 
characters. 

You can highlight a word in most Mac applications by 
double-clicking on the word. Triple-clicking some­
times highlights a paragraph. 

To highlight a line in Microsoft Word, place the arrow 
pointer to the left of the line and click once. To select 
a paragraph, place the pointer to the left of the 
paragraph and double-click. 

You can also simply press and hold the mouse button, 
then drag the cursor over the text you want to 
highlight. Note that these procedures work in Word, 
but not necessarily in other word processors, which 
contain their own shortcuts. 

Whenever you highlight text, the next keyboard ac­
tion completely replaces the highlighted text. There­
fore, be cautious about leaving text highlighted. If 
you should accidentally delete text, you can usually 
undelete it using the Undo command found under 
the Edit menu of most Macintosh applications. 

See also Cutting, Highlighting Text, and Undo . 
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Ouch! What could hurt more than to see that dreaded 
Bomb on your screen along with the message that a 
system error has occurred? (See fig. C.8.) When you 're 
running MultiFinder, you may see a different alert: 
The application ... has unexpectedly quit. 

,~ Sorry, a system error occurred. 

ID • OI 

Fig. C.8. A crash alert. 

Sometimes a crash will come as an error message; 
sometimes your system will "freeze," "lock up," "hang," 
or otherwise ignore you. You can tell your system has 
locked up if your pointer refuses to move when you 
move your mouse. 

Causes for a crash 
Your machine may crash for any of the following 
reasons: 

• RAM overload 
• Corrupted software (including incompatible 

applications/utilities, corrupted Desktop file, 
corrupted System file, corrupted PRAM, and 
corrupted application) 

• More than one System file 
• Bugs in a software program 
• Conflicting INITs 
• Heap size too small 
• Virus 
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If a particular action seems to cause your system to 
crash (for example, when you select the Print com­
mand), you probably have corrupted software. 

What to do if your system suddenly crashes 
Occasionally, even though your mouse has no effect, 
the keyboard may still work. Press 3€-S to save what­
everdocumentyou are working on. This rarely works, 
but it's worth a try. 

If your system locks up, you may have no choice but 
to turn the machine off and then restart it. Sometimes 
the alert box contains a Continue or Resume button 
which you can try clicking first. The alert box also may 
contain a Restart button that en ables you to restart 
without flicking any switches. Some of these buttons 
may be dimmed (depending on the mood of your 
computer). If the Restart button works, try to do an 
official Restart from the Special me nu on the desktop 
as soon as possible to make a fresh start. 

What to do if your system frequently crashes 
If you find that your system is crashing a lot (you 
determine how much is "a lot"), you may suspect a 
computer virus. If you do not frequently download 
files from a bulletin board or exchange disks from 
o ther machines or networks, however, your problem 
may not be a virus. Remember, system crashes have 
been around a long time-long before viruses ever 
surfaced . 

The following techniques may help you isolate the 
problem behind the crashes. After trying each proce­
dure, operate your machine the way you usually do to 

see if it still crashes. 

• If a particular application crashes, you may 
want to reinstall the application from the 
original program disks. 
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• If you're running MultiFinder and crashing, 
and you switch to the Finder and don't crash, 
try allocating more memory to each of the 
applications you run under MultiFinder. 

• Rebuild the invisible Desktop file by holding 
down the 3€ and Option keys upon starting 
up. Remember, doing so removes any informa­
tion you may have entered in Get Info boxes. 

• Scan for viruses using a virus detection pro­
gram such as Virex (from Microcom). Follow 
the Virex instructions to eradicate any 
virus( es). 

• If you have a system overload because of the 
number of fonts, INITs, desk accessories, and 
CDEVs, you may not have enough memory to 
run applications on top of all your "extras." In 
this case, you may need to enlarge the memory 
allocation. 

At the desktop level, from the Apple 8 menu, 
select About the Finder. If the light area of 
the System bar represents less than 25% of the 
entire bar area, you may need to enlarge your 
system heap. To enlarge your system heap, you 
should purchase HeapFixer (from CE Soft­
ware). 

• Zap the parameter RAM. Press 3€-0ption-Shift 
while selecting the Control Panel from the 
Apple w menu. 

• Use the Find File desk accessory under the 
Apple w menu to find all the System files on 
your startup disk, and then delete all but the 
one you want to use (probably the latest 
version). Multiple copies of the System-no 
matter where they are located-will cause 
problems. 

• Remove all the INITs from your System Folder. 
Put them all in a new folder somewhere else 
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on the hard disk-you don't have to remove 
them completely from your hard disk. If the 
machine operates nicely, drag an INIT from 
your INIT folder into the System Folder and 
Restart. If your Mac doesn't crash, add one 
INIT at a time to sort out the bad INITs. 

• Install a new System file. To do so, boot up 
from a floppy disk and use your original 
system installation disk labeled "System Tools" 
from Apple. 

To remedy a crash using the Programmer's Switch 
When your system does crash, short of resetting and 
rebooting, try the following steps to restore it. 

1. Click on the Continue button (if one is 
showing on the message box with the bomb). 
If this works (it generally doesn't), select 
Restart from the Special menu and resume 
your work. 

2. Push the Interrupt button on the Program­
mer's Switch, provided you installed the 
Programmer's Switch. When you press this 
button, you see a large box with a > in the 
upper left corner of the screen. 

3. Type sm fa700 a9f4. 

4. Press Return. 

5. Type pc fa700. 

6. Press Return. 

7. Type g. 

8. Press Return. 

This procedure may or may not work (now you tell 
me!). If the Interrupt button yields no success, push 
the Reset button. The Reset button, located next to 
the Interrupt button on the Programmer's Switch, 
restarts your Mac. 
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See also Error Messages, IN/Ts, Maintenance, Pro­
grammer's Switch, System, and Troubleshooting. 

Cut is a standard Macintosh operation that removes 
information (text or graphic) and puts it on the 
Clipboard. You can paste the contents of the Clip­
board onto another location, if you want. The new 
location can be within the same document, the same 
application, or an entirely new application. 

To cut 
1. Select the element you want to cut. 

2. From the Edit menu, select Cut 

or 

Press 3€-X 

To cut and paste 
1. Select the element you want to cut. 

2. From the Edit menu , select Cut 

or 

Press 3€-X 

3. Go to the new location where you want to 
paste the material, and click. 

4. From the File menu, select Paste 

or 

Press 3€-V. 
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Notes 

The cut item remains in the Clipboard until you cut 
or copy a new item, or until you shut down your Mac. 
Unlike the Copy command, where copied material 
remains in the original location as well as the new 
location, material that is cut is removed from the 
original location. 

See also Clipboard, Copying, Deleting Files, High­
lighting Text, Mouse, and Pasting. 

l Data Conversion 1!1;;;;;===~ 
Glasnost isn't the only thing bringing different worlds 
together. More and more, different computing plat­
forms (such as Mac and IBM) are used in the same 
location, and people need to share information across 
these platforms. Applications such as MacLink Plus/ 
PC (from Data Viz) and LapLink (from Traveling Soft­
ware) can translate Macintosh files to DOS files and 
back again (see fig. 0.1). 

9 Fiie E<llf Preferences Ln1.1 

Untitled 

fhrrll. Mocllnk Plus"/Desktop ru c:i o .. ,.vu tic . • 00545329 

Moclntosh rormots 
MS Word 

Lotus (WKS ... l 
MocBlnory 
MocWrlte 

MS Word (for MS-DDS) 
MultlPlon Moc (SYLK) 
Po eMoker (Moel 

® ~:~nslo tors 0 Select 
Flies 

"Foreign · Formots 
WordPerfect (PCl 

DCA (IBM Reulsoble) 
MultlMote 
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Fig. D.1. Maclink Plus/PC data conversion. 
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In addition, most new Macs available today come with 
a SuperDrive. A SuperDrive is a high density floppy 
drive (FDHD) which uses l.44M floppy disks. What's 
especially neat about this drive is that it can read 
3 1/2-inch disks formatted on IBM PC-compatible 
computers. The only thing you need to perform a 
conversion is the translation software that comes 
with your system disk. 

As the use of Macs and PC-compatible machines in the 
same setting becomes more common, these transla­
tion programs can do more as well. For example, the 
latest version of MacLink Plus/PC can convert DOS­
created graphics into a Macintosh-compatible envi­
ronment. 

See also File Formats. 

, Database Programs .. , iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii;;;;; 

A database program provides a listing of information 
organized in functionally related files that enable you 
to manipulate and retrieve information as needed. A 
database created using a database management sys­
tem (DBMS)-such as FileMaker Pro or 4th Dimen­
sion-consists of files, records, and fields. 

Afield is a unique piece of information common to all 
records. A record is a collection of fields, and, in turn, 
a file is a collection of records. For example, you can 
think of the phone book as a file, each listing as a 
record, and each record containing the fields "name," 
"address," and "phone number." 

In Figure D.2, you can see a FileMaker Pro record 
consisting of eight fields. Databases can be relational, 
in which records relate to one another through com­
mon fields, or flat, in which records have common 
fields but do not integrate with one another. 
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Fig. D.2. A database layout for mailing labels. 

, Deleting Files 1----~~~~~ 
Deleting a file from a disk or a folder removes the file 
from that disk or folder. When you drag an icon into 
the Trash Can, the file isn't completely gone until the 
trash is emptied. If you want to clear up space on a 
disk, you can drag icons to the trash. However, the 
files you drag to the crash will still take up disk space 
until the trash is emptied. 

The trash empties itself when you lai.mch an applica­
tion, shut down your Mac, eject a disk, copy or 
duplicate a file, or select the Empty Trash command. 

To delete a file 
1. On the desktop, select the file you want to 

delete. 

2. Drag the file icon to the Trash Can . 

3. When the Trash Can icon reverses, release the 
mouse button. 
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To empty the trash 

On the desktop, from the Special menu, select 
Empty Trash. 

To delete an application without getting an alert 
message 

l. On the desktop, select the file yo u want to 
delete. 

2. Press and hold the Option key. 

3. Drag the file to the Trash Can. 

4. When the Trash Can icon reverses, release the 
button and the key. 

To delete a locked file 

Notes 

1. On the desktop, select the file you want to 
delete. 

2. Press and hold the Option key. 

3. Drag the file to the Trash Can. 

4. When the Trash Can icon reverses, release the 
button and the key. 

If you are in an application and you want to delete a 
file, you must return to the desktop. 

If you dele te a file inadvertently, you may be able to 
undelete the file by using utilities such as SUM II or 
Norton Utilities (from Symantec). In the meantime, 
whatever you do, d o not write more data to that disk! 
Immediately run an "undelete" program, such as 
Norton Undele te, to restore deleted files. 

See also Desktop, Ejecting Disks, Files, Quitting, Shut 
Down, Trash Can , and Undo. 
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, Desk Accessories lll;;iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii~ 
Your operating system comes with a set of tools that 
are available whenever you use your Mac-regardless 
of the application you use. These tools are called 
Desk Accessories (DAs). The standard set of accesso­
ries includes the Alarm Clock, Calculator, Chooser, 
Control Panel, Find File, Key Caps, Note Pad, and 
Scrapbook. 

Although the standard DAs are quite handy, they are, 
by far, not the only DAs available. As your Mac now 
stands, you are limited to fifteen DAs. With so many 
good DAs are on the market, you may find it difficult 
to select which ones to install on your system. 

You can use a utility such as Suitcase II (from Fifth 
Generation Software), which enables you to install an 
unlimited number of DAs. Some software programs 
come as both an application and a DA, such as Deneba 
Software's Canvas and Zedcor's DeskPaint. Although 
the DA version is usually not as powerful as the full­
blown application, imagine how easy it is when you 
need to draw a line, or color in a shape, and you can 
simply go to the Apple menu rather than quitting the 
current application. 

You must install each desk accessory (prior to System 
7) using the Font/DA Mover. Figure D.3 illustrates the 
installation of a new desk accessory into the System 
file of the active hard disk. 
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Fig. D.3. Installing a new desk accessory. 

Preparing to install a DA 
To install a DA, you must have the DA you want to 
install on disk, either on your hard disk or on a floppy 
disk. You also need the Font/DA Mover application, 
and you need to be able to access your hard disk or the 
startup disk on which you want to install the DA. 

To install a new DA 
1. Launch the Font/DA Mover application. You do 

this by either double-clicking on the Font/DA 
Mover application icon, or double-clicking on 
a Font/DA Mover file. 

The Font/DA Mover dialog box appears. 

2. Click on the radio button for Desk Accessory. 

3. On one side of the dialog box, click Open to 
open the file that contains the new DA you 
want to transfer. On the other side, click Open 
to open the System file in your System Folder 
on your hard disk or startup disk. 

4. Click to select the DA you want to transfer and 
click Copy. Shift-Click to select more than one 
DA. 

5. After the file transfers, click Quit. 
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Notes 

To automatically select "Desk Accessory," press and 
hold the Option key while the Font/DA Mover opens. 

You can transfer DAs from left to right or from right 
to left in the Font/DA Mover dialog box. 

See also Alarm Clock, Calculator, Chooser, Control 
Panel, Find File, Font/DA Mover, Key Caps, Note Pad, 
Scrapbook, and "SYSTEM 7 FIRST LOOK." 

Just as the surface of an office desk is a work 
surface, so too is the Macintosh desktop. The 
desktop is made up of the screen, disk icons, trash 
can, and menu bar (see fig. D.4). 

Fig. D.4. The Macintosh desktop. 

The desktop is the work area that the Finder creates 
on your screen. You open, close, copy, move, and 
delete files on the desktop. The desktop is the first 
screen you see when you boot up your Mac, and the 
last screen you see before you shut down. 
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If you think of the desktop as an actual desk, you can 
better understand how the Mac enables you to move 
(place this set of files over there) and discard (put this 
junk in the trash) just as you would if you were 
actually sitting at a desk. 

Desktop is also the name of the invisible file your Mac 
creates to keep track of housekeeping information, 
such as storing the information you see when you 
issue the Get Info command from the File menu. 

You can rebuild the Desktop file if your Mac is 
abnormally slow in starting up, or if you get a message 
that a disk is damaged. Rebuilding the Desktop takes 
little time and is often a miracle cure! (Best of all, it 
doesn't damage anything.) 

To rebuild the Desktop file 

1. Shut down the Mac. 

2. Press and hold the 8€ and the Option keys. 

3. Restart the Mac (on the Mac II series, press the 
power key). 

4. When the desktop appears, release the keys. 

5. Click OK to respond to the confirmation 
message. 

The rebuilding process may take a few minutes. If the 
problem is here, however, rebuilding the Desktop is 
a simple fix. 

Notes 

Caution: Rebuilding the Desktop file removes notes 
in the Get Info section of each file. You can see the 
information for a particular file by selecting the file 
and then selecting Get Info from the File menu. Get 
Info, updated as you work, helps organize and track 
the creation of files. 
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You cannot rebuild the Desktop file while running 
MultiFinder. 

See also Control Panel, Copying, Crashes, Deleting, 
Finder, Folders, Font/DA Mover, Get Info, Menus, 
Rebuilding the Desktop, Restarting, Shut Down, 
Startup Screen, Trash Can, and Windows. 

, Desktop Publishing Im;;~~;;;;; 
One of the hottest topics in personal computing, 
desktop publishing is the application of personal 
computer systems to all phases of the publication 
process- from entering text and drawing graphics to 
producing a final report, pamphlet, or book. 

Besides the basic equipment, such as hardware and 
page layout software (such as PageMaker, Quark 
Xpress, or Publish It!) , you need some basic skills to 
begin desktop publishing. For instance, you need a 
knowledge of basic design principles and some un­
derstanding of typography. (Most major cities offer 
classes, and many books are available on the subject.) 

You may only need a good word processor since 
many high-end word processors such as Microsoft 
Word, Nisus, and WordPerfect offer much of the same 
features as a desktop publishing program. 

The Little Mac Book was produced via desktop pub­
lishing. The text was composed in Microsoft Word, 
and the screenshots were created using Capture and 
MacPaint. The text and graphics were combined 
using PageMaker (see fig. D.5). 

I 
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Fig. D.5. Desktop publishing The Little Mac Book. 

Desktop publishing enables you to combine text and 
graphics on one page. You can combine a spread­
sheet created in Excel, with several documents created 
using WordPefect Mac. Add to that document a pho­
tograph retouched using Photoshop. You can pro­
duce sophisticated output, including items such as 
color separations. 

See also Buying Hardware, Buying Software, Clip 
Art, Draw Programs, File Formats, Fonts, Graphics 
Programs, Page Setup, PostScript, and Special Char­
acters. 

, Dialog Box l liiii .._.._.._.._..__. 

Your Mac is so friendly that when it needs information 
from you, it doesn't just wait for you to provide it; the 
system prompts you through a dialog box like the one 
you see in Figure D.6. After you provide information 
and dick OK, the settings you select take effect. 
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A dialog box has a selection with a dark border (the 
default) that is usually your "OK" button. Pressing 
Return or Enter selects that default. Also, you have a 
Cancel button, so you can exit the dialog box without 
changing settings. 

Some dialog boxes, such as the Save, Open, and Print 
dialog boxes, are similar to one another across appli­
cations (which really helps when learning new pro­
grams). 
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Fig. D. 6. A dialog box. 

Components of a dialog box 
A dialog box contains the following elements: 

• Round Radio buttons-mutually exclusive of 
one another; you can select only one at a time. 

• Check boxes-not mutually exclusive; you can 
select and check as many as you want. 

• Option boxes-require you to enter informa­
tion. 

• Menus-like those that appear in many 
different Mac applications, from which you can 
select a command or an option. 

See also Alert Boxes, Opening Files, Page Setup, 
Printing, and Saving. 
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, Disk Drives 1---=~====~ 
A disk drive is the mechanism that spins a hard or 
floppy disk, reads information from the disk, trans­
fers the data to your computer, and writes informa­
tion from your computer onto the disk. In general, 
there are two kinds of disk drives: floppy disk drives 
and hard disk drives. 

Floppy drives 
Floppy disk drives are unsealed drives that use 
3 1/2-inch flexible disks (within unfloppy shells) that 
hold BOOK (double density) or 1.44M (high density) 
of information. An BOOK disk holds about 200 pages 
of plain text; a 1.44M disk holds about 360 pages of 
plain text. Your Mac comes with at least one internal 
floppy drive and other drives can be added easily. 

Hard drives 
Hard drives are sealed units made of steel or glass. 
Hard disk platters are coated with the same magnetic 
material as floppies, contain enormous storage ca­
pacity, and operate quickly (spinning at 3,600 revolu­
tions per minute). Hard drives can be internal or 
external, and some drives use removable cartridges 
(great for security). Storage capacities are always 
increasing with the upper limit now reaching more 
than 2.2G (gigabytes). 

Drive speed 

The speed of a hard drive (something to consider 
along with capacity) is measured in three ways: 

• The average access time- the amount of time 
it takes for the computer to find the informa­
tion for which it is searching. Access time is 
usually expressed in millionths of a second 
(ms), also called nanoseconds (ns). 
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• The transfer time-the time it takes for the 
hard drive to transfer data from the hard disk 
to the computer's memory. 

• The track-to-track access time-the speed with 
which the read/write heads can jump from 
track to track on the disk to find the necessary 
information. 

Hard drive purchase considerations 
Hard drives usually come initialized (formatted). 
They also generally come with software for organiz­
ing and managing created files and optimizing the 
space that's used on the drive. 

When evaluating a hard drive for purchase, inquire 
about the following items: 

• What is the cost per megabyte? 

• Does the hard drive automatically "park" the 
heads (safety feature) when it is turned off? 

• Does the hard drive have an external switch for 
changing the SCSI address? (Especially impor­
tant if you have several peripheral devices 
connected to your Mac.) 

• Does any software come with the hard drive? If 
so, what is the purpose of the software? 

• Will the drive fit physically with the rest of your 
Mac equipment? 

• What cable(s) do you need? 

Finally, determine what your storage needs are and 
buy the most storage you can afford. Even though it 
may seem impossible to you now, almost everyone 
runs out of hard disk storage eventually. The larger 
the disk capacity, the cheaper the per-megabyte costs. 

See also Buying Hardware, Disks, Initializing Disks, 
and SCSI. 
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The function of a disk is to store data. Disks store the 
Mac's operating system, your programs, and your 
data. You cannot save your valuable creations with­
out disks. There are two basic types of disks: floppy 
disks and hard disks. Floppy disks fit in your shirt 
pocket, are lightweight, and are relatively inexpen­
sive. Hard disks are housed in sealed chambers and 
can hold far more data (up to 2000 times as much!). 

Not-so;floppy floppy disks 

You're probably wondering why a floppy disk isn't 
floppy. The disk itself is housed within a protective 
plastic shell. If you slide the metal shutter on a disk, 
you will see the floppy magnetic media used to store 
your data (don't touch!). 

DS-DD, MFD-2HD-what does it mean? 

Floppy disks for use on Macintosh systems come in 
one size: 3 1/2-inch, and two storage densities. High 
density (HD) holds l.44M of data; double density 
(DD) holds 800K (approximately 200 pages of plain 
text). The density of a disk refers to the amount of 
information that can be stored in a given space. 

DD drives cannot read HD disks, but HD drives can 
read both DD and HD disks. 

Most floppy (a.k.a. micro floppy, MF) disks are dou­
ble-sided (DS). "Double-sided" means that both sides 
of the floppy disk are certified safe to store data. Only 
the floppy disks used on the original Macs are single­
sided. You can format a single-sided disk as double­
sided, but you risk losing some data, because the 
second side has not been verified as "safe" to store 
data. 
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Caringjor floppy disks 
Because floppy disks are unsealed, you need to pay 
special attention to their care. Some general disk­
handling guidelines follow. 

• Keep disks away from all sources of heat (they 
melt before the paper labels on them burn!). 

• Keep disks away from magnetic fields that 
disrupt the alignment of electrical impulses on 
the disk (translation-you lose your data). 
Magnetic fields are everywhere: the ringing 
telephone, a paperclip holder, your monitor, 
and your floppy drive. (Do not put floppies on 
top of your montior or external floppy drive.) 

• Store all disks in a safe place and in a closed 
container to avoid dust contamination. 

• Keep the outside of the floppy disk clean. 

• Keep Fido, junk food , cigarettes, liquids, and 
little greasy fingers away at all times! 

Hard disks 
Hard disks, also called "hard drives," are physically 
different in shape from floppy disks, can hold any­
where from 10 megabytes to more than a gigabyte of 
information, can be internal or external, and are 
available in removable cartridges. Both floppy and 
hard disks are coated with magnetic material. The 
major difference between the two is that a floppy disk 
is a flexible disk within a protective shell and used in 
an unsealed disk drive, while a hard disk is rigid and 
is contained in a specially-sealed unit. The sealed unit 
enables the sensitive hard drive to run in a more 
protected, maximum-performance environment. 

Caringjor your bard disk 
Hard disks don't need as much direct care as floppy 
disks, but should not be exposed to excessive mois-
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rure or heat and not moved or bumped abruptly, even 
while not active. 

Make sure your hard disk operates on a steady sur­
face, and that it has room to breathe. Don't forget to 
back up your data regularly. 

See also Backups, Disk Drives, Ejecting Disks, and 
Maintenance. 

Dots per Inch (DPI) is a measure of the resolution of 
a character as it is printed or as it appears on the 
monitor screen. DPI is the number of dots in a one­
inch-long line and is often a measure of the quality of 
a printer or monitor device. The higher the DPI, the 
better the quality of the finished product. The Image­
Writer II prints at 72 DPI and the standard Mac 
monitor displays characters at the same level of reso­
lution. The LaserWriter family of printers has a reso­
lution of 300 DPI. Other laser printers come in at 
1000 DPI and professional, top-of-the-line printers 
go all the way up to 2740 DPI. 

See also ATM, Desktop Publishing, Fonts, and Print­
ers. 

Draw programs are applications that enable you to 
create and combine objects, rather than bit-mapped 
images. Draw programs which allow you to create 
layers and then superimpose them on one another, 
form the basis for many of the Computer-Aided De­
sign (CAD) programs that are currently available. 
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Generally, good drawing programs-such as Mac­
Draw II, Freehand, and Illustrator-provide the fol­
lowing: 

• Intuitive drawing tools so that you know the 
purpose of the tool just by looking at the icon. 

• Alignment of objects with one another. 

• Change the order in which objects appear 
(front to back or reverse). 

• Treatment of bit-mapped images created with 
paint programs as a single object. 

• Gray scaling. 

• Data saved to different file formats. 

• Font, style, and size control. 

See also File Formats and Graphics Programs. 

You easily can duplicate an existing file from the 
desktop. This procedure is useful if you want a 
backup copy of a particular file to keep in a different 
folder on your hard disk, or if you want to modify an 
existing file, yet keep the original file intact. 

To duplicate a file from the desktop 
1. Click on the file you want to duplicate. 

2. From the Edit menu, select Duplicate 

or 

Press ~D. 

A new file appears with the name "Copy of 
originalfilename." 

3. If you want a name other than "Copy of...," 
type the name for the new file . 
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See also Copying and Files. 

, Ejecting Disks lliiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii= 

You may need to eject a floppy disk from a disk drive 
before you are ready to turn off your Mac. Following 
are different ways to eject a floppy disk: 

To eject a disk from the desktop 
1. Point to the icon of the disk you want to eject. 

2. Press and drag that icon to the Trash Can (trust 
me). 

3. When the Trash Can icon reverses, release the 
mouse button. 

To eject a disk from within an application 
1. From the File menu, select Save As ... . 

2. At the Save dialog box, click Drive if the name 
of the disk you want to eject doesn't appear in 
the dialog box. 

3. Click Eject. The floppy disk pops out. 

4. Click Cancel to return to your application. 

To eject a disk from an internal floppy drive at 
anytime 

Press 38-Shift-1. 

To eject a disk from an external floppy drive at 
anytime 

Press 38-Shift-2. 

To eject a disk when you 're done with your Mac 
session 

I. From the File menu, select Quit to quit 
whatever application you are using and return 
to the desktop. 
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2. From the Special menu, select Shut Down. 

Your Mac ejects any floppy disks and shuts down. 

To eject a stubborn disk that refuses to come out 
1. Unbend a paper clip and push the straight 

edge into the little hole to the right of the 
floppy drive opening. 

2. Give a quick push when you feel some resis­
tance. Your disk should pop out. 

Use this procedure only as a last resort! 

Notes 

Ejecting a disk by sliding its icon to the Trash Can 
clears the disk from the Mac's memory. If you eject a 
disk by pressing ~E, don't be surprised if your Mac 
asks you to perform the dreaded disk-swapping ritual 
(Please insert the disk ... ). Try pressing :!€-. to get rid 
of this message. 

An internal drive appears as a slot on the front of your 
machine. An external drive is a separate little box 
attached to your machine with a cable. 

See also Disk Drives, Disks, and Keyboard Shortcuts. 

Electronic Mail (E-Mail) is a messaging system that 
permits users to send and receive "mail" electronical­
ly to and from other people on the same network. You 
can send E-Mail through local area networks or use it 
with information services (such as CompuServe and 
Prodigy) to connect with other users. These systems 
usually give you a message when you sign on if 
someone has sent you mail. 

See also Bulletin Boards, Networking, Modems, and 
Telecommunications. 
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, Erasing Disksl liiii ---------------;;;;;; 

When you erase a disk, all files and data contained on 
the disk disappear and the disk is left entirely blank. 

To erase a disk 

Notes 

1. From the desktop, select the disk you want to 
erase. 

2. Under the Special menu, select Erase Disk. 

You will see an alert box (see fig. E.1). 

1· -..-1 Completely erase disk named 
"Startup" (internal driue)? 

([ Cancel ]J [One-Sided J [Two-Sided] 

Fig. E. l. The Erase Disk alert box. 

Note: When you erase a hard disk, there are 
only two buttons: Cancel and Initialize. 

3. Confirm that you want to completely erase this 
disk by clicking Two-Sided (or One-Sided, if 
necessary). If, at this point, you 're not sure 
what you're doing, click Cancel. 

4. Respond to the on-screen prompts. 

Be very, very careful. Make sure you really want to 
erase the disk before completing this procedure. 

Reformatting a disk erases data on that disk. 

See also Deleting, Disks, and Initializing Disks, Re­
covering Data. 
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, Error Messages 1------------------
Things don't always run as smoothly as you might 
like. When something goes wrong with your Mac, 
your program, or your data, you probably will see an 
error message. Error messages usually appear as alert 
boxes. The messages result from sophisticated diag­
nostics that your Mac runs when you start up the 
computer and an ongoing set of tests it runs as you 
work. 

For example, if you have a problem during the 
startup, you see a sad Mac face with a code under­
neath, rather than the usual happy face Mac. These 
characters represent the type of startup error that has 
occurred. 

Codes that start with the characters OF, denote soft­
ware failure (perhaps a corrupted system). When the 
first two characters are something other than OF, the 
error is usually a hardware startup error. Other errors 
that can occur are system errors when the Mac freezes, 
or ROM errors resulting from software problems. 

See also Crashes, Maintenance, Recovering Data, and 
Troubleshooting. 

, File Compression l~iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 
How to get more from less? Generally, the mores pace 
you have on your hard disk, the more you use. And 
eventually, you'll run out of room. When you do, you 
don't necessarily have to get a bigger hard disk, when 
you can use a variety of utilities to compress the disk 
information. When this information is compressed, it 
requires as much as twenty to fifty percent less space, 
thereby increasing the amount of information your 
disk can hold. This is great for archival backups. 
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Compressing files also greatly reduces the time it 
takes to transfer files over a modem, and therefore 
telecommunication charges. Stuftlt (Aladdin Systems) 
is the industry standard for file compression, and 
now Stufflt Deluxe offers even more features. Disk­
Doubler (Salient Software) also is a handy compres­
sion tool that, when installed, becomes an option on 
the Main menu. 

Remember, once a file is compressed, you must 
decompress it before you can use it. 

, File Formats .. , iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii~ 

File formats refers to the structure used to record 
information on a disk. Different applications create 
files in different file formats. As with foreign lan­
guages, different applications speak in their own 
dialects. 

There are a variety of formats that Macintosh applica­
tions use to save files. Following is a brief description 
of each format. 

• DIF (data interchange format) is used for 
saving numbers in each cell in a spreadsheet 
without transferring formulas . 

• RTF (rich text format) is a special exchange 
format used to transfer data between Microsoft 
applications. 

• SYLK (symbolic link) allows numerical data 
and formulas to be transferred. 

• Text/ASCII converts files created with a particu­
lar application into text-only generic files 
based on ASCII codes. Text files are easily read 
by and transferred from program to program 
across different computer platforms. 
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• WKS (worksheet) is used to transfer files to 
Lotus 1-2-3 and Symphony on PC-compatible 
machines. 

• EPS (encapsulated Postscript) is part PICT in 
how it displays a drawing and part Postscript 
code in how it prints a drawing. EPS files can 
be gray-scale or colored. 

• PICT, PICTl, and PICT2 are image-saving 
picture formats usually used by object-oriented 
draw programs such as MacDraw II. PICT 
images can be in color. PICT was created for 
the purpose of exchanging pictures between 
applications. 

• PNTG is the most common image-saving 
format used by paint programs such as Mac­
Paint. It stores only black and white bit­
mapped images, and is limited in size and 
resolution. PNTG images usually appear jagged 
when printed. 

• TIFF (tagged image file format) are bit-mapped 
files which can vary in resolution (DPI). TIFF is 
usually used for black and white scanned 
images. 

Most programs provide for the importing of, and the 
exporting to, different file formats . Unlike PC files, 
the Macintosh file format is not contained in a file 
name. 

Graphic formats 
Graphics programs include painting, drawing, and 
page layout software such as MacPaint, PageMaker, 
and Illustrator. Format, however, refers to the record­
ing of images. For example, MacPaint files are created 
in the file format known as PICT. Mac applications 
also use several other formats such as TIFF, EPS, and 
PICT2. 
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Before you begin using one application to create a 
graphic to use in another application, be sure that the 
two applications are compatible. The best way to 
check compatibility is to consult the application man­
ual or call the company's technical support. Most 
applications are moving toward fuU compatibility, 
and many can convert "foreign" formats into usable, 
application-specific formats. 

Text fonnats 
In text and spreadsheet applications such as 
Microsoft Excel and Microsoft Word, (and "foreign" 
applications such as Lotus 1-2-3), format refers to 
recording characters, usually represented by a string 
of single digits. 

Most word processors provide a full range of file 
format options that enable you to save a file in the 
format that another word processor uses. For exam­
ple, Microsoft Word permits you to save a file in your 
choice of format-even Microsoft Word for the PC 
(see fig. F.l). Most spreadsheets allow the same 
flexibility. For example, Excel permits you to save files 
in the formats ofDIF, SYLK, WKS, CSV, and, ofcourse, 
text. 

The universal file format is text or ASCII (American 
Standard Code for Information Interchange) , the 
plain Jane of file formats.This format contains only 
text itself-no fancy format codes or other applica­
tion-specific changes. ASCII is reliable and is the most 
available code. 
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File Format (QDJ 
@Norm11I 
O TeHt Only [Cancel J 
O TeHt Only with Line Breaks 
Microso ft Word 

O 1.0 I Microsoft Works 
O 3.0 I Microsoft Write 
O MS- DOS 

O MacWrite 
O Interchange format (RTF) 

D Of~lnult tormnl tor till' 

Fig. F.l. Microsoft Word saves files to a variety of file 
formats. 

To save a file to a different file fonnat 
1. With your file open on-screen, from the File 

menu, select Save As. 

2. If you see a file format selection button, select 
the format you want to save to-for example, 
Text Only. If you do not see a selection, look 
for a button that will provide you with such a 
list, such as a Format or Options butto n. 

3. Type a name for your new file. Keep in mind 
that files on a PC are limited to e ight characters 
with a three letter extension, such as 
LETTER12.DOC. 

4. Click OK, or press Return or Enter. 

To open afile in a dijferentfi/efonnat 
1. Launch the application you want to use as the 

new file format. For example, double-click on 
the icon for Microsoft Word. 

2. From the File menu, select Open. 

3. Double-dick on the name of the file you want 
to open. You may have to scroll or change to a 
different disk or folder to find the file. 
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In some programs, you may have to select a 
button such as Show All Documents to view 
files saved to a different format. 

4. Answer any on-screen prompts, if necessary. 

5. \Vhen the translated document appears on­
screen, from the File menu, select Save (38-S). 

6. Type a name for your new file and press 
Return. 

See alsoData Conversion, Opening Fi/es, and Saving. 

A file is a set of information stored on a disk under a 
unique name. On the desktop, files are represented 
by icons (if that's how you choose to view them) and 
organized according to the Mac's Hierarchical Filing 
System (HFS). File names are limited to 31 characters 
(including spaces), and may contain any character 
except the colon. 

To create afile 
Generally, new files are created and named within 
applications, however, there are several ways to 
create a file: 

• Launch the application you want to use to 
create your file. For example, double-click on 
the MacDraw II icon to create a drawing, or 
double-click on the WriteNow icon to type a 
letter. 

• Open a document similar to the one you want 
to create. For example, to write a report, 
double-click on the icon for the report you 
created last time. To create a logo using 
Freehand, double-dick on the icon of another 
Freehand document. 
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• Select the icon of a document similar to the 
one you want to create and duplicate that icon. 
For example, find the icon for your resume 
created in WordPerfect and select it. Under the 
File menu, select Duplicate . Double-click on 
the icon of the file you just created entitled, 
"Copy of filename." 

Once you have a document open on-screen, you can 
do one of three things: 

• Close the document. From the File menu, 
select Close . Then, open a new blank docu­
ment. Under the File menu, select New. 

• Save the open document to a new name. From 
the File menu, select Save As . 

• Select everything on-screen and delete it. From 
the Edit menu, select Select All . Then press 
Delete . You also can delete everything by 
dragging the I-beam to highlight all the text, or 
by drawing a marquee around a group of items 
to select them, and then press Delete . 

Don't forget to save your new work! 

To create a.file.from within an applicaUon 
1. Launch the application that you want to use. 

For example, double-click on the icon for 
MacWrite II. 

2. In most applications, you will see a blank 
document appear in front of you. If all you see 
is the menu bar, from the File menu, select 
New ~-N). 

Your file is officially "created." You may start typing or 
working on your document, or may choose to save 
your file right away. 

Don't worry, your Mac won't let you quit without first 
reminding you to save your work. 
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To open an existing file from the desktop 

Double-click on the icon of the file you want to open. 

To open an existingfilefrom within an application 
1. From the File menu, select Open ~-0). 

If the Open selection is gray, you may first have 
to close your current file. From the File menu, 
select Close. 

2. Select the disk or folder in which the file 
resides. Select a new disk by clicking on the 
Disk button. Select a new folder by clicking on 
the folder name above the file listing. 

3. Scroll through the file list until you find the file 
you want. 

4. Double-dick on the name of the file you want 
to open, or select the name and click Open. 

To save a file 

1. With the document you want to save open on­
screen, from the File menu , select Save ~-S). 

2. Type a file name. 

3. Click OK, or press Return or Enter. 

To save a file to another folder 

1. With the document you want to save open on­
screen, from the File menu, select Save ~-S). 

2. Select the folder you want to contain the saved 
file. Click on the folder names in the Save 
dialog box to open them. Click on the folder 
button above the file listing to go up to a 
higher level of organization. 

3. Type a file name. 

4. Click OK, or press Return or Enter. 
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To save a file to another disk 

1. With the document you want to save open on­
screen, from the File menu, select Save ~-S). 

2. Click the Drive button in the Save dialog box 
until the name of the disk to which you want 
to save the file appears. 

3. Type a file name. 

4. Click OK, or press Return or Enter. 

To print a file from the desktop 

1. Click to select the icon of the document you 
want to print. 

2. From the File menu, select Print ~-P). Make 
changes in the Print dialog box, if desired. 

3. Click OK, or press Return or Enter. 

If the application that created the document is avail­
able, the file prints. If the application is not available, 
your Mac tells you so. 

To print a file from within an application 
1. With your document open on-screen, from the 

File menu, select Print ~P). 

2. Make changes in the Print dialog box, if 
desired. 

3. Click OK, or press Return or Enter. 

To print multiple files created using the same appli­
cation 

1. On the desktop, using the shift-click technique, 
select the files you want to print. 

2. From the File menu, select Print ~P). 

3. Click OK, or press Return or Enter. 
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To rename a file from the desktop 
1. At the desktop, click on the file name. If the 

pointer doesn't turn into an I-beam, click 
again. 

2. Type the new name for the file. 

3. Click OK, or press Return or Enter. 

To rename a.file from within an application 
1. With the file you want to rename open on­

screen, from the File menu, select Save As . 

2. Type the new name for the file. 

3. Click OK, or press Return or Enter. 

This procedure creates a second file; it doesn't over­
write the first file. You may want to throw away the 
original file when you return to the desktop. 

To move a file from one folder to another on the same 
disk 

1. On the desktop, open the folder containing 
the file you wane to move and the window 
containing the folder to which you want to 
move the file. 

2. Drag the icon of the file you want to copy to 
the folder window. 

3. Release the mouse button. 

To copy a.file from one disk to another 
1. On the desktop, select the icon of the file you 

want to copy. 

2. Drag the icon of the file you want co copy to 
the icon of the disk you want to copy to (the 
destination disk). 

3. When the icon of the destination disk reverses, 
release the mouse button. 



======================== Macintosh Topics 

To accomplish this procedure from within an applica­
tion, use the Save As command, and select the ap­
propriate drive using the Drive button. 

To copy several files from one disk to another 
I. At the desktop, press and hold the Shift key. 

2. Click to select an icon of a file you want to 
copy. Repeat to select all the icons you want to 
copy. 

3. After you select all the icons you want to copy, 
release the Shift key. 

4. Point to any one of the highlighted icons. Press 
and hold the mouse button. 

5. Drag that icon on top of the icon of the 
destination disk. 

6. When the icon of the disk reverses, release the 
mouse button. All the files copy. 

This technique is called shift-clicking. An alternative 
to shift-clicking is to draw an imaginary box-a mar­
quee-(usingyour pointer) around the files you want 
to include. 

To copy afilefrom one folder to another folder on the 
same disk 

I. Press and hold the Option key. 

2. Drag the icon of the file you want to copy to 

the destination folder. 

3. When the icon of the destination folder 
reverses, release the mouse button. 

To duplicate aftlefrom the desktop 
1. At the desktop, select the file you want to 

duplicate. 

2. From the File menu, select Duplicate (W-D). 

An exact copy of the file is created and named Copy 
of original filename , where original filename is the 
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name of the original file. The original file remains 
unchanged. 

To duplicate a file from within an application 
1. With the file you want to duplicate open on­

screen, from the File menu, select Save As. 

2. Type a new name for the file. 

3. Click OK, or press Return or Enter. 

This procedure creates a second file; it doesn't over­
write the first file. The original file remains intact. 

To delete a file 
1. At the desktop, point to the icon of the file you 

want to delete. 

2. Press and hold the mouse button. 

3. Drag the icon to the Trash Can, located in the 
lower right comer of the desktop screen. 

4. When the Trash Can icon reverses, release the 
mouse button. 

To delete several files , use the shift-dick technique, 
or draw a marquee. 

To empty the trash can of all the files you deleted 

From the Special menu, select Empty Trash. 

To view a listing of files 
At the desktop, under the View menu, select the type 
of listing you want. 

You can view by icon, small icon, name, date, size, or 
kind. On color monitors, you also have the option of 
viewing a listing sorted by color. 

To lock a file 
1. At the de·sktop, select the icon of the file you 

want to lock. 

2. From the File me nu , select Get Info (3€-1) . 
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3. Click in the Locked box in the upper right 
corner. ~ means the file is locked. 

When a file is locked you can view and copy the 
contents, but you cannot alter the contents or throw 
away the file. 

To place a file on the desktop 
1. At the desktop, open the folder containing the 

file you want to put on the desktop. 

2. Select the icon of the file, and drag it to the 
desired location on the desktop. 

Note: You cannot do this under System 7. 

To put back to its original location a file that appears 
on the desktop 

1. Select the icon of the file on the desktop you 
want to put back. 

2. From the File menu, sdect Put Away. 

To recover afil.e name that you inadvertently changed 
1. Before you perform any other action, back­

space until all of the characters in the file name 
are deleted. 

2. Press Return or Enter. 

To get information about a file 
1. Select the file or application that you want 

information about. 

2. From the File menu, select Get Info (3€-1). 

3. Type comments in the info box, if you want. 

4 . Click the close box. 

The Get Info window contains file information such 
as the kind, size, version number, location, date 
created, and date last modified. 
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Notes 

The Save As command enables you to save an active 
file under another name. This command is useful 
when you want to use the same file over (such as a 
letter) with some slight modification. 

See also Copying, Deleting Files , Duplicating, Fold­
ers, Get Info, Locking, Printing, Saving, Scrolling, 
and Trash Can. 

, Financial Programs1ml ~~~-
Financial programs fall into general categories such 
as accounting, tax preparation, financial forecasting, 
business planning, personal finance planning, and 
financial analysis. Accounting applications are by far 
the largest group of financial programs available; 
these programs range from basic applications such as 
a simple checkbook (see fig. F.2) or general ledger, to 
complex and sophisticated accounting packages that 
are relational databases disguised as seamlessly inte­
grated modules. 

'* rue Edit 

Enter Transactions: 1991 

Ending Balance: 399. 95 

®Check O Deposit 

Date: ~ Number. 

Payee: I IRS Eol Tax 

Amount: I I oo. og 
Memo: ls1 1-88-071'1 (nESl 

c···~1 ·-·~:.J 
D Cleared D Printable Check 

R ce t ClliD I Delete I ~ 

Fig. F.2. Using Quicken to keep track of expenses. 
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Because the push for these high-level packages has 
left many small businesses in the gap between simple 
applications (which are easy to use but incomplete) 
and complex programs (which offer far too much for 
the small business operator), many developers have 
offered middle-of-the-road packages. These packages 
have a lot of power, but don't require a high level of 
understanding of accounting principles. 

You may not believe it now, but sooner or later your 
hard disk (if you have one) will be filled with hun­
dreds offiles. With all those files, how can you find the 
one you need, especially if you forgot what folder you 
placed it in? The Find File desk accessory searches 
through any folder or disk, and can locate a file by 
name-even an incomplete name. 

Figure F.3 shows the results of a search for files that 
contain the letters "sys" in the file name. Notice that 
Find File searches for all occurrences of the name; it 
doesn't stop after finding the first one. You can click 
on a file icon in the listing to see where that particular 
file is located. 

ID Find Fiie 

lg) System Tools II Senrch for: l sy~ I ~ 1.3 

D So;sltmfo- K 

0 
Cruttd : ._.flt, 5ti> 14, 1988; 12:00 PH ell System Folder 

~ 
Hodlfi.d : ..,od,Au<j7,1!191 ;9~ N1 lg) System Tools 
Sizt : 404093by1H; 

395K on disk 

Fig. F.3. Using Find File to search f or a file. 
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To find aflle 
1. From the Apple e menu, select Find File. 

2. Type the name (or partial name) of the file 
you're looking for in the Search for: box. 

3. Click on the icon of the little person on the 
right side of the window. 

Find File searches the disk and lists the files 
containing the letters you specified. 

4. To find out how to access the listed files, click 
on the name of one of the files listed in the 
center of the window. 

In the lower right corner of the window, you 
see a listing of the folders you need to open to 
get to that particular file. 

In the lower left corner of the window, you see 
information related to that particular file. 

5. To move a file temporarily to the desktop, 
from the Find File menu, select Move to 
Desktop ( 3C-M). 

6 . Click the close box to exit Find File. 

To search for files on a different disk 
1. From the Apple e menu, select Find File. 

2. From the Find File menu, select Search Here. 

3. Indicate where you want Find File to search. 

4. Follow the procedures to find a file. 

You also can click on the disk icon in the upper left 
corner of the Find File window until you see the name 
of the disk you want to search. 
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Notes 

Find File doesn't take you to the file you're looking 
for. It doesn't open the file up. It only tells you where 
to find the file. You still need to return to the desktop 
and open the necessary folders to get to the file you 
want. 

See also Desk Accessories, Files, and Get Info. 

The Finder is an important part of Macintosh system 
software and is the control center for the Mac desk­
top. The Finder is a file (and an application) that 
provides you with the tools to manage how the files 
are organized and manipulated on the desktop. The 
Finder performs the following tasks: 

• Manages documents and applications. 

• Ejects disks. 

• Initializes and erases disks. 

• Opens, closes, copies, moves, renames, and 
deletes desktop elements. 

• Organizes the desktop. 

• Provides information from the Info box. 

• Starts up and shuts down your Mac. 

Because your Mac looks to the Finder for instructions 
on organizing the desktop when it starts, it's impor­
tant that you only have one Finder on any one disk 
(floppy or hard). 

You may find that you need to organize your desktop 
according to the "instructions" contained in an alter­
nate Finder. For example, you may be using more 
than one hard disk and the non-dominant disk (the 
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one whose System is not active) contains fonts or 
desk accessories you need to access. 

To "moutit" a tiew Finder 
1. Open the file containing the new Finder. 

2. Press and hold the Option key and the 3€ key. 

3. Double-dick on the Finder icon. 

Notes 
The dominant Finder is always represented by the 
icon in the upper right corner of the desktop. 

The Finder is inactive when MultiFinder is running. 

See also System. 

Fkeys are short programs you define to perform a 
specific task so that you don't have to enter all the 
keystrokes. You invoke an Fkey by pressing the 3€and 
the Shift keys in combination with a number (1 
through 9, or 1 through 12, depending on the key­
board you use). Fkeys are stored in the System Folder. 

Predefined Fkeys 
Keys Action 

3€-Shift· l Ejects a floppy disk from the inter­
nal disk drive. 

3€-Shift-2 Ejects a floppy disk from the exter­
nal disk drive. 

3€-Shift-O Ejects a floppy disk from the third 
disk drive (if you have one). 

3€-Shift-3 Creates and saves a MacPaint file 
from whatever is on the screen. 
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l!&-Shift-4 

Notes 

(This combination does not work 
with all applications.) 

Prints the contents of the active 
window (on lmageWriters only) . 

If you hold down the Caps Lock key when you press 
l!&-Shift-3, you get a screen dump of just the active 
window. 

Thousands of Fkey utilities are available through 
public domain sources (check the listings in the back 
of your favorite Mac magazine). As new utilities are 
created and the limit for the number of desk accesso­
ries is eliminated with System 7, however, Fkeys may 
become a thing of the past. 

See also Desk Accessories, Font/DA Mover, Macros, 
System, and "SYSTEM 7 FIRST LOOK" 

, Folders liiiiil ======iiiiiiiiiiiiiii 
Just like the folders you have in your file cabinet, 
Macintosh folders hold related information in o ne 
location. A folder can contain files, other folders, 
graphics documents, or any type of information. 

One of the strong points of the Mac's hierarchical 
filing system is its capability to store files within 
folders and folders within other folders. You can have 
as many folders as there is room o n your disk. A good 
rule of thumb for organizing your work is to have only 
folders, and no files, on the desktop at the root (the 
first level) of your filing system. 

You can rename folders just as you can rename files 
or other icons. Be careful not to rename application 
folders because o ther utilities and programs often 
require a specific name to do their job. 
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The following tasks occur at the desktop. 

To create a new folder 
1. From the File menu, select New Folder (3€-N). 

A new folder labeled "Empty Folder" appears 
on your desktop. 

2. Type a name for the folder. 

You now may slide items into your new folder. 

To open a folder 

Double-dick on the icon of the folder you want to 
open. 

To move a/older 
1. Point to the icon of the folder you want to 

move. 

2. Press and hold the mouse button. 

3. Drag the folder to the new location. 

4. Release the mouse button. 

To place an item into a folder 

1. Point to the item (file, folder, etc.) you want to 
place in your folder. 

2. Press and hold the mouse button. 

3. Drag the item onto the desired folder. 

4. When the folder icon reverses, release the 
mouse button. 

To remove an item from a/older 
1. Double-click on the folder that contains the 

item you want to remove. 

2. Drag the icon you want to remove out of the 
folder and to the new location. 

3. Release the mouse button. 
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To rename afolder 

Notes 

1. Double-click on the folder name if the name is 
only one word, or drag the I-beam over the 
text if the folder name is more than one word. 

2. Type the new name. 

If your cursor does not change to an I-beam, and you 
are unable to rename a particular folder, the folder 
may be locked. To check a folder's status, from the 
File menu, select Get Info. A locked file/folder has a 
1:8:1 next to the box marked "Locked." To unlock a 
locked file, click on the 1:8:1, then click the close box. 

To get rid of a folder, slide the icon to the trash. Be 
sure to check the contents first! 

See also Files. 

The Font/DA Mover is the Apple utility that installs 
fonts and desk accessories. Installation involves mov­
ing files from one location (usually a floppy disk) into 
the active System on· your hard disk or startup disk. 

Preparing to use the Font/DA Mover 
In order to install a new font or desk accessory 
successfully, you must have the following: 

• The Font/DA Mover application. If you do not 
have this application on your hard disk or 
startup disk, you can find the Font/DA Mover 
on one of the Utilities disks that came with 
your Mac. 

• A source file. A source file (usually on a 
separate floppy disk) contains the font or desk 
accessory you want to install. 
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• A destination file. A destination file is the file 
you want to contain the new font or desk 
accessory. This file is usually the System file 
contained in the System Folder, or on your 
hard disk or startup disk. 

To install a new font 
1. Double-dick on the Font/DA Mover icon (see 

fig. F.4) . 

Font/DA Mover 

Fig. F.4. The Font/DA Mover icon. 

2. Insert your source disk into the floppy drive. 

3. On one side of the dialog box, click the Open 
button to select the location of your source 
file. Click Drive if necessary. Double-dick on 
the file when you find it. 

4 . On the other side of the dialog box, click the 
Open button. Double-click on the System file 
when you find it. If you make a mistake or 
change your mind, click the Close button. The 
Close box then turns back into an Open 
button for you to indicate your new selection. 

5. Select the font that you want to copy from the 
source disk list (see fig. F.5). Scroll if neces­
sary. Shift-click to select more than one font. 

As you select an individual font, a sample of 
the typeface appears at the bottom of the 
window. If you select more than one font, the 
typeface does not appear. 

6 . Click the Copy button to install the font(s). 

7. Click Quit to exit the Font/DA Mover program. 
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Fig. F.5. The Font/DA Mover screen. 

To install a new desk accessory 
1. If you already activated the Font/DA Mover, 

click the Desk Accessory button to see desk 
accessories rather than fonts . 

2. Insert the DA source disk into the floppy drive. 

3. Click one of the Open buttons in the window 
to reveal the contents of the DAs o n the source 
disk. 

4. Click the other Open button to find and open 
your System file (the destinatio n). 

5. From the list on your source disk, select the 
DA(s) you want to install on the System. Shift­
click to select more than one. 

6. Click Copy. 

7. Click Quit to exit the Font/DA Mover program. 

To install a new font or desk accessory directly into a 
specific application 

1. Launch the Font/DA Mover in the usual fashion 
(see preceding instructions). 

2 . Before you click o ne of the Open buttons to 
select a destination file, press and hold the 3C 
key. 
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3. Click one of the Open buttons on the window 
to select a destination file. 

At this point, you will see a list of applications, 
rather than a listing of just document files. 

4. Select the application into which you want to 
install a font or desk accessory, and continue 
with normal Font/DA Mover procedures. 

To remove a font or desk accessory 
1. Double-click on either the Font/DA Mover 

application icon or any Font/DA Mover file in 
your System Folder. 

The Font/DA mover opens with the Font 
option selected. 

2. Click the Desk Accessory button to view the 
list of desk accessories. 

3. Highlight the item you want to remove. 

4. Click Remove. 

Caution: Copy the unwanted font or desk accessory 
to another file (or create a new file to contain that 
item) prior to removing the item from your System. 
Who knows? You may want it later. 

Notes 
You can launch the Font/DA Mover application by 
double-clicking on the application icon or by double­
clicking on any Font/DA Mover file. 

You are limited to fifteen desk accessories in your 
System file . Each one takes up RAM, so be selective as 
to which ones you install. 

If you think that using the Font/DA mover is too much 
trouble, be patient. System 7 will enable you to install 
fonts and desk accessories simply by dragging files 
into a folder. 
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SeealsoDeskAccessories, Fonts, and "SYSTEM 7 FIRST 
LOOK." 

, Fonts .. , iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

A font is a collection of letters, punctuation marks, 
numbers, and symbols that appear in the same type­
face, style, and size. Because each font conveys a 
message, selecting and using a font impacts the ef­
fectiveness of a document. 

With fonts you can be classy: you can use " instead of 
" , enhance text with italic rather than underline, and 
add S4fe to your substance. 

Your Mac's System Folder contains some standard 
fonts including Chicago, Helvetica, Monaco, New 
York, Geneva, Times, Courier, and Symbol (see fig. 
F.6) . More fonts can be added using the Font/DA 
Mover. 

Ch it ago , co u r i e r, Gene v a , 
Helvetica,M on a c: o, New York, 

Times, L'l'µ~oA, (Symbol) 
Fig. F. 6. Standard Macintosh fonts. 

In addition to standard typewriter letters and sym­
bols, you can generate special characters such as ® 
and J by using the Option and Shift keys in combi­
nation with standard alphanumeric keys. You can 
view these special symbols by using the Key Caps desk 
accessory. 

Points, picas, and styles 
Fonts are made up of type. A type size is expressed in 
picas and points. Six picas equal one inch and 12 
points equal one pica (72 points equal one inch). 
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Type weight refers to the heaviness on the letters. 
Type angle refers to the slant or degree of rotation of 
type. Type style refers to boldface, italic, OHl.llttftAl!lle, 

shadow, strikethm, underline, and other style op­
tions that come with most Mac applications. 

Types of fonts 
The two types of fonts are bit-mapped fonts (also 
called screen fonts) and outline fonts (also called 
PostScript fonts). A bit-mapped font is created when 
a particular pattern of dots or pixels (picture ele­
ments on your monitor screen) is filled in. The shape 
of the character depends on the pattern of dots on the 
screen; therefore, each sized character requires a 
separate pattern of dots. An outline font, however, is 
stored as a mathematical expression that generates 
the outline of the font, rather than as a pattern of 
filled-in pixels. With an outline font, a new size of a 
particular font is generated by changing the equation, 
rather than generating a new pattern of dots as with 
bit-mapped fonts. 

Bit-mapped fonts 
A bit-mapped font is a font in which the characters in 
the set are composed of a pattern or a matrix of dots. 
Because each dot represents an individual piece of 
information, bit-mapped fonts can take up lots of 
room, especially the larger point sizes. 

Bit-mapped fonts are designed for dot-matrix (the 
ImageWriter line) printers. Bit-mapped fonts are 
usually named after a city such as Geneva, Venice, or 
Monaco. The icon for a bit-mapped screen font is 
shaped like a suitcase (see fig. F.7). You install bit­
mapped screen fonts on your System using the Font/ 
DA Mover. 
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Fig. F. 7. The icon for a bit-mapped font (left) and an 
outline font (right). 

Because bit-mapped fonts consist of dots arranged in 
a pattern, they don't look terrific when printed on a 
laser printer, which accentuates the dots. The jaggies 
or staircase effect is especially apparent with type 
over 18 points in size (see fig. F.8). 

Chicago and Monaco 

Helvetica and Times 

Fig. F.8. Bit-mapped fonts (top) vs. outline fonts 
(bottom). 

Although you cannot get rid of these jaggies entirely, 
utilities such as Adobe Type Manager help smooth the 
appearance of the type. You also can select the 
Smoothing option from the Page Setup dialog box, 
which helps remove some of the roughness. 

Outline fonts 
When laser printers came along, the demand for high­
qualityfonts became tremendous. The old, bit-mapped 
fonts that were acceptable on the ImageWriter just 
couldn't do the job when the resolution was in­
creased to 300 dpi. 

Now, thousands of fonts can be downloaded to your 
printer and programs such as Fontographer, 
TypeAlign, and SmartArt, are available to help you 
design and manipulate fonts to suit your particular 
needs. 
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To change a font selection 
l. Highlight the text you want to change. 

2. From the Format, Font, or Type menu 
(depending on the application), select the 
name of the font and/or the font size. 

As long as your text is highlighted, you can reapply 
different fonts until you find the font you want to use. 

You can select the font and font size before or after 
you enter the text. 

To change a font size or style 
l. Highlight the text you want to change. 

2. From the Format, Font, or Type menu 
(depending on the application) , select the font 
size and style you want to apply to your 
highlighted text. 

Most programs have keyboard equivalents you can 
use to apply styles and increase/decrease point sizes. 
Check your on-line help screens or the documenta­
tion that came with the software. 

Notes 
Two different fonts within a given document are 
plenty. The same is true for font sizes and styles. Don't 
go nuts just because you can! 

If you are going to download fonts to your printer, be 
aware that each font has its own identification num­
ber and new fonts are assigned a number. If the font 
you download has the same ID number as one already 
present, you will not get the printed font that you 
expect. 

See also Font/DA Mover, Image Writer, Key Caps, La­
serWriter,Points, Special Characters and the "QUICK 
KEY GUIDE. " 
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The great graphics that the Mac brings co personal 
computing and the creative genius of the people who 
work with the Mac have produced some absolutely 
addicting games. There are software programs that 
resemble common games, from Yahtzee to Solitaire; 
baseball to hockey. There's something for everyone. 
As Macs gets faster and have more memory available, 
increasingly sophisticated games appear (see fig. G .1). 

Fig. G. I. 1be game Tesserae (Inltne Design). 

The best games (of which there are many shareware 
versions-check your Mac magazine) should fulfill 
the following criteria: 

• Provide entertainment and enable you to do 
things you could not otherwise do, such as 
play one-on-one with Michael Jordan or fly an 
F-16 jet. 

• Permit you to save your game so that you can 
pick up where you left it. 

• Keep track of the highest scores. 
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• Contain on-Line help. 

• Provide engaging visual and sound effects that 
make you feel as if you are right in the race car 
or in the baseball stadium. 

• Provide hints along the way if you need them 
so that the frustration does not get intolerable. 

• Enable you to change the characteristics of the 
game, such as the speed and shape of the 
target, the point values, or the consequences. 

• Come from a company that offers technical 
support and some type of update to the game. 

See also Bulletin Boards and Buying Software. 

The Get Info box provides you with detailed informa­
tion about a file or a folder. You access the Get Info 
box from the File Menu on the desktop. The following 
information is available: 

• File kind 

• File size 
• File location 
• Date of file creation 
• Date of last modification 
• Version of the application (if appropriate) 
• Locked status of the file 
• Suggested Memory Size 
• Application Memory Size 

You also can enter comments about the file at the 
bottom of the Get Info box (see fig. G.2). Note that 
you can enter more comments than the size of the box 
seems to allow-use the arrow keys to scroll through 
the comment. 



======================= Macintosh Topics 

ID Info 

~ FrH Hlnd 2 .02 

Ktnd: opplic•lion 
Stu: 7t9,479b\lltS ustd, 705Kondlsk 

lih•r•: H ... d Disk, CHS, t.8 (SCSI •o) 

CrHIM: Fri, Jun 23, 1989, 6 :22 PM 
Hetltfiff: Frl, .Jun 23 , 1989 , 6 :24 PH 
Y~rsio•: 2.02, © AltP-J• Corporation, 1988 

SU111Ht .. H .. >ory Stu (K): 7:50 

o\pp llc•Uoo H..,.ory Stu (K) : I t 200 I 

Fig. G.2. A Get Info box. 

To view infonnation about a.file or a folder 
1. At the desktop, select the icon for the file or 

folder you want information on. 

2. From the File menu, select Get Info (3€-1). 

3. Click the close box to close the Get Info box. 

To attach a comment to a file or folder 
l. At the desktop, select the icon for the file or 

folder you want information on. 

2. From the File menu, select Get Info (3€-1). 

3. Type your comments. Comments are saved 
automatically. 

4. Click the close box to close the Get Info box. 

To lock a.file or folder 
l. At the desktop, select the icon for the file or 

folder you want to lock. 

2. From the File menu, select Get Info (3€-1). 
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3. Click in the Locked box.~ designates 
"locked." 

4 . Click the close box to close the Get Info box. 

To unlock a file or folder 
1. At the desktop, select the icon for the file or 

folder you want to unlock. 

2. From the File menu, select Get Info (3€-1). 

3. Click in the Locked ~ box. The "X" disap­
pears. 

4. Click the close box to close the Get Info box. 

See also Files and Locking. 

, Graphics Programs la;;~~~-
You could consider every Mac application to be a 
"graphics" application. In addition to the newer 
graphics applications such as presentation graphics 
and multimedia, the Mac has graphics programs for a 
wide range of uses-everything from producing a 
newsletter to creating an organizational chart. 

Graphics programs represent a general class of appli­
cations that fall into two major categories: paint 
programs and draw programs. The primary distinc­
tion between the two is how they create graphic 
images. 

Paint programs, such as MacPaint, use bit-mapped 
images by darkening screen pixels to create the pat­
tern that forms the object. You can manipulate the 
shape of a paint object by using tools to add or delete 
individual bits. This flexibility is an advantage of paint 
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programs. A disadvantage is that the resolution of 
these bit-mapped paint images may not be high 
enough for finished art work, although there are 
paint programs (such as SuperPaint) that can pro­
duce paint images with a resolution of 300 dpi. 

Draw programs are object-oriented and, therefore, 
do not create an item as a configuration of dots. 
Instead, draw programs generate a mathematical 
expression that produces the outline of the drawn 
object. Each mathematical expression is represented 
as a separate physical layer so that you can draw one 
object and then place it over another without a 
conflict between the two. Because you are dealing 
with intact objects, the individual objects cannot be 
manipulated to the same degree as bit-mapped images, 
although they can be resized. 

The major advantage of draw programs is the high 
degree of precision with which you can create images 
and the smooth edges that characterize the finished 
graphic when printed. Draw programs were (and still 
are) the basis for the Computer-Aided Drafting/Draw­
ing programs, such as AutoCAD and Generic CADD. 

See also Desktop Publishing, DP!, and Draw Pro­
grams. 

The quality of help varies tremendously among appli­
cations. Some applications offer terrific on-screen 
help, while others offer nothing more than a sentence 
or two of copyright information. 

There are two types of on-line help: help as a menu 
item and context-sensitive help. The first allows you 
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to select Help as an item on the main menu or Apple 
menu. The second type of help provides you with a 
directory from which you select a topic . For example, 
in Figure H. l, "Borders" was selected from the main 
Help list, and Microsoft Word produces a sizeable 
amount of information about the particular feature, 
including the page number in the manual where you 
can find more information. 

ID Help 
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Ftg. H.J. A Help screen. 

The second type of help is C<!,Iled context-sensitive 
help. You don't have to go to a separate menu item to 
access context-sensitive help. Usually a keystroke 
combination produces a help screen about a particu­
lar topic or menu item. With Microsoft Word, for 
example, when y~u press the 3€-? key combination or 
press the Help key, the mouse pointer takes the 
shape of a question mark. Use this new mouse pointer 
to select a feature when you want help. 

See also Balloon Help in "SYSTEM 7 FIRST LOOK." 
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, Highlighting Text ,._.iiiiiiiiiiiiiiiiiiiiiiiiiiiiii~ 

To make any changes to text, you first need to 
highlight it. After you highlight text, you can change 
the font, point size, and style; you can delete it, 
replace it with other text, cu t it and paste it some­
where else, or copy it and paste it somewhere else. 

The I-beam is the tool with which you select text. At 
the desktop, the mouse pointer automatically turns 
into an I-beam when you click on a file name. 

In some programs, including most graphics pro­
grams, you must select the text tool prior to manipu­
lating text. 

To highlight a word 

I![ 

I. Point co any character in the word you want co 
highlight. 

2. Double-dick the mouse button and the word 
highlights (see fig. H.2). 

• Fiie Edit formot font Document Utllllies Window 

Untitled I 

You can highlightallusing your mou~. 

I 

Fig. H.2. Double-clicking to highlight a word. 

To highlight part of a word 
1. Place the mouse pointer to one side of the 

first word you want to highlight. 

2. Press and hold the mouse button. 

3. Drag the I-beam in the direction opposite 
where you first clicked, to highligh t the desired 
letters. 

4. Release the mouse button. 
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To highlight several words 

II[ 

1. Place the mouse pointer to the left of the first 
word you want to highlight. 

2. Press and hold fhe mouse button. 

3. Drag the I-beam to the right to highlight the 
desired words. 

4. Release the mouse button (see fig. H.3). 

'* Fiie Edit Format Font Document Utllltles Window 

Untltled1 

You can 

Fig.H.3. Highlighting several words. 

To highlight a portion of text 
1. Click at one end of the section you want to 

highlight. 

2. Press and hold the Shift key. 

3. Drag the I-beam across the characters you want 
to highlight. 

4. Release the mouse button and the Shift key. 

To highlight a large portion of text 
1. Click at one end of the section you want to 

highlight. 

2. Scroll to the other end of the selection you 
want to highlight. 

3. Press and hold the Shift key. 

4. Click the mouse button at the end of the text 
you want to highlight. 

5. Release the Shift key. 
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Notes 

When highlighting text, you can drag left to right or 
right to left. You can start highlighting at the bottom 
of a document and drag up, or vice-versa. 

If you have an extended keyboard, you can highlight 
text without using your mouse. Use the arrow keys to 
position the I-beam at one end of the text you want to 
highlight. Press and hold the Shift key. Use the arrow 
keys and the Home , End, Page Up,and Page Down 
keys to select text. 

You can triple-click to highlight a paragraph in 
Microsoft Word. 

See also Copying, Cutting, Mouse, and Pasting. 

, HyperCardll;iiiiiiiiiiiii====~ 
HyperCard is best described by the author of the 
original program, Bill Atkinson, as a software erector 
set. HyperCard literally lets you create anything from 
a simple phone directory to a complex program 
including animation and sound. HyperCard consists 
of several different building blocks, using the Meta­
phor of the library index with cards at the most basic 
level. 

A card is one screen's worth of information, and the 
basic unit of any HyperCard stack. A stack is a collec­
tion of cards. On any one of the cards, you can have 
a variety of information, such as text and graphics, 
charts, access to sounds, and even animation. 

Each card in a stack contains a background that holds 
text fields, buttons, and graphics. Figure H .4 shows a 
typical HyperCard application. The background is 
the information common to all cards in this stack, 
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such as the lines separating months and the spiral 
down the middle of the date book. 

Fields contain text, such as dates or the names of 
months. You use buttons to travel from stack to stack. 
A script controls the action of each button. You can 
edit the script using HyperTalk's simple English 
commands. 

1991 
a t t t r t s 

January!? ! : 1! I~ I; 1!1 

14 1$ 16 17 II 19 20 
21 22 2l 24 2' 26 71 
21 2' 31 31 

February 4 , , 7 ! ! ,! 
II 12 IJ 14 1' Ii 17 
II It 21 21 22 23 24 
25 26 27 ::I 

March 1 2 > 
.. ' ' 7 • ' 10 

II 12 IJ 14 '' 1' 17 
II It 20 21 22 23 24 
2' 26 21 '2t 2't 30 31 

o~ rn~ m 
d t t f t I I 

! ! 1! l~ ,; I~ 1! April 
" 16 11 18 19 20 21 
22 23 24 2:5 26 71 21 

"'" 
• 1 ! ! 1! 1~ 1; May 
ll 14 IS 16 17 II 1' 
20 21 22 23 24 2:5 %6 
21 21 29 JO 31 

I 2 June ,.,,,, , 
10 11 12 13 14 '' 16 
1'1 18 l'J 20 21 22 21 
242'UZ?2t2'l0 

Fig. H .4. A HyperCard application. 

HyperCard started a revolution because it enabled 
non-programmers to work with a sophisticated set of 
commands which produce effects that otherwise re­
quire extensive programming skills. As with all good 
applications, HyperCard has inspired competition. 
Other software developers are vying for the attention 
of HyperCard fans, and some are succeeding. Super­
Card has made in-roads into HyperCard 's market and 
Spinnaker PLUS, which aims at the business commu­
nity, is also an attractive alternative. 

, Icons liiiiil iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii-..-

An icon is a graphic representation of a file, folder, 
disk, or application. For example, disk icons look like 
floppy disks and folder icons look like file folders. 
Icons are the medium through which you work to 
select, move, copy, and delete files. 
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Applications create files with distinct icons, yet it is 
not just the application's icon that is visually differ­
ent. Data files (those you create) are distinct as well 
(see fig. 1.1). 

ID Appllntlon Icons I 
I I Utms 7S,S091< in disk 228K IV.tllM>lt 

-App Ii ca if> ~ ~ Y\. ,-7 p,! 

lions 

Data Iii 

- r~ii 
Mtoroso(t 'Word p...,..,.. H>cCr•v 61Jptt-P1\it ~11lustr1tor 

es -1 II [I ~ I ~ 
l•ttff" ~Ht¥slttttr" floorpl.an fTlffitl "'9o 

L!J 
5'jsttm foldtr 

Fig. 1.1. Icons for applications and documents. 

See also Files, Opening Files, ResEdit, and Viewing 
Files. 

In the early Apple days, the ImageWriter line of 
printers was IT if you wanted to print anything. The 
first day you got your printer, you thought it was the 
greatest, right? Then you saw other printers that 
could print high quality work- faster. Still, because 
of its price, the Image Writer remains the printer most 
commonly used with Macintosh computers. The orig­
inal Imagewriter (without the capital "W") was rela­
tively inexpensive (about$400 retail) and very reliable. 
Although Apple no longer manufactures this model, 
you can still rustle up a used one for about $150. 

The redesigned ImageWriter II replaced the old Im­
agewriter. The new printer offers basically the same 
features for about $600 retail. The newest Image Writ-
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er is the ImageWriter LQ, with the LQ standing for 
"letter quality" (although some people swear it stands 
for "large quantity"). The LQ is cumbersome, weigh­
ing-in at about 60 pounds. However, the LQ offers 
some outstanding features that make it a serious 
contender for those who need more than the Image­
Writer II, but less than a LaserWriter. Some of the LQ 
features include the following: 

• A wider carriage 

• An envelope feeder 

• Three levels of print quality 

• Printing resolution of 216 dpi 

• Four resident fonts 

• Several paper paths and sheet bins for feeding 
everything from certificates to mailing labels 

The LQ lists for about $1,400, although you can get it 
for about $1,000. This price is not much cheaper than 
many of the new laser printers available today. Even 
ribbons run about $20. For good, low-cost printing, 
you're not limited to an ImageWriter. GCC Technol­
ogies and Brother both offer compatible impact 
printers that produce an image as good as the LQ for 
about one-half the price. 

See also Buying Hardware, Laser Writer, Peripherals, 
and Printing. 

-j Initializing Diskslso ~~~~-
When you purchase new floppy disks, they are not 
ready to use. Think of a new disk as a parking lot on 
which the lines have not yet been painted. The cars 
(like the data) have no place to go. When the disk is 
initialized (the lines painted), the data (like the cars) 
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know where to park themselves, and your Mac knows 
where to find the data. 

Most hard disks are initialized (formatted) when you 
purchase them. If your hard disk is not, use the 
software that came with the drive to complete the 
initialization process. 

You don't have to remember whether a floppy disk 
has been initialized or not. Your Mac tells you if the 
disk you insert is unreadable-it asks you to initialize 
it (see fig. 1.2). 

i- -;:-1 This disk is unreadable: 

Do you wont t o initialize it? 

([ Eject )J [One-Sided) [Two-Sided) 

Fig. 1.2. Inserting a new floppy disk. 

If you insert a DOS-formatted 3 1/2-inch disk into 
your floppy drive, your Mac may tell you it's not a 
Macintosh disk. It then asks you if you want to 
initialize it. Be careful! Initializing a disk erases any 
data contained on that disk. 

To initialize a disk 
1. Insert the disk into a floppy drive. 

2. At the alert box, click Two-Sided. 

If you have a SuperDrive, click Initialize . If 
you are using old single-sided disks, click One­
Sided. 

3. Click Erase . (If you're not sure about what's 
on the disk, click Cancel .) 

4. Type a name for the disk and click OK (or 
press Return or Enter). 
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If you prefer, you can just click OK and name 
the disk later. 

To reinitialize a disk 
I. On the desktop select the disk you want to 

reinitialize. 

2. From the Special menu, select Erase Disk . 

3. Proceed with Steps 2-4 as described in the 
preceding entry. 

This procedure is useful for deleting all data on a disk 

Notes 

Initializing, formatting, or erasing a disk is serious 
business and is not the same as deleting all the files on 
the disk. Initializing removes all the information on 
that disk, including special disk tables that enable the 
Mac to resurrect files that may be deleted inadvertently. 

If you are going to erase, initialize, or format a disk, 
think twice about clicking that final OK in the dialog 
box. After you click the mouse button, any data is 
wiped off the disk! Some utilities (such as Norton 
Utilities or SUM II) can recover some files from a 
crashed or formatted disk, but as good as the pro­
grams are, there is no guarantee. 

Some companies sell initialized disks. 

See also Disks, Erasing Disks and Recovering Data. 

1 INITs ,....._iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

INITs are small utility programs that add functionality 
to your system. When placed in your System Folder, 
INITs load automatically and become active each time 
you start up your Macintosh. Like any other program, 
INITs take up a certain amount of RAM and the more 
INITs you have in your system, the less RAM is 
available for other Macintosh activities. 
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Popular INITs 

Following is a short list of typical INITs available 
today: 

/NIT 

After Dark 

Auto Mac 

Cheshire 

DiskTop 
Express 

What It Does 

Uses everything from fish to 
lightning to save your screen 
from burning in. 

Creates macros to automate 
keystrokes. 

Creates a variety of graphs based 
on data within an application. 

Enables you to copy, delete, 
etc., from within an application. 

Image Grabber Captures screen images as Paint 
files. 

MultiClip Creates multiple clipboards. 

SuperClock Places a clock in the upper right 
corner of the menu. 

Type Reunion Organizes similar families of type 
on the Font menu. 

Virex Scans your system and disks 
(inserted in your floppy drive) 
for viruses. 

To install an !NIT 

1. Insert the floppy disk that contains the INIT 
you want to install. 

2. At the desktop, double-dick on the icon of the 
floppy disk to view its contents. 

3. Drag the icon of the INIT you want to install 
on top of the System Folder on your hard disk 
or startup disk. Shift-click to select more than 
one INIT. 
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4. When the System Folder icon reverses, release 
the mouse button. 

5. Under the Special menu, select Restart. 

To deactivate an INIT 

Notes 

1. At the desktop, double-dick on the System 
Folder icon. 

2. Scroll to find the INIT you want to remove. 

3. Drag the INIT out of the System Folder to the 
desktop or to another folder. 

4. Under the Special menu, select Restart. 

When you have several INITs, they may clash, causing 
a system crash or nullifying one another. If your INITs 
clash, you must selectively remove INITs from the 
System Folder or change the order in which they load. 
INITs load in alphabetical order, so you also can 
change the order in which INITs load by changing the 
name of an INIT (from "OnCue" to "zOnCue," for 
example). You also can change the INIT loading 
order through the use of a commercial product such 
as INITPicker. 

See also CDEVs, Crashes, System, and Utilities. 

, Inserting a Disk I---~~~~;;;; 
A 3 1/2-inch floppy disk is the only size disk you can 
insert into a floppy drive on your Mac. The disk you 
insert must be the same density or lower than the 
density of your disk drive. For example, a SuperDrive 
can read a high-density disk, a double-density disk, 
and a single-density disk. A regular double-density 
drive can read a double-density or single-density disk; 
it cannot read a high-density disk. A single-density 
drive can read only a single-density disk. 
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To insert a floppy disk 
1. Hold the disk with the label facing up and the 

metal circular piece facing down. Look for the 
arrow on the floppy disk (see fig 1.4). Point the 
metal shutter toward the drive. 

Fig. l4. Af/oppy disk. 

2. Gently insert the disk into the drive. You 
should feel it catch and your Mac will do one 
of the following things: 

• Accept the disk and display a disk icon in 
the upper right corner of the desktop. 
Double-dick on the icon of the disk to 
view the disk contents. 

• Determine that the disk is "not a Macin­
tosh disk" and ask whether you want to 
initialize it. If it's blank, go ahead and 
initialize it. 

• Spit the disk out. The machine is looking 
for a startup disk. Insert a disk containing 
a System and Finder, or startup from the 
hard disk. 

See also Disk Drives, Disks, Ejecting Disks, and Ini­
tializing Disks. 

1 Installing Software l .. ~~~-
You can install software in a variety of different ways, 
depending on its type (desk accessory, INIT, and so 
on) and size. Most software can run off of a floppy 
disk. But more and more applications, because of 
their complexity, need to be installed on a hard disk. 
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Applications installed on a hard disk run much faster 
and are readily available. 

To install desk accessories, use the Font/DA Mover. 
To install control panel devices (CDEVs) and INITs, 
drag their icons into the System Folder. 

The simplest way to install software on a hard disk is 
to drag the application icon into a folder you create 
for that application. Some software applications, 
however, are larger than the SOOK a typical floppy 
disk holds. These larger applications must be in­
stalled or restored using the program that comes with 
the application. This method requires you to double­
click on the installation program (usually named 
Install) and then follow the on-screen instructions. 

Before you install new software .. . 

Whenever you have a disk containing new software, 
the first thing you should do is lock that disk. Locking 
the disk prevents you from writing new material on 
top of existing material. 

Second, you should make backup copies of each 
disk(s). Use only the backup copies oforiginal disks­
never the originals. Store the originals in a safe off-site 
location. 

To install new software onto your bard disk 
(method 1-formal installation) 

1. Insert into your floppy drive the disk contain­
ing the software you want to install. 

2. On the desktop, double-click on the icon of 
the floppy disk to view the disk contents. 

3. If you see a file labeled "Read Me," double­
click on it. If you see a file labeled "Install," 
double-dick on it and follow any screen 
prompts. 

If neither a "Read Me" file nor an "Install" file 
is present, follow Method 2. 
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To install new software onto your hard disk 
(method 2-copyingftles) 

Notes 

1. At the desktop, from the File menu, select 
New Folder. 

2. Insert the floppy disk containing the applica­
tion you want to install. 

3. Double-dick on the icon of the floppy disk to 
view its contents. 

4. If you see a file labeled "Read Me," double­
click on it. 

5. From the Edit menu, select Select All (~A) to 
select all the icons on the floppy disk. Drag the 
icons from the floppy disk on top of the New 
Folder icon on the desktop. 

6. When the folder icon reverses, release the 
mouse button. The files copy to the hard disk. 

7. Double-click on the icon of the new folder to 
view the contents. 

8. After checking to see that all files copied to the 
hard disk, drag the icon of the floppy disk to 
the Trash Can to eject it. 

Some applications come on multiple disks. These 
programs may need to be installed using the Install 
procedure. When copying files, be sure to copy all 
files from all floppy disks into one folder on your hard 
disk. 

Some applications must be unstu.ffed or decompressed 
using Stuftlt or DiskDoubler prior to use. These files 
will not work by merely copying the files to your hard 
disk. 

See also Copying, File Compression, Files, and 
Font/DA Mover. 
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, Keyboard l a-iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

Besides the mouse, the keyboard is your main com­
munications link to your Macintosh. Keyboards are as 
personal as any other part of the Mac, and even more 
so because a keyboard that fits your way of working 
can make the difference between work and pleasure. 
The original keyboard came with a total of 58 keys, 
was small, and didn't have extras such as a numeric 
keypad or function keys. Today, you can get key­
boards with up to 105 keys. You even can purchase 
modular keyboards that assemble to fit your needs. 

Good keyboards have the following characteristics: 

Notes 

•A solid, not a mushy, feel when you press the 
keys. 

• An ergonomic design so that the face of the 
board is slightly tilted in your direction. 

• Optional audio feedback (clicking) when you 
press the keys. 

• Keys that are large enough for moderately 
large fingers. 

• Numeric keypad for fast data and financial 
entry. 

• Programmable function keys. 

• Adjustable key resistance. 

• Macro software for automating keyboard 
activities. 

A handy way to make the most out of your extended 
keyboard is to purchase a program such as QuicKeys2 

(from CE Software). QuicKeys2 enables you to assign 
several procedures to a particular key. For example, 
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you can tell your Mac to make highlighted text 14 
point, bold, italic, Helvetica- all with the press of one 
button! You also can insert the current date in a 
document simply by pressing Control-D, for exam­
ple. Such macro-defining software can save you time 
and frustration. 

See also Keyboard Shortcuts and Macros. 

, Keyboard Shortcuts l .. iiiiiiiimiiiiiiiiiiiiiimiiiiiiiiiiiiiimiiiiii 

Keyboard shortcuts are key combinations you can 
press to issue commands, rather than selecting com­
mands from a menu. The commands are identical to 
those you issue from a menu. 

Keyboard shortcuts are available in all Macintosh 
programs. When you pull down a menu, you notice 
the menu commands. Do you notice also the fre­
quently overlooked keyboard equivalents listed next 
to those commands (see fig. K.1)? 

Undo 3€2 

Cut 
Copy 
Paste 
Clear 

8eH 
sec 
81l U 

Select Rll 81l R 

Show Cl ipboard 

Keyboard 
equivalents 

Fig. Kl. Keyboard equivalents appear next to menu 
commands. 

Most keyboard shortcuts use the Command key in 
combination with character keys. The Command key 
contains the ~ and 0 symbols. Following are some 
key combinations that are common to most Mac 
applications. 
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Key(s) 

3€-C 

3€-F 

3€-N 
3€-0 
3€-P 

3€-Q 
3€-S 
3€-V 

3€-W 
3€-X 

3€-Z 

Action 

Copies text or graphics to the 
Clipboard. 

Finds a word or phrase. 
Creates a new file or folder. 
Opens an existing file. 
Prints an existing file . 
Quits an application. 
Saves a file. 
Pastes text or graphics from the 
Clipboard. 
Closes the active window. 
Cuts text or graphics and copies 
it to the Clipboard. 

Undoes the most recent command 
or action. 

3€-. Selects Cancel in a dialog box; 
cancels a procedure. 

Enter Selects the default in a dialog box. 

Return Selects the default in a dialog box. 

Shift- Moves to the previous field in a 
Tab dialog box. 

Tab Moves to the next field in a dialog 
box. 

See also the "QUICK KEY GUIDE." 

, Key Caps ... , iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii._ 

There are times when you want to change fonts, but 
you are not sure how the particular font may look. At 
these times you can use the Key Caps desk accessory. 
You can select a font on the Key Caps menu and then 
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see exactly how the fonts in your system will appear 
in your documents. 

To view font characters 
1. From the Apple w menu, select Key Caps. 

2. From the Key Caps menu, select the font you 
want to view (see fig. K.2) . 

Fig. K.2. Examining the Monaco font. 

3. Press and hold the Option key, or the Shift­
Option key-combination, to see which charac­
ters are available using a particular font in 
conjunction with either of these key combina­
tions. 

4. Click the close box to exit Key Caps. 

See also Desk Accessories, Fonts, and Special Char­
acters. 

, LaserWriter1;;;I ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;__. 

The LaserWriter family of printers helped to bring the 
Mac into the high-tech world of desktop publishing. 
First came the LaserWriter, then the LaserWriter Plus, 
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and now a selection of LaserWriters that fits every 
printing need. 

LaserWriter SC 

Fast on the heels of the LaserWriter Plus (which is no 
longer manufactured) was the first QuickDraw print­
er developed by Apple, the LaserWriter SC. This non­
PostScript printer was fairly inexpensive (about 
$2,800), but it still had a good deal to offer such as lM 
of RAM, four resident fonts, and a relatively cheap and 
easy upgrade to the next printer level. Apple no 
longer manufactures SCs, but you can still find them 
in the used-computer market. 

LaserWriter IINT 

The LaserWriter IINT is a true PostScript printer, of­
fering a larger range of fonts and sizes. The IINT can 
be networked with non-Macintosh printers and non­
Macintosh computers. 

LaserWriter IINTX 

The top-of-the-line LaserWriter is the LaserWriter 
IINTX. Its sizeable RAM can be upgraded to 12M­
enough to download a large number of fonts. You can 
store these fonts on the hard disk that attaches to the 
printer through the printer's SCSI port; you do, 
however, pay for this convenience. 

Personal LaserWriter SC 

The competition from other companies (such as GCC 
Technologies and Texas Instruments) has forced 
Apple to come up with two less-expensive printers: 
the Personal LaserWriter SC and the Personal Laser­
Writer NT. The new SC is like the discontinued 
LaserWriter SC. The new SC is a QuickDraw printer 
that can't be shared with other computers . At $2,000 
retail, however, the new SC is much less expensive 
than the old SC. The new SC is still not as cheap as 
other non-Postscript Mac printers, but it is a step in 
the right direction. 
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Personal LaserWriter NT 
The new Personal LaserWriter NT, though not net­
workable, is a true PostScript printer and costs almost 
$2,000 less than the original NT. It weighs only about 
30 pounds(15 pounds less than the old Nl); fits in small 
spaces; is fast, and is open to adding more memory; 
and has emulation modes so you can make your Mac 
think that it is printing to a LaserJet or a Diablo 630 
daisy wheel printer-all for less than $3,500 retail. 

See also Buying Hardware, Image Writer, PostScript, 
Printing, and QuickDraw. 

~Launching Applications .. , ~-
Launching an application means starting a software 
program. If you want to write a letter, you launch a 
word processing program. If you want to create an 
illustration, you launch a draw or paint program. 

To launch an application 
At the desktop, double-dick on the icon of the ap­
plication you want to launch. 

To launch an application by opening an existing 
document 

At the desktop, double-dick on the icon of the docu­
ment you want to work on. 

The application that created that document launches 
automatically, and the document appears on-screen. 

Notes 
Several products are available that to he lp your 
launching efforts, such as On Cue (from ICOM Simu­
lations) or DiskTop (from CE Software). On Cue 
creates a pop-up menu of applications in the upper 
right corner of your screen. You simply select the 
application you want to use. With DiskTop, you 
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simply double-click on the DiskTop icon and the 
app lication launches. 

See also Files, Mouse, Opening Files, and Startup 
Screen . 

1 Locking l 
Sometimes you may want to safeguard data by locking 
the floppy disk containing the data. When a disk is 
locked, you can view the contents, but you cannot 
change the contents. You can 't even rename a file on 
a locked disk. You can, however, copy files from a 
locked disk to an unlocked disk, and then make 
changes to the copies. 

It is good practice to lock all new application disks. 
For example, when you take out your new PageMaker 
installation disks, the first thing you do is lock these 
disks. 

To lock a floppy disk 

Slide open the little plastic switch on the upper 
corner of the disk so that you can see through the 
hole. 

To unlock a locked floppy disk 

Slide shut the little plastic door on the upper corner 
of the floppy disk so that you cannot see through the 
hole. 

To lock an individual file or application 
1. At the desktop, select the fi le or application 

you want to lock. 

2. From the File menu, select Get Info ( 3€-1) . 

3. Click the box D at the upper right corner of 
the Get Info screen. l:8l means "locked." 

4. Click the close box. 
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To unlock a locked file or application 
1. At the desktop, select the locked file or appli­

cation you want to unlock. 

2. From the File menu, select Get Info (3&-I) . 

3. Click on the box [gl at the upper right corner 
of the Get Info screen.D means "unlocked." 

4. Click the close box. 

See also Files and Get Info. 

Macintosh Systemss;;, -..;;;;;;;;;;;;;;;;;;;;;;;;;;-

This section provides a chronological listing of Macs 
currently available . Although Apple no longer manu­
factures some of these models, they are available in 
the used-computer market. Refer to Table M. l for a 
comparison of system specifications. 

Mac Plus (discontinued) 

The Mac Plus is no longer manufactured, but can be 
found in many homes and offices today. The Plus is 
slower than the rest of the Macs and has some 
limitations, such as no internal hard disk and limited 
memory (lM of RAM, expandable to 4M), but Mac 
Plus is the ideal place to begin. 

Introduced in October, 1985, this machine has been 
the standard for thousands of Mac users, and you can 
do a great deal with it, including word processing and 
desktop publishing. 

The Mac Plus is especially cost-effective if you need to 
set up several Macs. 

Mac SE (discontinued) 
Although the SE uses the same CPU as the Plus, and 
runs at the same clock speed, due to design en-
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hancements, the SE runs more than 20 percent faster 
than the Plus. 

The SE has an expansion slot (the Plus does not) so 
you can use various upgrade cards. You also can 
upgrade an SE to an SE/30, which you cannot do with 
a Plus. The Mac SE has plenty of room inside for two 
floppy drives or an internal hard drive and a floppy 
drive . This Mac also has been taken out of produc­
tion. 

Mac II (discontinued) 

The Mac II, introduced in May, 1986, was the top of 
the line until Apple introduced the Ilxseries. The Mac 
II has six slots for expansion and color capabilities, 
and supports monitors much larger than the SE's 
display. What the Mac n offered most was increased 
speed (four times as fast as an SE), which was wel­
comed by many, but the Mac II's lack of portability 
made it less attractive. The II was the first Mac to have 
a 68020 processor, which proved inferior to the 
68030 processor. 

Mac Ilx (discontinued) 

The Mac Ilx has six expansion slots-twice the num­
ber of expansion slo ts as the newer Mac IIs, but it 
takes up more desk space. The Ilx supports two 
floppy drives (or a floppy drive and a hard drive) 
rather than one. 

MacSE/30 
The SE/30combines the best of the SE (like the Super­
Drive) with some features of the higher-end Macs, 
such as the Mac II's higher processing speed. 

Most notably, the SE/30 has a faster 68030 central 
processor, which enables you to speed up your work 
greatly-up to four times the speed of an SE. 

Probably the nicest thing about the SE/30 is that it's 
the same size as the original SE. The Mac II family 
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Table M.1. 
Macintosh Specifications 

Max. Speed No. Floppy Built· in Retail 
Model RAM Proc. (MHz) Slots Drive Video Price 

128K 128K 68000 8 0 400K b/w $400• 

512K 512K 68000 8 0 400K b/w S500* 

512Ke 512K 68000 8 0 SOOK b/w S6oo• 

Plus 4M 68000 8 0 BOOK b/w S700• 

SE 4M 68000 8 800, l.4M b/w n ,200• 

11 32M 68020 16 6 BOOK S3,400-4,700* 

SE/30 32M 68030 16 1 l.4M b/w S4, 100·5,800 

llx 32M 68030 16 6 1.4M S2,500* 

Hex 32M 68030 16 3 1.4M S4,700• 

llci 32M 68030 25 3 1.4M color S7,200·7,900 

Ponable 9M 68000 16 l.4M b/w S4 ,800-5,500 

llfx 32M 68030 40 6 l.4M Sl0,800-
12,800 

Classic 4M 68000 8 0 1.4M b/w S999-l ,500 

LC lOM 68020 16 1.4M color S2,500 

llsi 17M 68030 20 1 l.4M colo r $4,900-5,700 

*Discontinued; the price shown is for a used system. 

7befollowing models are currently available: SE/30, /lei, Portable, 
lift:, Classic, LC, and llsi. nie rest of the models are no longer 
manufactured, but y ou may still find new SEs and llcxs on retailers ' 
shelves. 

All macbines above tbe 512Ke bave a minimum RAM of JM, w ith the 
exception of the Portable, LC, and !Isl, wbich have a minimum of 2M. 

Retail Price ranges from minimum system configuration to maximum 
system configuration, as of January, 1991. 
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(which you have to move up to for more processing 
power and speed), on the other hand, is larger (25 
pounds for the central unit alone) , and you need to 
purchase the monitor separately. Because the SE/30 
has room for expansion, there are expansion cards 
available that enable you to use external color mon­
itors, connect with IBM mainframe computers, and 
take advantage of networking options. 

Mac Portable 
The Portable offers all the features that make a Mac a 
Mac and does so at the convenience of transportabil­
ity and long battery life (six to twelve hours compared 
to other portables' two or three). It comes with 
standard Mac ports and an optional internal hard 
drive. But the highlight of the portable is its clear, 
crisp Active Matrix Liquid Crystal Diode display. The 
Portable does have some shortcomings: absence of 
color, weight (16 pounds), and only one source for 
batteries (Apple). However, it is a Mac! 

There are, however, alternative laptops such as the 
Colby Systems SE-30 and Dynamac's SE-30 (which 
comes with a built-in modem) . Areal contender is the 
10-pound Outbound portable, which is much cheap­
er (about $2,500) than the other portables. 

Apple and Sony plan to introduce a tiny notebook 
Mac late in 1991, which may please those looking for 
a portable portable. 

Mac II ex (discontinued) 
The first thing you notice about the Mac Ilcx is its size. 
The footprint is noticeably smaller than the other Mac 
Ils, so the entire system fits neatly under a standard 
monitor. The llcx is smaller because it has only three 
expansion slots, a smaller power supply, and a con­
densed motherboard (the main logic board). The 
Mac Ilcx has the speed and power you need if you 
want to enter the world of more powerful Macs. 
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Mac/lei 

The Ilci offers everything that the Ilcx has to offer, 
only the newer Mac is faster (50% faster than the Ilcx) 
and has built-in color video capability. Number 
crunchers love the addition of the co-processor, 
which processes instructions when mathematical 
and other large "thinking" operations take place. 
Many users (and reviewers) think that this model is 
the best Mac available, given its modular design in 
combination with the aforementioned features. 

Macllfx 

Vroom! This is about as far as you can go right now 
with the Mac. Speed, speed, and more speed is what 
distinguishes the Ilfx from the other high-end Macs. 
In fact, with its special architecture, the llfx runs 70 to 
100 percent faster than the Ilci. The Ilfx uses static 
RAM (SRAM), an especially efficient way to process 
information. Not that you will need it, but the IIfxalso 
can create 16.7 million colors. At a retail price of 
about $9,000, this Mac does not come cheaply, but if 
you must have the best, look no further. 

Mac Classic 

Available since November, 1990, this new Mac is 
destined to replace the Plus and the SE. It offers a 
SuperDrive and IM of RAM, and a microphone for 
audio input. The Classic is compact and has limited 
expandability. With this machine, Apple is targeting 
people who want to get into the Mac scene for less 
than $1,000. 

Mac LC 

This new Mac (LC for low cost color) is the first low­
cost color Mac available. The LC comes with 2M of 
RAM, and voice input capability, easily surpassing the 
old Mac II in power, speed, and usability. Weighing in 
at only 8 pounds, the LC is almost portable. The LC 
offers color capability and an emulation card so that 
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it can run Apple Ile software. Apple is aiming the LC, 
along with the Classic, at the educational and home 
market. 

Mac Ilsi 

The Mac Ilsi is the third of the new Macs recently 
released. A modularly designed color Macintosh, the 
Ilsi uses the same CPU as the Ilcx and runs about four 
times faster than the Plus. It also has sound capability, 
and is almost twice as fast as the SE/30, yet sells for 
$3,800 list (almost $1,000 less than the SE/30). The 
llsi is the fastest Mac available, following only the Ilfx 
and Ilci. 

A macro is a series of keystrokes that you define and 
save as a set for later use. After you press the key 
combination that you assign to a macro, all the 
keystrokes that are part of that macro execute. Macros 
are time-saving tools that can perform tasks ranging 
from underlining a word to generating a complex 
format for a newsletter. 

Two types of tools are available for creating macros: 
those that come as part of applications and those that 
are separate utilities that operate regardless of the 
application. WordPerfect, for example, comes with a 
powerful macro language which provides editing 
plus a variety of macro functions. You can create a 
simple macro by selecting the Macro command from 
the Special menu, defining the macro, and then 
entering the keystrokes. Once you define the macro, 
WordPerfect remembers the keystrokes and executes 
them on your command. 

The second type of macro is generated by utilities 
such as QuicKeys2 (from CE Software) and Tempo 11 
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(from Affinity). These utilities are macro generation 
tools that are instaJled as part of your System and are 
always available when you need them. An important 
advantage of using these independent utilities is their 
flexibility across applications. You also can use 
MacroMaker, which comes as part of Apple 's system 
software. 

See also System. 

Should you buy through the mail? You see advertised 
tempting prices offered by one of the thousands of 
third-party (Apple is the first party, and you are the 
second) vendors. You see these advertisements in a 
periodical such asMacUser,MacWeek, MacWorld, and 
the Sunday New York Times. How good are the 
prices? 

You can expect to pay about 40-50 percent below list 
price for software and about 40 percent below list 
price for hardware purchased through a mail-order 
vendor. 

When contemplating buying software or hardware 
through the mail, keep the following questions in 
mind: 

• How long has the company been in business? 

• Is there an in-house service department? 

• When do they charge your credit card (upon 
receipt of your order or upon shipment)? 
Using a charge card always gives you some 
recourse (a chargeback. or credit) if you are 
dissatisfied for just reasons. 

• When can you expect to receive you order? 

• What are the re turn policies? 
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• Is there a toll-free technical support hot-line? 

Do you need technical support? lf the answer is yes, 
you may want to purchase from a local dealer rather 
than through the mail. 

See also Buying Hardware and Buying Software. 

You can prevent both minor and major Macintosh 
repairs-and the accompanying bills-by remember­
ing the foll9wing maintenance guidelines: 

• Keep your computer and peripherals clean and 
free of dust by vacuuming (the outside!) and 
wiping down the surfaces using a mild liquid 
detergent, not alcohol. Don't clean color 
monitor screens with anything other than a 
product designed for that use. Dust covers are 
an inexpensive, but worthwhile, investment. 

• Keep food and drinks away from your work 
area. 

• If you smoke, do it away from your machine. 
Smoke particles can get on the head of a 
floppy drive and wreak havoc. 

• Clean your mouse by turning the ring on the 
underside counter-clockwise. Use alcohol 
(unplug your mouse first) and cotton swabs to 
get out the gunk. Several commercial mouse 
cleaning products are available as well. Also, 
replace your mouse pad every year or so to 
make sure that you track on a clean surface. 
You can clean mouse pads made of cloth. 

• Store your disks in a cool, dry area away from 
your Mac or external floppy drives. 

• Minimize the heat to which your computer is 
exposed. 



======================== Macintosh Topics 

Notes 

• Vacuum the inside of your Image Writer to get 
rid of the little paper bits. Use alcohol (unplug 
the machine first) or a commercial platen 
cleaner to remove old ink. Also, always use 
paper that is under 20 lbs. 

• Use light sewing machine oil on the moving 
partS of your Image Writer every six weeks. 

Make backups of all your data as frequently as you can 
stand to. Have several different backup sets that you 
rotate. Keep your backups at a different location. 

Remember to check warranty information to find out 
which activities void your warranty. If you take apart 
your Mac and try to fix something yourself, you may 
void your warranty. 

See also Backups, Disk Drives, Disks, Mouse, and 
Troubleshooting. 

A menu is a listing of commands that you activate by 
using the mouse or keyboard to select an item from 
the list. Every Macintosh application works through a 
series of menus that appear across the top of the 
screen. Many menu items are similar across applica­
tions. 

The opening Mac desktop screen shows the Main 
menu bar including the Apple w, File, Edit, View, and 
Special menu (see fig. M.1). Macs that contain color 
capabilities also have a color menu option. 

Each of these menus has a list of commands from 
which you can select. The five menus that you see on 
the opening screen are standard for the desktop. 
Each Macintosh application, however, has a different 
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set of menus that are designed to fit the particular 
features of the program. For example, within differ­
ent applications, the File menu may contain slightly 
different commands. 

Fig. M.1. The menu bar on the desktop. 

To select a command from a menu 
1. Position the mouse pointer on the name of a 

menu at the top of your screen. 

2. Press and hold the mouse button. You can see 
the commands available from that particular 
menu. 

3. While pressing the mouse button, drag the 
pointer down to the menu command you want 
to select. 

4. Release the mouse button to activate the 
highlighted menu command. 

The menu item flashes to tell you that it has been 
activated. 

To move from one pull-down menu to another 
1. Position the mouse pointer on a menu. 
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2. Press and hold the mouse button. You see the 
commands that are available on that particular 
menu. 

3. Move the mouse pointer to the right or left to 
point to a different menu. 

To browse through a menu listing 

Notes 

1. Point to the menu you want to view. 

2. Press and hold the mouse button. 

3. Drag the pointer down to view specific com­
mands. 

4. To stop viewing the menu without selecting 
any commands, simply drag your pointer off 
the menu, and release the mouse button. 

Commands that appear dimmed are not active menu 
items and have no effect if chosen. For example, you 
can't open a file until you first select a file. 

Keyboard shortcuts appear next to many menu items. 
These key combinations accomplish the same task as 
selecting that particular command from a menu. For 
example, if you want to save a file , you can select the 
Save command from the File menu or use the ~S 
keyboard shortcut. 

Some applications have menu customization options. 
For example, with Microsoft Word you can add com­
mands to an existing menu by using the Commands 
option from the Edit menu. With FileMaker Pro, you 
can make frequently used procedures menu items. 

You also can change the way menus appear by using 
the programming tool ResEdit. 

See also Keyboard Shortcuts, ResEdit,'and the "QUICK 
KEY GUIDE." 
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A modem is a basic part of any telecommunications 
system because it enables you to transmit and receive 
computer-generated data over the telephone. The in­
coming phone line plugs into one modem jack, and 
then a phone line is connected from the second 
modem jack to a telephone. A modem is the hardware 
that lies at both ends of the transmission. The phone 
line links the two modems together. The modems 
modulate and then demodulate basic signals so that 
the computers on each end can "talk" with one 
another. 

Types of modems 
Modems can be internal or external, and come in a 
variety of speeds, measured in baud rates. A baud is 
a measure of how fast information goes from digital 
to audio and back again. The higher the baud rate, the 
faster the modem. A baud rate of 300 was the stan­
dard, then 1200, 2400, and now baud rates of 9600 
are available. Current modem prices range from $89 
to thousands of dollars. 

Purchase considerations 
If you plan to purchase a modem, consider the 
following suggestions: 

• Be sure that the modem is Hayes-compatible 
(the industry standard). 

• Be sure that the speed you buy is compatible 
with the speed of the modem with which you 
will be telecommunicating. When they match 
and you "shake hands" (called handshaking!), 
things work fine. Discrepancy in speeds leads 
nowhere fast and produces garbled data. 

• Look for software or a modem that comes with 
a built-in buffer that enables you to store 
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information (such as messages or even small 
downloaded programs) for later use. 

• Purchase only what you need. If all you need 
to do is send short notes around the country, 
don't bother with the high power, fast, expen­
sive modems. A simple 1200 or 2400 baud rate 
capability is adequate. 

• Extra features (if you want to pay for them) 
include automatic dialing and redial. Check 
the software for these features. 

See also File Compression , Networking , and 
Telecommunications. 

~ Monitorsllii -----------------
The first Mac had a nine-inch screen (as do the Classic 
and the SE/30), but you now can find everything from 
two-page displays to the revolutionary Pivot Display 
System (from Radius), which changes the orientation 
of the screen image as the monitor's physical orienta­
tion is changed. 

Monitors are similar to television sets. How clear an 
image appears is a matter of resolution, which de­
pends on several factors. 

The first variable is the number of pixels (picture 
elements), measured both horizontally and vertical­
ly. A high resolution display may show up to 1,664-by-
1,200 pixels. That's almost two million pixels on the 
screen-enough to show the finest detail. 

The second variable is the horizontal scan rate-the 
rate at which horizontal lines are drawn across the 
screen. The higher the rate, the better the image. 
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The final variable is the refresh rate. The refresh rate 
is the speed at which the monitor brings its light level 
up to full capacity. 

Monitors can be monochrome , show a variety of 
shades of gray, or be color. The color monitors can be 
expensive, but the images they can produce are 
nothing short of amazing. 

When pricing monitors, make sure to inquire about 
graphics boards. Some monitors are packaged with 
any necessary boards; other monitors require a sep­
arate purchase. Your system may already support the 
monitor you select, without requiring you to pur­
chase a board. 

You can use a color monitor with an o ld Mac. Make 
sure you have a slot available for the board you need 
for your new monitor. 

See also Buying Hardware. 

The mouse is the pointing device that comes with 
your Macintosh. You move the mouse and your Mac 
translates those movements to the screen. 

Today's mouse is similar to the model introduced 
with the original Mac. You can plug the mouse con­
nector into a port on the back of your Mac or into the 
keyboard (you even can choose which side of the 
keyboard). 

The mouse pointer generally appears on your screen 
in the shape of an arrow, an I-beam, or a watch. The 
shape of the pointer changes depending on the 
function that the mouse is performing and the ap­
plication you are using. For example, the mouse 
pointer appears as an I-beam during most text aper-
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ations; the pointer changes to a wristwatch when 
your computer is busy thinking. The tip of the pointer 
indicates where an action takes place. 

To use a mouse 
With the mouse on a clean, flat surface, slide it in 
different directions. A5 the ball on the underside of 
the mouse rolls around, little sensors inside your 
mouse send messages to your Mac. The computer 
translates these messages and moves the mouse 
pointer on-screen accordingly. 

Basic mouse techniques 
Basic mouse tasks involve pointing, clicking, and 
dragging. Each of these techniques has an important 
purpose. 

Pointing involves learning to move the mouse to 
select menus, commands, objects, and text. To do 
anything with a file, object, or portion of text, you 
must learn how to select those items. Clicking and 
double-clicking, in conjunction with pointing and 
dragging, create all of the necessary mouse functions. 
Dragging enables you to do two things: move an 
object from one location to another, and highlight a 
specific range of text, or a number of objects. 

To point to an object 
Place your mouse on a flat surface. Move the mouse 
until the tip of the pointer arrow is over the object you 
want to select or activate. 

If you run out of mousepad ... 
If you run out of mousepad as you try to move the 
pointer, try this technique: lift up the mouse and 
place it in the center of the mouse pad. 

Notice that the pointer doesn't move when you move 
the mouse; the pointer moves only when the ball 
inside the mouse moves. You now can scoot the 
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mouse pointer anywhere on the screen using a small 
area of mouse pad. 

To select an object 
1. Point to the object you want to select. 

2. Click the mouse button once. To click, press 
and release the mouse button. Do not move 
the mouse as you click. 

Selected icons reverse from white to black or change 
color. 

To deselect an object 
Click anywhere on the screen other than on that 
object. 

To select more than one object 
1. Press and hold the Shift key. 

2. Click on one of the objects you want to select. 

3. Click on another object you want to select. 

4. Continue clicking on objects until you have 
selected all the items you want to select. 

5. Release the Shift key. 

This action is called Shift-clicking and is handy when 
you want to take the same action (such as deleting) 
with more than one item. 

To select objects by drawing a marquee 
A marquee is an invisible box that you draw to 

highlight several icons on the desktop. Drawing a 
marquee highlights those items contained within the 
marquee lines. Any action you take (drag, trash , 
duplicate, or copy) affects all items within the mar­
quee. 

1. Place the mouse pointer to the upper left of 
the object(s) you want to select. 

2. Press and hold the mouse button . 
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3. While pressing the mouse button, drag the 
mouse diagonally toward the lower right of the 
object(s) you want to select. 

4 . Release the mouse button. 

To deselect an object when more than one object is 
selected 

1. Press and hold the Shift key. 

2. Click on the object you want to deselect. 

3. Release the Shift key. 

To drag an object 
1. Point to the object you want to move. 

2. Press and hold the mouse button. 

3. Drag the mouse to position the object where 
you want it. 

4. Release the mouse button. 

To double-click 
1. Point to the object you want to open or 

activate. 

2. Click the mouse button twice in rapid succes­
sion. 

If you click too slowly, your Mac does not recognize 
the action as a double-dick. Clicking too quickly does 
not present a problem. 

To change the responsiveness of your mouse 
1. Under the Apple 9 menu, select Control 

Panel. 

2. Select the icon for the Mouse device. Scroll if 
necessary. 

3. Select the desired mouse tracking and repeat 
rate. 

4. Click the close box to activate your changes. 
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Tracking determines how far your pointer moves 
when you move your mouse. If you select the fast 
speed, when you scoot your mouse a tiny bit, the 
pointer will move a greater distance across the screen 
than if you select a slower speed. 

To clean your mouse 
Although the mouse is reliable, it can quickly develop 
a disease endemic to the species called "dirtitis." 
Dirtitis develops when gunk and junk from the mouse 
pad and your desk get into the mechanical workings 
and prevent smooth rolling. You can use alcohol and 
cotton swabs to cure your mouse and keep it happy. 

I. Shut down your Mac and unplug the mouse 
cable. 

2. Turn your mouse upside-down. 

3. Rotate the plastic ring counter-clockwise. (If 
your mouse doesn't come apart this way, 
check the manual that came with your mouse 
to see how to remove the ball.) 

4. Cup your hand over the ring and turn the 
mouse over. The ring and the ball fall out. 

5. Using a cotton swab dipped in rubbing alco­
hol, rub the gunk off the little plastic wheels 
inside the mouse. 

6 . Making sure the ball is free of crumbs and 
other particles, insert the ball back into the 
mouse, secure the plastic ring, and rotate the 
ring clockwise: 

7. Plug the mouse cable back into the proper 
port, start up your machine, and enjoy the 
feeling! 

Mouse alternatives 
Many people stick with their mouse forever, but there 
are now alternatives such as an optical mouse (with 
no moving parts to dirty) , the Isobar (on the Out-
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bound portable computer), trackballs (like an upside 
down mouse where you move the ball, rather than 
moving the casing that contains the ball), and even 
The Cordless Mouse (from Practical Solutions) where 
infra-red technology allows you to use a mouse that 
does not have a tail! There also are pens and tablet 
input devices available. 

See also Highlighting Text, and Scrolling. 

,r Mouse Pads 1;1 ======~ 
A mouse pad is a flat object on which you maneuver 
your mouse. The pad is a luxury item designed to 
enhance your tactical mousing experiences. 

The standard pad is generally six-by-nine inches and 
is made of a material that has enough friction to 
enable the ball on the underside of the mouse to 
rotate with the slightest mouse movement. As usual, 
there are now mouse pads that resemble Swiss cheese 
or contain crazy visuals. Some mouse pads are even 
clear, enabling you to slide a picture of your favorite 
boss underneath so that you can roll all over his or her 
face! If you do not have a mouse pad, you can 
substitute the plastic cover of a loose-leaf binder. 

See also Mouse. 

Multifinder is a file located in the System Folder. 
When you activate MultiFinder, it replaces the Finder 
and enables you to do multi-tasking-open more 
than one application at a time. For example, with 
MultiFinderyou can have Filemaker sorting a database, 
while at the same time having instant access to 
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SuperPaint. MultiFinder is ideal for individuals who 
go back and forth regularly between applications. 

Because MultiFinder is so powerful, it affords you 
certain luxuries. One luxury is background printing 
(printing while you continue to work). Apple provides 
a small program named Print Monitor, to enable you 
to control several printing functions as you work. 

MultiFinder requirements 
You can run MultiFinder on any Mac starting with the 
Mac Plus. You must have the following to run Mul­
tiFinder: 

• Minimum of System 6.0 and Finder 5.0 in­
stalled. 

• At least 2M of RAM. 

To activate MultiFinder 
1. From the Special menu, select Set Startup. 

2. Click the radio button labeled MultiFinder. 

3. Click OK. 

4. From the Special menu, select Restart. 

To switch applications 
You can switch between several open applications by 
clicking on the icon in the upper right corner of the 
screen (see fig. M.2). Click until you get to the 
application you want. 

You also can select the desired application from the 
list at the bottom of the Apple w menu, or double­
click on the application's icon on the desktop. 

Before selecting an application from under the Apple 
W menu, you can press and hold the 3€ key to get rid 
of the DAs in the listing. 
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Fig. M.2. The MultiFinder icon. 

To launch applications automatically upon startup 
1. Shift-dick to select the applications you want 

to load automatically. 

2. From the Special menu, select Set Startup . 

3. Click the radio button labeled MultiFinder . 

4. Click the radio button labeled Open Applica­
tions and DAs . 

5. From the Special menu, select Restart . 

To open documents automatically upon startup 
1. Shift-dick to select the documents you want to 

open automatically. 

2. From the Special menu, select Set Startup . 

3. Click the radio button labeled MultiFinder . 

4. Click the radio button labeled Selected items . 

5. From the Special menu, select Restart . 
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To view memory allocation 
1. At the desktop, from the Apple menu, select 

About the Finder . 

You see a bar listing of the memory allocation 
used in your system. 

2. Click the close box to exit the window. 

To adjust an application's memory size 
1. From the desktop, select the icon for the 

application you want to check. 

2. From the File menu, selectGet Info . 

In the lower right comer of the Get Info 
window, you see the amount of memory that is 
suggested, and the amount that is allocated to 
run the application (see fig. M.4). 

3. Click in the Application Memory Size (K) 
box, and type the amount of memory that you 
want to allocate, for example, 1024 . 

4. Click the close box to exit the Get Info box. 

5. From the Special menu, select Restart . 

I nfo 

lock• d 0 
Microsoft 'Word 
Microsoft Word 4.0 

Kind : •pplicatlon 
Siz•: 683,296 bytts ustd, 668K on disk 

Yhon : 20M, SCSI 0 

Cr•.it•d: Mon, Apr 10, 1989,5:00PM 
Hodifi•d: F"ri, Apr 21 , 1989, 1 :04 PM 

Yto rsion: 4 .0 , © 1987- 1989 Microsoft 
Corpor-.t lon 

Su99• st•d H•mory S iz• (IC) : 512 

Application He-mory Siz• (K): EJ 

Fig. M.4. A Get Info window. 
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To temporarily disable MultiFinder 
1. Press and hold the Option key. 

2. From the Special menu, select Restart 

3. After the Mac finishes boo ting, release the 
Option key. 

To reactivate the Finder 
1. From the Special menu, select Set Startup. 

2. Click the radio button labeled Finder. 

3. Click OK 

4. From the Special menu, select Restart. 

You can tell thatMultiFinderis no longer active by the 
disappearance of the MultiFinder icon from the up­
per right corner of the Mac screen after restarting. 

Notes 
You may not need to use MultiFinder, especially if 
you use only one application regularly. 

MultiFinder is very RAM intensive. With insufficient 
RAM, you might get MultiFinderto work, but you may 
be limited to running only one application besides 
MultiFinder, which may not make it worth the effort. 

Background printing is turned on automatically when 
you activate MultiFinder. 

You need to adjust the Finder's memory size after 
getting a Not Enough Finder Memory message. 

MultiFinder will be standard fare for System 7. In 
other words, MultiFinder will always be operating 
under the new System. 

See also Crashes, Finder, Get Info, System, Print 
Monit01-, and Printing. 
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A network is a particular configuration of devices, or 
nodes (computers, printers, plotters, etc.) , that are 
connected so that information can be shared be­
tween these devices. The devices in a network are 
usually connected by cables, and some are connected 
using modems across "bridges" that connect net­
works located in other cities. A Macintosh, no matter 
which model, comes with a built-in network capability 
called AppleTalk. AppleTalk is the standard system 
for sharing information over a network. 

See also AppleTalk, AppleShare, and Modem. 

The Note Pad is a desk accessory located on the Apple 
menu. Note Pad enables you to write up to eight 
pages of notes; retrieve them whenever you want; 
cut, copy, and paste from them; and more. Anything 
you enter in the Note Pad is saved automatically­
even if your battery goes down or you rebuild the 
Desktop file. 

Note Pad consists of eight pages that you can fill as 
desired (see fig. N.1). 

To enter text into the Note Pad 
1. From the Apple 9 menu, select Note Pad 

2. Click anywhere on the Note Pad. 

3. Type the text you want to record. The comput­
er saves the text automatically when you close 
the Note Pad. 

4. Click the close box to exit the Note Pad. 



Click here 
to move to 
the previous 
page 
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~O Note Pod 

Word Search 

·s - nonbreaking space 
•t - tab mark 
·p - paragraph mark 
·n - end of line mark 
·- - optional hyphen 
·d - section mark 
•• - caret 
., - formula character 

Fig. N.l . The Note Pad desk accessory. 

To flip through Note Pad pages 

Click 
here to 
move to 
the next 
page 

In the lower left corner of the Note Pad window, there 
are two triangles. Click in the upper triangle (folded 
up) to move to the next page; click in the lower 
triangle to move to the previous page. 

To replace text in the Note Pad 
1. Highlight the text you want to replace. 

2. Type the new text. 

To remove text from the Note Pad 

Notes 

1. Highlight the text you want to remove. 

2. Type the replacement text or press Delete to 
remove the text without replacing it with new 
text. 

Each of the eight Note Pad pages stores 12 lines of 
text. 

Text does not automatically flow to the next page in 
the Note Pad. 

The Note Pad does not support graphics. 
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See also Desk Accessories, Desktop, Rebuilding the 
Desktop, and Scrapbook. 

Optical Character Recognition (OCR) software takes 
a file created by a scanner, and turns the scanned text 
into an editable file. OCR software reads text as text 
rather than just as a set of graphic characters. The 
software also interprets scanned images for your 
application. Scanners can also scan different levels of 
grays, and some models scan and interpret color. 

Types of OCR software 
The following list describes three basic types of OCR 
software: 

Notes 

• Nontrainable software is limited to the specific 
text and printers for which it was designed. 

• Trainable software can be trained or taught so 
that it can follow a template and read almost 
any style of type. 

• Automatic software includes some artificial 
intelligence features and is designed to read 
text without any kind of training. 

No OCR program is perfect. You must read through 
a scanned document to be sure that there are no 
errors ofomission (things that are not there that should 
be) or errors of commission (things thatare there that 
shouldn't be). 

See also Scanning. 
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d Opening Files ~I ~~~~~ 
There are two ways to open files: from the desktop 
and from within an application. 

To open a file from the desktop 
Double-dick on the icon of the file you want to open. 
The application you used to create the file opens and 
the contents of the file appears on-screen. 

To launch an applicationfrom the desktop 
Double-dick on the icon of the application you want 
to launch. The application launches and a blank 
screen appears, ready for you to begin working. 

With some programs, you see a dialog box asking you 
to specify what type of document you want to create. 

To open afilefrom within an application 
1. From the File menu, select Open (see fig. 

0.1). 

2. Select the disk that contains the file you want 
to open. 

Click Drive to view the contents of another 
drive. 

3. Select the folder that contains the file you want 
to open. 

Double-click on the name of a folder in the file 
listing to view the contents of that folder. 

Click on the name above the Open button to 
move upward through folders in the hierarchy. 

Point to the name of the folder above the file 
listing, and press and hold the mouse button 
to view the names of the folders higher in the 
hierarchy. Release the mouse button to select 
the names of the folder containing the file you 
want to open. 
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4. Scroll through the file listing until you find the 
name of the file you want. 

5. Double-dick on the name of the file you want 
to open. 

Click 
here to 
select a 
different 
level in 
the 
hierar­
chy 

Notes 

Select a Document: 

~Jen's Stuff 

' 1111111111lflflfl\ 

Cl HyperCard 
Cl System Folder 
D tes t 
Cl Tour Folder 
Cl Utllltles 

Click 
here to 

r:==""o""ue'"'s"'"E,..3"'°o,_ 11 move up one 
4SS4K auallable level in 

GEJ1~ the 
r.:::::::71 ~ hierar-
~ ~ chy 

D Read Only 

Fig. 0.1. The Open dialog box. 

Some applications support multiple open files. 

See also Files and Launching Applications. 

Orientation specifies whether an image prints with 
the long edge of the paper horizontal or vertical. 
Apple refers to these settings as Tall/Wide on Image­
Writer printers and Portrait/Landscape on LaserWrit­
er printers (see fig. 0.2). To print this book on a 
LaserWriter, we set the orientation to portrait. 

II~ w;do Tall 

Image Writer 

Portrait Landscape 

Laserwriter 

Ftg. 0.2. Orientation settings. 
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Mose programs are preset portrait orientation unless 
you specify landscape. You usually find orientation 
settings by selecting Page Setup or Print from the 
File menu. 

To change the orientation of a document 

Notes 

1. From the File menu, select Page Setup. 

2. Select icon for the orientation you want. 

Some programs do not display orientation 
settings as icons; the programs require you to 
click a checkbox to change the orientation 
setting. 

3. Click OK 

Orientation sectings differ from application to appli­
cation. Sometimes you must first select Options from 
the Page Setup or Print dialog box to gee co the 
orientation settings. 

See also Page Setup and Printing. 

The Page Setup command, common co most Mac 
applications, enables you to set basic parameters as co 
how a Mac page appears when printed. The contents 
of the Page Setup dialog box depends on the type of 
printer you use (see figs. P.1 and P.2). 

~lm~o•ge~W~r~lle~r~~~~~...,.....~~~~_...i;x2""'1 c:E:J) 
Poper: ®US Letter 0 R4 Leiter 

0 US Legal 0 lnternattonnl fanfold 
0 Computer Paper 

Ortentallon Special Effects: D Tall Adjusted 
O so ~ Reduction 
0 No Gaps Between Pages 

Fig. P.1. The ImageWriter Page Setup dialog box. 
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LaserWrlter Page Setup , .2 
Poper : ®US Let1er O A4 Le11er O Toblold 

O us Legol O 85 Let1er 

~~l~~~~:org3 
Orten1ot1on 

gmi~ 

Prlnter Effects: 
r8) ron1 Substltutlon? 
C8) TeHt Smoothing? 
cg) Graphics Smoothing? 
[8l raster Bitmap Printing? 

loocument ... J cgi fractional Widths O Print Postscript Duer l eHt 

O Se1 Default 

Fig. P.2. The LaserWriter Page Setup dialog box. 

Both the Image Writer and the LaserWriter Page Setup 
dialog boxes have the following features: 

• Paper enables you to select the type of paper 
you are printing on, including US Letter (8.5 
inches by 11 inches), US Legal (8.5 inches by 
14 inches), A4 Letter (11.75 inches by 8.25 
inches), B5 (10 inches by 7.5 inches, for 
LaserWrirers only), and Tabloid (11 inches by 
17 inches, for LaserWriters only). The Image­
Writer also has Computer Paper (11 inches by 
13 inches) and Fanfold (paper that comes in 
attached sheets) options. 

• Orientation sets whether the image prints with 
the long edge of the paper horizontal or 
vertical. 

• Special Effects (ImageWriter) permits you to 
make adjustments for the difference in the dpi 
between the Mac screen and the ImageWriter; 
reduce the size of the output (50% reduction); 
and avoid gaps between pages (the No Gaps 
Between Pages option). You also can reduce or 
enlarge from 25 to 200 percent. 

• Printer Effects (LaserWriter) enables you to 
substitute fonts when they are not variable (the 
Font Substitution option); to lessen the 
occurrence of jaggies (the Text Smoothing 
option and Graphics Smoothing option) ; and 
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process bitmap images prior to sending them 
to the printer (the Faster Bitmap Printing 
option). 

See alsolmageWriter, LaserWriter, Orientation, and 
Printing. 

- Paper I 
Paper is not just paper. Most dot matrix printers limit 
your choice to fanfold paper, which comes in con­
nected sheets, unless you want to insert 8 l/2-by-11-
inch pieces individually. If you use fanfold paper with 
your lmageWriter, you may want to purchase paper 
perforated with a laser during manufacturing. When 
you separate this paper, it has a very sharp edge that 
looks like single-sheet paper. 

You also should consider the weight of the paper. 
Weight is expressed in pounds of one ream (500 
sheets of paper). For example, 500 sheets of25-inch­
by-38-inch paper weighs 60 pounds. Therefore, the 
weight of the paper is referred to as "60 pound." 

Some printers cannot handle paper heavier than 24 
pound. The paper-feed mechanism often determines 
which size paper a printer can handle. Some laser 
printers enable you to print heavier paper on a 
straight path, whereas the conventional path could 
not handle heavier papers. 

There are also different types of paper. Use the 
standard bond for letters, textured paper for special 
uses, uncoated paper for general printing, coated 
paper (with a clay finish co help hold ink) for desktop 
publishing, and heavy cover paper for covers. 

See also Printing. 
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The Paste command is a close cousin of the Cut and 
Copy commands located on the Edit menu. Once text 
or a graphic is cut o r copied, the Clipboard stores it 
automatically. You then can paste the stored element 
into another location. A cut or copied item is stored 
in the Clipboard until you cut or copy ano ther item to 
the Clipboard or shut down your Mac. 

You can cut and paste within a document, between 
documents, or between applications. You also can 
paste an element into the Scrapbook for long-term 
storage. 

To cut and paste 
1. Highlight the text you want to cut or select the 

item you want to cut. 

2. From the Edit menu, select Cut (3&-X) . 

3. Select the location where you want the cut 
text/item to appear. 

If you want to paste into the same document, 
scroll to the desired location and click. 

If you want to paste into a different document, 
quit the current application, launch the other 
document, scroll to the desired location, and 
click. 

4. From the Edit menu, select Paste (3&-V). 

To view the contents of the Clipboard 
1. From the Edit menu, select Show Clipboard 

2. Click the close box to exit the Clipboard. 

To paste an item from the Clipboard 
1. Click where you want the text or graphics to 

appear. 

2. From the Edit menu, select Paste (a€--\? . 
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To paste an item into the Scrapbook 
1. Select the item you want to paste into the 

Scrapbook. 

2. From the Edit menu, select Copy (:ig.C) . 

3. From the Apple 9 menu, select Scrapbook 

4 . Scroll, if you want, to select a position within 
the Scrapbook. 

5. From the Edit menu, select Paste (:ig.V) . 

6. Click the close box to exit the Scrapbook. 

To paste an item from the Scrapbook 

Notes 

1. From the Apple 9 menu, select Scrapbook 

2. Scroll to find the item you want to use. 

3. From the Edit menu, select Copy (:ig.C) . 

4. Click the close box to exit the Scrapbook. 

5. Click where you want the text or graphic to 
appear. 

6. From the Edit menu, select Paste (:ig.V) . 

You may paste an item as many times as you want, as 
long as that item remains in the Clipboard or Scrap­
book. 

See also Clipboard, Copying, Cutting, and Scrapbook. 

A peripheral is any external device that attaches to 
your Macintosh. The general classes of peripherals 
are external bard and floppy drives, printers, plotters, 
scanners, modems, CD-ROM drives, and pointing 
devices such as mice and drawing tablets. Most 
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peripherals plug into the back of the Macintosh in the 
appropriate port (as indicated by the icon) . 

If you have more than one SCSI peripheral to connect 
to your Mac, you can chain up to seven together. You 
can "daisy-chain" SCSI devices only if each one has a 
unique ID# (from 0-6). Most SCSI devices have a 
switch that allows you to change the address. For 
instructions on changing a SCSI address, consult the 
manual that came with your peripheral. 

Caution 
Never attach or detach peripherals with your Mac 
turned on. Always shut down the Mac properly before 
you begin hooking up new items or disconnecting 
anything. 

See also SCSI. 

The Paged Memory Management Unit (PMMU) makes 
virtual memory a reality. Virtual memory allows part 
of your hard disk to be used as RAM. Virtual memory 
improves the Mac's management of calculation-in­
tensive tasks. 

The PMMU is a separate chip that is built into the 
68030 central processing unit (found on most newer 
Macs) and can be installed on other models. But the 
chip alone does not do the trick. You need virtual 
memory software. Support for virtual memory is 
built-in to the upcoming System 7, so the extra 
software will not be necessary for machines running 
System 7. 

See also Macintosh Systems and Virtual Memory. 
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~ Postscript ·m;;I =====~ 
PostScript is a page-description language from Adobe 
Systems that prepares an image for priming. This 
language describes the shape of the image (a letter or 
a graphic) as a mathematical formula that defines an 
outline to be drawn and then filled . The language­
licensed to various printer manufacturers-is the 
most popular page-description language. PostScript 
provides the most power and the greatest number of 
options for producing high-resolution images (in­
cluding fonts). 

PostScript, in contrast with QuickDraw and other 
page-description languages, does not use any prede­
termined shapes; different characters do not need to 
be stored. Postscript waits for a command to draw a 
graphic and then sends a message to the printer 
telling the primer how to draw that particular shape. 

Actually, the command comes to the printer as a 
QuickDraw command (which is stored in ROM), and 
the page description language translates that com­
mand for the printer. 

Some printers (such as GCC Technologies Personal 
Printers) produce print of the same quality as Post­
Script by using QuickDraw technology. QuickDraw 
printers, however, lack the flexibility to create graph­
ics or text with an infinite number of size and shape 
options. 

Because Postscript is a programming language, there 
are now products (such as Adobe's SmartArt or 
Broderbund's TypeStyler) that enable you to pro­
duce PostScript effects by issuing English commands. 

See also Fonts, LaserWriter, Printers, and Printing. 
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, Print Monitor ._, iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

Print Monitor is a small spool program (included with 
your System software) that enables you to print while 
you continue working. Print Monitor allows you to 
specify when a print job prints. It notifies you about 
dwindling paper supply and signals when to insert 
paper manually. 

To activate the print monitor 

Notes 

1. From the Apple w menu, select Chooser. 

2. Click to select Background Printing 1:8l. 

3. Click the close box to exit the Chooser. 

4. From the Apple w menu, select Print Moni­
tor. 

5. Select from the available options. 

6. Click the close box to exit the Print Monitor. 

Print Monitor must be in your System Folder along 
with your printer driver. Print Monitor only works 
under MultiFinder. You must activate Background 
Printing in the Chooser dialog box in order for Print 
Monitor to work. 

See al!!O Chooser, MultiFinder, Printing, and Print 
Spooler. 

Your printer can take up a great deal of time printing 
large documents. A print spooler is a handy program 
that enables you to continue working while you print 
a file. A print spooler tells the Mac to send the file you 
want to print to a disk file until the printer is ready for 
that file. The file , therefore, waits on the disk and does 
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not tie up your Macintosh. You even can have many 
files in the spooler queueing up to print. 

Many companies--such as Orange Micro, the pro­
ducers of the Grappler Spooler-sell print spoolers 
that can have up to one thousand documents waiting 
to be printed, provided you have the disk space. 

Print spoolers are software solutions. Print buffers 
perform the same function as spoolers, but print 
buffers are hardware solutions. A print buffer is an 
actual device inserted between your Macintosh and 
your printer. When you direct your Mac to print, the 
Mac sends the file to the buffer where the file stays 
until your printer is ready to print the file or until you 
instruct the buffer to print. 

See also Printers and Printing. 

You can use many different types of printers with 
your Mac, provided you have the software that en­
ables your Mac to talk to that printer. 

The three main types of printers are: dot matrix, ink 
jet, and laser. 

Dot matrix printers 

Dot matrix is the most-used type of printer. Dot 
matrix printers print using impact technology: a 
series of pins in the print head strike through a nylon 
or a cloth ribbon containing ink, thereby forming a 
character as an impression. Today, dot-matrix print­
ers with 24-pin print heads are quite common, and 
the quality of output is acceptable for most Mac users. 
The ImageWriter line of printers is of the dot-matrix 
variety. 
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Ink jet printers 
Ink jet printers are a relatively new type of printer. Ink 
jet technology produces a very fine spray and "paints" 
the character on the page. The sprayed ink is dry as 
the page finishes printing. The best ink jet printers 
print about six pages per minute at a quality very close 
to that of a laser printer. 

Laser printers 
The laser printer is the printer with the best quality 
and speed of output. Laser printers are ideal for 
desktop publishers. Laser printers used to be expen­
sive- the most inexpensive one you could get to 
work with the Mac was more than $4,000. Today's 
laser printers, however, are more affordable, starting 
at $1,300. 

See also Buying Hardware, ImageWriter, Laser­
Writer, PostScript, Print Spooler, and Printing. 

Printing is the production of a copy on paper of the 
work you have created on-screen. 

In order to print Mac files, you must have a Macintosh­
compatible printer connected to the proper port on 
your Mac or available to you on a network. You also 
must have a printer driver in your System Folder that 
matches your type of printer (the basic drivers come 
with your system software). 

Individual applications such as PageMaker require a 
"prep" file- Aldus Prep, for example-to be present 
in addition to your printer driver in your System 
Folder (application-specific prep files come with the 
application software). You also must select the print­
er through the Chooser desk accessory. 
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You can print a file two ways: from within the appli­
cation or from the desktop. Before you print anything, 
however, you must select a printer driver from the 
Chooser. The system file that makes a printer work is 
called a printer driver. For your printer to work (and 
for it to show up on the Chooser), you must have the 
correct driver for your printer in the System Folder 
when you boot up. 

Print options 

The Print dialog box gives you a number of options. 
Among those options, you can indicate the following: 

• Which pages you want to print. You do not 
have to print the entire document each time 
you issue the Print command. 

• The number of copies you want to print. 

• Whether you want the paper feed to be 
automatic or manual. 

• The quality/speed level you need (ImageWriter 
only). If your work is a draft, try printing in 
draft mode. 

To select a printer 
l. From the Apple w menu, select Chooser. 

2. Select the icon of the printer you want to use. 

3. Click on the name of the printer. 

4. Click the close box to exit the Chooser. 

You may find it helpful to select Page Setup from the 
File menu upon creating a new document. This 
procedure ensures that your Mac uses the proper 
document specifications when printing to the selected 
device. 

To print a.file from within an application 
l. Open the document/file you want to print. 

2. From the File menu, select Print (3€-P). 
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3. Click OK, or press Return or Enter. 

The Print dialog box contains several different op­
tions that enable you to determine how your printed 
output appears. 

To print a file from the desktop 
1. Select the icon of the file you want to print. 

2. From the File menu, select Print ~-P). 

3. Click OK, or press Return or Enter. 

Your Macintosh automatically sets up the file for 
printing and waits for you to tell it to go ahead and 
print. 

To cancel printing 
Press 00-. (period) to stop the print procedure. If the 
job has transferred entirely from the Mac to the 
printer, this procedure may not work. 

If you use a print spooler, you may be able to pause 
the spooling action and delete the file from the 
queue. 

To print the contents oftbe screen to an Image­
Writer 

Press Shift-00-4 . 

This procedure works on lmageWriters and compat­
ible printers only. 

To print the contents of the active window to an 
Image Writer 

Press Caps Lock-Shift-00-4. 

This procedure works on ImageWriters and compat­
ible printers only. 

To create a screen dump file 
Press Shift-00-3 . 
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Your Mac numbers screen dump files in order, start­
ing with "ScreenO," to a maximum of IO files. Rename 
the files to make room for 10 more screen dump files. 

You may open, print, or alter a screen dump file using 
any standard paint program (such as MacPaint or 
SuperPaint). To print the contents of a screen, simply 
print the paint file. 

To print the contents of the screen to a LaserWriter 

Create a screen dump and then prim the screen 
dump file. 

To print a listing of flies and folders 
1. At the desktop, open the window that contains 

the files of which you want a list. 

2. Under the File menu, select Print Directory. 

To prevent the test page from printing 
Laser printers generally run through auto-test rou­
tines whenever you tum them on. The printers as­
sume that you want a report of the findings, and 
generously spit out such a report each time you 
startup your printer. To prevent the printer from 
printing this test sheet, pull out the paper tray just 
enough to prevent the paper from feeding. Push in 
the tray after several minutes elapse. 

If you have trouble printing .. . 
If you cannot get your document to print, check the 
following: 

• Is your printer turned on? 

• Is your surge protector light on? 

• Is the "select" button activated? (ImageWriter 
only) 

• Are your cable connections secured? 

• Is the paper supply adequate? 

• Is there a paper jam? 
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• Did you check your Chooser settings? Are all 
three items selected: icon for printer, name of 
printer, and user name? 

• Do you have the proper printer driver in your 
System Folder? If not, copy the correct driver 
from your original system disk to the System 
Folder on your hard disk. 

• If you have a spooler, did you check the print 
queue? 

• Did you check your Page Setup selections? Do 
they reflect the specifications for document 
you want to create? Are your margins properly 
set? 

• Did you check your Print selections? Are your 
feed selections correct? Is your page range 
correct? 

• Did you check your page breaks? 

• Do you have the proper fonts installed in your 
System? 

Occasionally, it helps to shut off your printer and turn 
it back on again. Doing so clears out the printer's 
memory. 

Notes 

To see what a document will look like when printed 
(without wasting paper), look for a Print Preview 
command. Check the manual that came with your 
software to see if such a command is available. Some 
programs have a Print Preview command under the 
File menu; others allow you to preview a document 
from the Print dialog box. 

See also Chooser, Fonts, ImageWriter, LaserWriter, 
Page Setup, Paper, Print Spoolers, Printers, and 
Troubleshooting. 
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, Programmer' sSwitch 111;;;;;;;----
The Programmer's Switch is the extra piece of gray 
plastic that came with your Mac. The switch contains 
two buttons: Reset and Interrupt. Use the Reset but­
ton (an arrow) to reset your Mac instead of turning it 
off and on again- useful in the event of a crash. The 
Interrupt button (a circle) is used primarily by- you 
guessed it- programmers. 

You install a Programmer Switch (on most machines) 
simply by snapping it into place. A few Macs require 
that you open the case to install the switch. On the 
Mac 128K through the SE/30, install the switch on the 
left side of your Mac. On the Mac II and above, install 
the switch on the right side. For the Hex and the IIfx, 
install the switch on the front. The Mac Portable 
doesn't use a switch. 

To install the Programmer's Switch, consult your 
manual (or have your dealer install the switch). 

See also Crashes. 

Like PostScript, Quick.Draw is a page-description and 
display language that is part of the Macintosh oper­
ating system. Quick.Draw tells your Mac how to dis­
play and print characters and graphics. Quick.Draw 
(developed by MacPaint and HyperCard genius Bill 
Atkinson) is responsible for the ease and speed with 
which you can move icons on the desktop. Unlike 
other page description languages, Quick.Draw is built 
into the ROM of the printer. 
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Unlike PostScript, QuickDraw requires no extra li­
censing fee. QuickDraw does, however, have some­
what limited type capabilities. It provides a high 
quality-although fixed-set of fonts. For example, 
the LaserWriter II SC has four fonts of various sizes 
and QuickDraw prints these fonts beautifully. If you 
try to print a 13-point font when 12-point is resident, 
you won't get the same quality; the SC may have 
trouble approximating the new size. 

Apple's efforts at developing an Apple page-descrip­
tion language may eliminate the need to purchase 
Postscript and thereby lower the price of high-quality 
laser printers. 

See also Postscript and Printing. 

Just turn off your machine, right? Wrong. 

Why can't you just tum off your machine? Your Mac 
is always very busy, even when you think it is just 
sitting there waiting for you to enter information. 
Your Mac spends part of this time keeping track of 
files. When you perform shut-down procedures, your 
Mac gets the message to do some "housekeeping." 
These tasks include putting files in the right place and 
closing files that may be open and so forth. In addi­
tion, shutting down prepares your Mac so that the 
beginning of the next work session goes smoothly. 

If you do not select the Shut Down command, the 
next time you boot up, you will find your Mac takes 
longer to display the desktop. This delays occurs 
because your Mac needs time to finish the clean up 
chores it should have had time to complete during 
the last session. In addition, you may lose data if you 
simply switch off your machine. 
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To quit an application 
1. From the File menu, select Quit @€-Q ). 

2. Save your file if prompted to do so. 

You may want to use the Close command instead of 
the Quit command. The difference is that Quit re­
turns you to the desktop, whereas Close allows you to 
open another document created within the same 
application. 

To shut down the Mac 
1. Quit any active applications. 

2. At the desktop, from the Special menu, select 
Shut Down. 

The Mac II series of computers automatically turns off 
when you issue the Shut Down command. The com­
pact Macs need you to turn off the power. The switch 
is on the back of the machine. 

Notes 
You must return to the desktop prior to shutting 
down. 

You may leave windows open on the desktop when 
you shut down; it isn't necessary to clear the desktop 
prior to selecting the Shut Down command. 

See also Files, Restarting, and Shut Down. 

Random access memory (RAM) handles temporary 
information storage. Random access memory is the 
place where your Mac does all of its thinking and 
scratch pad work. RAM is perhaps the most precious 
of all Mac commodities, because you must have 
adequate space to store all of the application direc-
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tions while you are working. In general, the more 
RAM you have, the more room there is to work, and 
the faster your Mac can operate. 

The basic Mac Classic comes with IM of RAM, which 
used to be more than enough. With the introduction 
of applications that take almost IM by themselves (to 
say nothing of the System and Finder space require­
ments), you can run out of room quickly. In addition, 
with the increasing demands of System 7, there will 
come a time when you need at least 2M of RAM to use 
the minimum of your Mac's capabilities. Fortunately, 
you can upgrade your Mac easily (at less than $100 
per megabyte). 

The Mac is sensitive if you don't have enough RAM; it 
alerts you when there is an insufficient amount to 
continue. When you get such a message, you can look 
to three possible sources of the difficulty. First, and 
most obvious, the application you want to use needs 
more memory than is available. Second, you have 
Control Panel devices (CDEVs) or INITs that are too 
big (or you have too many). Upon booting up, these 
utilities load, and there is insufficient RAM left for any 
further computing activity. Finally, you may have set 
the RAM cache too high, and RAM is going where it 
shouldn't. 

Because RAM is only temporary, any unsaved infor­
mation left in RAM (such as the unsaved contents of 
your document) is lost when you turn off the Mac. 

See also Crashes, MultiFinder, RAM Cache, SIMMs 
and Upgrading. 
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RAM cache (pronounced "cash") is a part of the Mac's 
memory dedicated to specific operations that are 
performed frequently by the computer. 

As processors get faster, the gap increases between 
how fast a computer processes information and how 
fast a hard disk can retrieve that information. We need 
something to dose that gap. That's where RAM cache 
comes in (see fig. R.1). 
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Fig. R.1. Setting the RAM cache. 

RAM cache affects the time it takes to access a file o r 
application. It also can improve the time it takes to go 
back and forth among applications running under 
MultiFinder. 

When you activate RAM cache, any disk-based opera­
tion you perform automatically gets stored in the 
cache.When you perform a particular task, your Mac 
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reacts quicker the second time you perform the task 
because your Mac doesn't have to go all the way back 
to the disk. The larger the cache, the faster things 
work. 

To change the RAM cache setting 
l. From the Apple ti menu, select Control 

Panel. 

2. Select the General device from the list of 
device icons. Scroll if necessary. 

3. Click on the up or down lever in the RAM 
cache box to increase or decrease the amount 
of space available to the cache. You can 
increase the RAM cache in 32K increments. 

4 . Click the close box to exit the Control Panel. 

5. At the desktop, from the Special menu, select 
Restart. 

Which RAM cache setting do you use? 
Changing the RAM cache setting is highly experimen­
tal. Apple recommends that your RAM cache setting 
not exceed 25% of RAM. If you allocate RAM through 
the RAM cache at greater than 348K per megabyte of 
RAM, your Mac resets the RAM cache to 348K per 
megabyte of RAM. 

If you have less than 2M of RAM, activating RAM cache 
will not significantly affect your system. See Table R. l 
for guidelines on setting the RAM cache. 

To check the amount of RAM in your system 
At the desktop, under the Apple ti menu, selectAbout 
the Finder. 

Click the close box to exit the Finder information 
window. 
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Table R.1. 
Recommended RAM Cache Settings 

Without With 
RAM MultiFinder MultiFinder 

IM 12SK 32K 

2M 256K 64K 

2 .5K 512K SOK 

4M 1,024K 12SK 

5M 1,2SOK 160K 

SM 2,04SK 256K 

Notes 

The more RAM you allocate to the cache, the less you 
have available for other purposes. Turn the cache off 
if your system crashes or if your applications run out 
of memory. 

See also Control Panel and RAM. 

i Rebuilding the Desktop l a;;~;;;;;;; 
Every Mac disk has a hidden Desktop file that is 
responsible for housekeeping. The Desktop file keeps 
track of available applications, icons, and file loca­
tions. As you add , delete, and move files on your hard 
disk, the Desktop file can grow to an unmanageable 
size. You may find that your Mac responds more 
slowly, or that your system crashes frequently. 

The simple rebuilding procedure often can speed up 
all your desktop activities and can seem like a miracle 
fix. The only drawback is that this procedure erases all 
your Get Info comments stored with each file. 
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To rebuild the Desktop 
1. Shut down your Mac. 

2. Press and hold the 3€ and Option keys. 

3. Restart your Mac. 

4. Click OK to respond to the Are y ou sure? 
prompt. 

See also Crashes, Desktop, Finder, Get Info, Trouble­
shooting and Windows. 

, Recovering Data la;;~~~~ 
No matter how hard you try, files can be corrupted or 
lost. This loss can happen for a variety of reasons 
including physical damage to a disk (rare), accidental 
deletion of a file (more likely), or problems with the 
inner workings of the system. This disaster can be 
slight (you lose a file that you backed up) or major 
(your Mac tells you that it can' t find your hard disk!). 
The Mac is a complex machine in its design and 
execution; therefore, it's difficult for amateurs to 
recover lost information without having access to 
some special tools. 

Several utility programs-such as SUM II (from Sy­
mantec) and Mac Tools Deluxe (from Central Point 
Software)-can help you recover a deleted file or 
erased disk, or repair a damaged disk. A new addition, 
The Norton Utilities for the Macintosh (also from 
Symantec), is especially useful (see fig. R.2) . 
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Fig. R.2. Norton UnErase. 

You can do everything from restoring a damaged hard 
disk to unerasing a file to restoring a hard disk that has 
been accidentally formatted. 

See also Crashes and Troubleshooting. 

Caution: ResEdit has the capability to destroy data 
withou t warning. Only use this program if you know 
what you're doing. 

ResEdit (the resource editor) is Apple's programming 
tool that enables a developer to get inside a program 
and easily change its features. With ResEdit, even 
non-programmers can make fun and interesting 
changes in menus, icons, and windows. You can get 
the ResEdit program from a bulletin board, your local 
dealer, or from various mail order companies. 

ResEdit enables you to change system features by 
altering ResEdit templates such as WIND (for win­
dows), PAT (for patterns) , and ICN# (for icons). A 
Mac file consists of "resource forks" that contain 
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resources such as icons, dialog boxes, alert boxes, 
and menu commands. ResEdit enables you to edit 
these resources directly. 

To alter an icon 

Pattern 

1. Launch ResEdit by double-clicking on the 
ResEdit icon (see fig. R.3). 

\ D 
. 

ResEdit 

Fig.R.3. 1be ResEdit icon. 

2. Open the System file by double-clicking on the 
System icon (make sure you have an identical 
copy of the System file in case you mess up this 
one) . 

3. In the resource list, double-click the ICN# 
template. The screen in Figure R.4 shows an 
icon consisting of cwo designs: a mask and a 
pattern. 

Iii Fiie Edit lcn• 

Hard Disk 

Startup 

s stem 

I 1 ·..... I .... .. . . . 

I I ~ 

"Fig. R.4. Altering icons using ResEdit. 

Mask 

4. Use the mouse pointer to click pixels on or off 
to modify the image as you want. 
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Notes 

5. Close all of the open windows and applica­
tions. When you restart your Mac, the newly 
modified icon appears. 

Always work off a copy rather than an original file 
when using ResEdic. If/when you gee the desired 
results, you can transfer the file to the desired loca­
tion. 

See also Bulletin Boards and Mail Order. 

Use the Restart command to start up your Mac with­
out turning off the power switch or using the Shut 
Down command. When you select Restart, all the 
disks in floppy drives are ejected, and the Mac begins 
its routine for loading the System so that you can 
begin work. Use this command when you make 
changes to the System file (such as the addition of an 
INIT or CDEV). You also can use this command when 
recovering from a system crash. 

To restart your Mac 

Notes 

1. Quit any active applications (don't forget to 
save!) . 

2. At the desktop, from the Special menu, select 
Restart. 

You do not need to close all the open windows on 
your desktop prior to shutting down, starting up, or 
restarting. 

See also Crashes, Programmer's Switch, and Shut 
Down. 
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One of the most basic commands in a Mac application 
is the Save command, accessed via the File menu. 
When you select the Save command for the first time, 
the Macintosh prompts you for a name for the file you 
want to save. You also can direct that file to be saved 
in one of the available folders, or on a different disk. 
You can save at any time while working on your file­
even before you actually type anything. You can save 
continuallywithouthavingtocloseupyourdocument 
or return to the desktop. 

The dialog box shown in Figure S. l is a standard Save 
dialog box common to all Mac applications. You see 
the Save dialog box when you save an untitled docu­
ment for the first time. When you save a file, you 
specify the following: 

• A name for the file 
• A location for the file 

Click here 
to change 
folders 

Click here 
to change 
file format 

-
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Fig. S.1. 1be Save dialog box. 

To save a file 
1. From the File menu, select Save (~S). 

2. Type the name for the file. 

3. Click OK, or press Return or Enter. 
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To save a file to another folder 
1. From the File menu, select Save (3€--S). 

2. Click on the folder name in the box above the 
file listing. 

Select the folder in which you want to save the 
file. Double-dick on the name of a folder in 
the file listing to view the contents of that 
folder. Click on the name of the folder above 
the file listing to see the chain of folders 
leading to the top of the hierarchy. Click on 
the icon of the disk to go back up through the 
folder hierarchy. 

3. Type the file name. 

4. Click OK, or press Return or Enter. 

To save a file to another disk 
1. From the File menu, select Save (3€--S). 

2. Click the Drive button in the Save dialog box 
or press Tab until the disk to which you want 
to save the me appears. 

3. Type the file name. 

4. Click OK, or press Return or Enter. 

To save a copy of the file on-screen 
1. From the File menu, select Save As. 

2. Type the file name. 

3. Click OK, or press Return or Enter. 

The original file remains intact. 

What's the difference between Save and Save As? 

The Save command allows you to save your work on 
disk. You give the file a specific name and indicate the 
folder in which the Mac should save the file. 

The Save As command enables you to save a file under 
another name or save a copy of the active file to a 
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different location. The dialog box, which appears 
when you select the Save As command, is the same 
Save dialog box you first saw when you saved and 
named the file. You now can enter a new name 
and/or indicate a new location for the file. 

The Save As command is useful for many situations 
such as when you want to use the same file (a form 
letter) with some slight modifications, yet leave the 
original file intact. 

Notes 

You do not have co wait until a file is complete before 
saving it. It is good practice to save a file every fifteen 
minutes or so. When you save a file, the file is updated 
to reflect your changes. It takes only seconds to issue 
the 3€-S keystroke. You can do it every time you take 
a typing break. 

See also File Formats and Files. 

A scanner is a peripheral that converts an image to a 
series of digital characters that your Mac can under­
stand. 

Using software provided with the scanner or other 
software developed for this purpose (such as Digital 
Darkroom from Silicon Beach Software), you can 
manipulate scanned images to accomplish seemingly 
impossible effects. The most expensive scanners are 
flat scanners similar to copying machines. You place 
the document to be scanned on a sheet of glass and 
start the scanner. A bright light moves across the 
scanner face, and more than 2,500 photosensors in 
the moving part of the scanner capture the image. The 
system saves the scan to a file that you can use with 
different programs. 
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Scanners also can come as sheet feeders and over­
head units. You even can use a scanner (ThunderScan 
from ThunderWare) that attaches to the print head of 
an ImageWriter and moves across the image, repro­
ducing it on-screen as the scan progresses, or a hand­
held scanner called HandScan, that you move across 
an image to capture it. Even the best scanner rarely 
reproduces a 100-percent duplicate image. You may 
clean up a scanned image using a program such as 
Photoshop (from Adobe Systems). 

See also File Formats, OCR, and Peripherals. 

;;;;; Scrapbook 1~~~~~~;;m 

The Scrapbook allows you to access text or graphics 
from within any application. For example, you can 
open the Scrapbook while using MacWrite 11, and 
paste the festive illustration in Figure S.2 into your 
party invitation. The Scrapbook is ideal also for com­
pany logos or frequently-used text blocks. 

22 127 PICT 

Fig. S.2 . The Scrapbook desk accessory. 

You can place things in the Clipboard for later use, 
but the Clipboard can hold only one item at a time, 
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and does not store things permanently. The Scrap­
book, however, is bound only by the amount of 
memory that your Mac can afford to spare. 

To store an item in the Scrapbook 
1. Open the application that contains the item 

you want to store in the Scrapbook. 

2. Select the item you want to place in the 
Scrapbook. 

3. From the Edit menu, select Copy (00-C) . 

4. From the Apple ti menu, select Scrapbook. 

5. Scroll to select the location for your stored 
item. 

6. From the Edit menu , select Paste (00-V). 

7. Click the close box to exit the Scrapbook. 

To use an item from the Scrapbook 

1. Open the document you want to contain the 
Scrapbook text or graphic. 

2. From the Apple ti menu, select Scrapbook. 

3. Scroll to find the text or graphic you want to 
use. 

4. From the Edit menu, select Copy (00-C) . 

5. Click the close box to exit the Scrapbook. 

6. In the document, click where you want the 
copied item to appear. 

7. From the Edit menu, select Paste (00-V) . 

To remove an item from the Scrapbook 
1. From the Apple ti menu, select Scrapbook. 

2. Scroll to find the text or graphic you want to 
remove. 

3. From the Edit menu, select Cut (00-X) . 
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4. Click the close box to exit the Scrapbook. 

See also Clipboard, Copying, Cutting, and Pasting. 

;;;;; Screen Dum:p}s;~~~;;;;;;;;;~= 

Producing a screen dump means printing the contents 
of a Mac screen to a file on disk or to a printer. 

To save a screen dump to disk 
Press ~-Shift-3 . 

Your Mac creates a MacPaint file on your disk named 
"ScreenO." You can create up to 10 of these files (0 
through 9); then the numbering starts over at 0 again. 
To produce more than 10 files, you need to renumber 
them. To print a screen dump file, treat it like any 
other paint file. 

To print a screen dump of the current window 
Press ~-Shift-4. 

Your ImageWriter (or compatible) prints the con­
tents of the open window; you cannot print a screen 
dump directly to a LaserWriter (or compatible). 

To print a screen dump of the entire screen 
Press Caps Lock-~-Shift-4 . 

Your ImageWriter (or compatible) prints the con­
tents of the screen; you cannot print a screen dump 
directly to a LaserWriter (or compatible). 

Notes 
To capture pull-down menus or any other "active" 
screen, you need a program such as Capture (from 
Mainstay) , Image Grabber (from Sebastian Software) , 
or SnapJot (from Wildflower Software) . 

See also Files and Printing. 
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A screen saver is a Control Panel device or !NIT that 
replaces the active screen with a moving display. By 
replacing the inactive screen with a moving display, 
an image does not remain on the screen for an 
excessive period of time and thereby cannot etch a 
design into the sensitive phosphor coating on the 
inside of the Macintosh's picture tube. 

Screen savers used to be relatively simple, but they 
have become elaborate affairs with designs ranging 
from schools of fish to flying toasters (see fig. S.3). 

Many screen savers include sound as well. AfterDark 
and Pyro! currently are the two most popular screen 
savers. 

See also CDEVs and IN/Ts. 

Fig. S.3. Flying toasters-a fun screen saver. 
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Scrolling enables you to move through a window or 
a listing of files so that you can see additional parts of 
the window or list and, therefore, see more infor­
mation. When you have a window that cannot show 
all of the contents of a folder (such as 100 files in a 
folder and the window shows only 20), you have to 
scroll through the window to get to the part of the 
document you want. 

As you scroll, you see different parts of the window. 
You can use the horizontal and vertical scroll bars 
(located on the bottom and right sides of a window) 
to view all the information. Scroll bars are gray if there 
is more to see in a particular direction and white if 
there isn't. You also can use the scroll box (the small 
white box in the scroll bars) to move quickly through 
a large file (see fig. S.4). 

If you have an extended keyboard, you can use the 
Home, End, Page Up, and Page Down keys. 

i!:!O MEMOS 0= 
8 items 213,130K in disk 107,455K avail 

CJ 
APPLICATIONS 

g CJ LJ TI1iTt- Scroll box 

DAT A System Folder !Hi!! 

iii~t-- Scroll bar 

CJ LJ i11111 

GAMES UTILITIES 

Fig. S.4. Scrolling options. 

To scroll one screen at a time 
Click the gray area on the scroll bar. 
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Click above the white scroll box to scroll up one 
screen; click below the white scroll box to scroll 
down one screen. 

To scroll one line at a time 
Click one of the scroll arrows at the end of the 
horizontal or vertical scroll bar. 

Click the up arrow to scroll up one line; click the 
down arrow to scroll down one line. 

To scroll through an entire document 
Drag the white scroll box up or down the scroll bar. 

Release the mouse button when the scrollbox is 
where you want it to be. 

To scroll from one part of a document to another 
Drag the scroll box within the scroll bar. Release the 
mouse button to scroll to that location within the 
document. 

The distance the screen scrolls is proportionate to how 
far you drag the scroll box. If you drag the scroll box 
to the middle of the scroll bar, you move near the 
middle of your document. 

See also Mouse, Size Box, Window, and Zoom Box. 

The Small Computer System Interface (SCSI) is a 
communications port that is an integral part of your 
Mac's hardware system. You can attach up to seven 
different devices or peripherals to your Mac in a daisy­
chain fashion using the SCSI (pronounced "scuzzy") 
port. For example, you may have an external hard 
drive linked to a scanner that is, in tum, linked to a 
printer. SCSI opened the world of hard drives and 
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other optional add-ons to the Mac, such as a remov­
able hard disk, CD-ROM drive, or scanner. 

So that the Mac knows what's attached to what, your 
system needs to know the number assigned to each of 
the SCSI devices connected to your system. Your Mac 
is automatically assigned number 7, so you can't use 
that number. The manufacturer usually assigns a 
SCSI number as well. When you start adding periph­
erals, these numbers may clash. 

In the old days, the only way that you could set SCSI 
address numbers was to take apart your hard drive 
and printer and then cut wires or install jumpers. No 
more. Most hard drives and printers come with easy­
to-set SCSI ID switches. All you have to do to change 
the number is turn a dial, press a button, or flip a 
switch. The procedure is quick and simple-and it 
works. 

Your Mac must encounter a terminator when it 
searches through a chain of SCSI devices. A termina­
tor looks like a serial plug without the cable and goes 
on the last device in the chain. Many devices have 
built-in terminators. 

See also Crashes and Hard Drives. 

Searching involves locating a file or the contents of a 
file by using various utilities. Search tools are an 
integral part of most word processing programs. You 
specify what to look for, and your Mac finds it for you. 

Applications that offer a search function also may 
offer a search-and-replace (sometimes called 
"change") function (see fig. S.5). Search-and-replace 
allows you to change the text you find-you can 
change capitalization, spelling, or even substitute 
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terms. For example, to change the spelling of a 
particular string of characters throughout a docu­
ment using Microsoft Word, you select the Change 
option from the Utilities menu and provide the 
characters for which you want to search. You indicate 
whether to replace the text with new text. Word then 
stops on the next occurrence of the characters. 

Change 

Find What: j Mcintosh 
~====================: 

ChangeTo: ~jM_a_c_in_t_o_s_h~~~~~~~ 
O Whole Word [81 Match Upper/ Lowercase 

([Start Search ]J [ IHllHJP ( Change Rll J (Cancel J 

Fig. S.5. A Change dialog box. 

Other utilities are external to any application (such as 
Find File) and can be used as desk accessories. Among 
these, GOpher and OnLocation are both fast and 
efficient in their search procedures, scanning 20M of 
disk space in a matter of seconds. 

See also Find File. 

The first thing you see when you boot up your Mac is 
the desktop, with menus along the top, disk icons in 
the upper right, and a trash can in the lower right 
corner. You are not, however, limited to the desktop 
as your only startup option. 

You may want to replace the Finder with MultiFinder. 
You also may want to open a specific file created with 
a specific application. You can use the Set Startup 
option from the Special menu to open a file or ap­
plication automatically when you start up your Mac 
(see fig. S.6) . 
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Fig. S. 6. The Set Startup dialog box. 

To startup with the Finder 

1. From the Special menu, select Set Startup. 

2. Click Finder. 

3. Click OK, or press Return or Enter. 

4. From the Special menu, select Restart. 

To startup with the MultiFinder 

1. From the Special menu, select Set Startup. 

2. Click MultiFinder. 

3. Click OK, or press Return or Enter. 

4. From the Special menu, select Restart. 

Notes 

You must restart your Mac to activate new startup 
settings. 

See also Finder, MultiFinder, Restarting. 

~ ShutDown~1~~~~~~ 
Shutting down involves more than switching off your 
Mac. When you select the Shut Down command, your 
Mac takes all of the directory information and makes 
sure that it is written back to the disk where it belongs. 
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This housekeeping enables you to start with a clean 
slate the next time you turn on your Mac. 

To shut down your Mac 
1. From the File menu, select Quit (~Q). 

2. At the desktop, from the Special menu, select 
Shut Down. 

On the Mac II series, the power automatically shuts 
off when the Mac finishes its housekeeping activities. 
(On some Macs, an alert box tells you when it's OK to 
turn off your Mac.) 

Notes 
Never turn off your Mac with an open document on­
screen. Always return to the desktop first. 

See also Quitting and Restarting. 

4 s1MMs I 
Single In-line Memory Modules (SIMMS) increase the 
amount of RAM available on your Mac. A SIMM is 
approximately 1 inch by 0.35 inches and consist of 
eight memory chips connected on an integrated 
circuit. Rather than having to solder the chips directly 
onto a board, the SIMM holds the chip and you insert 
the SIMM into the existing sockets. 

SIMM speed 
The speed of a SIMM is measured in nanoseconds­
billionths of a second. The lower the number, the 
faster the chip. A fast chip is 80 nanoseconds; a slow 
chip is 120 nanoseconds. Faster is better, but it's 
relative co price. If all you do is word processing, you 
don't see a big difference between 80 and 120 nano­
seconds. You do see a difference, however, with 
memory-intensive number crunching. 
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Installing SIMMs 
Expect your local dealer to charge $60-$100 per 
SIMM chip to install. You can purchase SIMMs for 
about one-half the dealer's price by purchasing via 
mail order. Many companies that sell SIMMs also 
include the tools you need to "break" the case of your 
Mac (check your warranty). Some vendors provide a 
videotape (at no extra charge) that details how to 

perform a RAM upgrade. 

You can add SIMMs yourself if you are careful, read all 
the directions, and review the instructional material 
each step of the way. Adding SIMMs can be a tricky 
business and a disaster without the correct tools. If 
you are a do-it-your-selfer, remember to unplug your 
Mac before opening the case, and be sure you 're free 
of static electricity. You don't want to shock your 
system. 

SIMMs purchasing guidelines 

If you do purchase SIMMs chips for do-it-yourself 
installation, ask the ve ndor the following questions: 

Notes 

• How long has your company been in business? 

• Do you provide free technical assistance? 

• Who manufactures the chips? 

• What kind of warranty comes with the chips? 

• How many SIMMS do I need to upgrade my 
lM system to a 4M system? (Fill in the appro­
priate amounts) 

Each SIMM usualJy holds 256K. Different Macintosh 
models require different SIMMs configurations. (Be 
sure to ask vendors about your individual needs.) 

Adding SIMMs usually means that your Mac takes 
more time to boot up and does not necessarily mean 
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that it works any faster, although you can do more 
with it. 

See also Mail Order and RAM. 

The size box, located in the lower right corner of a 
window (at the intersection of the scroll bars), en­
ables you to resize the window (see fig. S.7). 

To resize the window 
l. Move your mouse to position the tip of the 

mouse pointer in the size box. 

2. Press the mouse button and drag the size box 
in any direction- vertical, horizontal, or 
diagonal- until the window is the size you 
want it. 

3. Release the mouse button. 

Jen's Stuff 
S items 78 ,536K in disk 201 K available 

LJ LJ 
HyperCard Utilities 

Fig. S. 7. The size box. 

See also Mouse, Scrolling, Windows and Zoom Box. 
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~ Special Characters liOI ~~~;;;; 
You can create special characters by using the Shift 
and the Option keys (in combination or alone). For 
example , to produce the Macintosh Apple w, use the 
Shift-Option-K key combination in the Times or 
Chicago font . 

To create a special character 
At the location where you want to insert a special 
character, type the key combination as specified in 
the "QUICK KEY GUIDE" or Table S.1. 

To create a special character in a different font 
1. Type the keystrokes necessary to create the 

character. 

2. Highlight the character(s) you want to change. 

3. Select the new font. 

For a quick reference to the most commonly used 
special characters, see Table S .1. 

For a more detailed list of characters, refer to the 
"QUICK KEY GUIDE." 

To view a font's special characters 
1. From the Apple w menu, select Key Caps. 

2. From the Key Caps menu, se lect the name of 
the font you want to view. 

3. Press and hold the Option key to view one set 
of characters. 

4. Press and hold the Shift key to view another 
set of characters. 

5. Press and hold both the Shift and Option keys 
to view a third set of characters. 

6. Type several characters using the Shift and 
Option modifier keys. 
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7. Click the close box to exit Key Caps. 

You can type individual keys to see which characters 
they create. When you find the character you want, 
and you know which key-combination produces that 
character, return to your original document. Click 
where you want the character to appear. Type the 
necessary key-combination, and change the font, if 
necessary. 

Alternatives to Key Caps 
You probably will find it impossible to remember all 
of the Shift and Option key combinations and what 
they produce. To see the result of the combinations 
on-screen, you can use Key Caps or an alternative 
program. 

Peter Norton's KeyFinder shows you a screen of all 
the different characters, and when you click on the 
one you want, KeyFinder tells you the combination of 
keys you need to press. As you select different fonts, 
you see different symbols on the screen. This proce­
dure is much easier than using Key Caps, and you also 
can cut and paste from KeyFinder to an application. 

Notes 
Some programs create "smart" quotation marks for 
you automatically. For example, in Microsoft Word, 
you can select the "Smart Quotes" option from the 
Preferences dialog box accessed via the Edit menu. 
This command tells Word to make true opening and 
closing quotation marks for you. 

See also Fonts, Highlighting Text, Key Caps, and the 
"QUICK KEY GUIDE." 
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Table S.1 
Special Characters 

Description 

General characters 
• Bullet 
© Copyright 

Ellipsis 
Em dash 
En dash 
Hyphen; dash 

® Registered 
™ Trademark 

Key(s) 

Option-8 
Option-G 
Option-; 
Option-Shift-- (dash) 
Option-- (dash) 
- (dash or minus) 
Option-R 
Option-2 

Accents (type the symbol, then the letter) 
a Grave Option- ' , A 
e. 
ii 
n 
e 
~ 

Quotes 

Acute 
Umlaut 
Tilde 
Circumflex 
Cedilla 

Opening double 
Closing double 
Opening single 
Closing single; 
apostrophe 

Arrows (use Symbol font) 
i 
J, 

Up arrow 
Down arrow 
Right arrow 
Left arrow 

Boxes (use Zapf Dingbats font) 
0 Box with shadow 
• Box, filled 
D Box, unfilled 

Option-E, E 
Option-U, U 
Option-N, N 

Option-I, E 
Option-C 

Option-[ 
Option-Shift-[ 
Option-) 
Option-Shift-] 

Option-= 
Option-Shift-0 
Option-Shift-' 
Option-U 

0 
N 
n (outline) 

See also the "QUICK KEY GUIDE." 
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~preadsheet Programs ._, == 
A spreadsheet is an electronic ledger consisting of 
rows and columns that you use to organize informa­
tion. The worksheets that you create (using programs 
such as Microsoft Excel or Wingz) enable you to 
manipulate numbers and text by providing you with 
a grid like the one you see in Figure S.8. 

S file [dll Formula Format OD!a Options Macro Window 
B 10 I : SUM(BS BB) 

m. EHcol Spreodsheet I 
A 0 C D C r 

..+- - ~ 

rt- _!U _Q._2 Q3 ~Q'4 

11 
12 
13 
14 

~ --~--1~~~·1--~~-+-··~~-r~~-f--~--1 
1-1-ll---------+----!-·------+---- ' 
~ ~ 
Oil_ ~ ! 1c; 

Fig. S.8. A Microsoft Excel spreadsheet. 

You can enter numbers or text at the intersections 
("cells") of these rows and columns. You then can 
perform a variety of operations based on the informa­
tion. For example, you can use a built-in function 
such as AVERAGE to add values in a group of cells and 
then divide the sum by the number of values. Or, you 
can create your own formula that performs any type 
of operation you want on one cell, or a set of cells, 
such as adding cell Al to cellA2 and multiplying by 5: 
(Al+A2)*5. 

You also can use spreadsheets to manage databases, 
although spreadsheet programs do not have the tools 
a full database management system has. 
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Finally, you can create stunning graphs and charts 
(such as the one you see in Figure S.9) that you can 
paste into other applications. 

'* file Edit rormule rormet Date Options Macro Window 
B I 0 :SUM(B5·BB) 

45000 
40000 
35000 
30000 
25000 
20000 
15000 
10000 
5000 

0 

£Heel Spreedsheet 
C D 

Cheru 

Fig. S.9. A Microsoft Excel chart. 

See also Buying Software . 

Startup Screen ta-~~~~~;;;;;; 

Tired of the same picture on-screen when you start up 
your Mac? Any graphic you can capture as a paint file, 
you can have appear on your Mac screen each time 
you start up your Mac. You must have an application 
that supports this capability. 

To create a startup screen 
1. Launch a paint program such as MacPaint or 

SuperPaint. 

2. Create an illustration to use as a startup 
screen , or open the file containing the image 
you want to use as a startup screen. 

3. From the File menu, select Save As. 
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4. Select the Startup Screen option (see fig. 
S.10). 

5. Click OK, or press Return or Enter. 

I= CMS Hnrd Disk I 
CJ APPLICATIONS 
CJ ORTA 
a n 
CJ EZ 
CJ FROM PRODUCTION 
CJ little Mnc Book kb 

Document formnt: 

O MncPnlnt O Stnllonery 

IQ =CMS Hnrd .•. 

£,feel 

Oli1•e 

Snue 

[ Cnncel 

~Stnrtup screen 

Fig. S.10. Saving a startup screen using MacPaint. 

The next time you start up your Mac, the setup 
screen-not the regular desktop pattern-appears. 

Notes 

Your startup screen file must reside in your System 
Folder. 

See also Restarting and Saving. 

Computers are nothing more than a collection of 
hardware components such as integrated circuits, 
resistors, and switches. What makes your Mac do all 
the wonderful things it does? An operating system. 

The operating system is the brains of any computer. 
This software enables you to do everything from boot 
up to the desktop screen, to cut text from one 
application and paste it into another. 

System software comes on disk with every Mac. The 
System is responsible for all those things you can't 
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see: organizing files , keeping track of file names and 
the date when they were last modified, and storing 
text or graphics in the Clipboard. 

As the Macintosh grows more powerful and offers 
more features , the need for increasingly sophisticat­
ed Systems also grows. The latest version (as of this 
printing), System 6.0.7, offers more options and 
smoother operation than any previous System. You 
usually can get the latest System update from your 
Apple dealer. 

System 7.0 is the new version of the Macintosh 
operatingsystem (duefromApplesometimein 1991). 
For information on its features and how to use them, 
refer co the next section of this book: "SYSTEM 7 
FIRST LOOK." 

To check System and Finder version numbers 

Ac the desktop, from the Apple ti menu, selectAbout 
the Finder. 

Click the close box to exit the information window. 

To install a new version of the System and Finder 
1. Ac the desktop, from the Special menu, select 

Shut Down. 

2. Insert a copy of the Macintosh Systems Tools 
disk into a floppy drive. 

3. Turn on your Mac. 

4. Double-click on the icon of the Systems Tools 
disk and then double-click on the file named 
Installer. 

5. Select your model of the Mac from the list that 
appears. 

6. Click the Drive button to select the drive you 
want to contain the new System Tools (for 
example: your hard drive) . 

7. Click the Install button and wait. 
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The System, the Finder, and other important files 
automatically transfer. You also can install a new 
System and Finder by copying the files from one disk 
to another. Be sure and put the System and Finder 
into the System Folder. There should be only one 
System Folder per disk. 

To see if you have more than one System file on 
your disk 

1. From the Apple ti menu, select Find File. 

2. Type system. Press Return or Enter. 

Find File shows you a list of files containing 
"system" in the file name. 

3. Click the individual files to see where they are 
located. 

4. Delete all files but the one system you want to 
use in the System Folder. You will probably 
want to keep the latest version. 

5. From the Special menu, select Restart. 

To activate a different System 
You may want to take advantage of what another 
system might offer (such as a DA or Font not available 
on the System installed on your hard disk). To do so, 
you have to make this other System dominant. 

I. Press and hold the Option key. 

2. Double-dick on an application 0 _1 the disk 
containing the System you want to activate. 

The icon located in the upper right corner of the 
desktop represents the dominant drive. 

Notes 
To create a bare-bones startup disk, you need only 
two files: the System and the Finder. 

Newer versions of system software take up more 
memory and more disk space. If you are working on 
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an older machine, or a floppy-disk-based system, you 
may want to keep using an older version of the system 
software. 

See also Bulletin Boards, Find File, Finder, Get Info, 
Installing Software, and "SYSTEM 7 FIRST LOOK.". 

~Telecommunications a;;I ~~~ 
Telecommunications have become increasingly more 
sophisticated over the past few years. You now can 
connect with another computer through your Macin­
tosh. 

For the price of a modem (starting at around $100) , 
and a communications package, you can connect 
with the world. You can send and receive messages, 
download free games and programs, ask questions of 
experts thousands of miles away, go shopping, com­
pare airline flights , advertise your talents, check the 
weather forecast, access the computer at the office 
from your home, and so on. You even can send and 
receive faxes using your Mac. 

Purchasing considerations 

A good telecommunications program should do the 
following: 

• Use on-screen, rather than modem, buttons to 

control functions. 

• Offer automatic answering, dialing, and 
redialing. 

• Supply on-line help. 

• Transmit sound, graphics and color. 

• Supply an on-line timer so that you can track 
billing charges. 
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• Use a command language for customizing 
telecommunications functions. 

• Support multiple protocols including the 
major ones such as XModem, YModem, and 
Kermit. 

• Support terminal emulation (so that you can 
talk to mainframes). 

The leading telecommunication packages, both of 
which incorporate the above features and more, are 
White Knight (formerly the public domain program 
called Red Ryder) from FreeSoft, and MicroPhone II 
from Software Ventures. White Knight is a tremen­
dously powerful telecommunications package. You 
can tell by its version number (11 !-Red Ryder went 
through 10 upgrades) that the program has been 
around awhile and has been enhanced through nu­
merous upgrades. 

See also Bulletin Boards and Modems. 

The Trash Can, located in the lower right corner of 
the desktop, is the destination of files you want to 
delete, and floppy disks you want to eject (see fig. 
T.l). 

A file dragged to the Trash Can remains in the Trash 
Can until you do one of three things: select the 
Empty Trash command from the Special menu, shut 
down your Mac, or launch a new application. 

A bulging trash can icon indicates that you have 
trashed a document (marked it for removal) . You can 
retrieve the file from the trash, but you must act fast! 
(see fig. T.2). 
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Fig. T.1. 7be Trash Can. 

II 
Fig. T.2. An empty Trash Can (left) and a full Trash 
Can (right). 

Once your bulging Trash Can slims down, your only 
hope of retrieving a trashed file is through the use of 
a recovery program such as The Norton Utilities for 
the Macintosh. 

To delete a file or folder 
1. At the desktop, drag the icon for the file or 

folder you want to delete to the Trash Can at 
the lower right corner of the screen. 

2. When the Trash Can icon reverses, release the 
mouse button . 

To delete several files 
1. At the desktop, Shift-click to select the files you 

want to delete. 

2. Drag any one of the selected items to the Trash 
Can. The rest of the selected items move as 
well. 
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3. When the Trash Can icon reverses, release the 
mouse button. 

To retrieve a file from the Trash Can 
1. Double-click on the Trash Can icon to open it. 

2. Drag the file you want to retrieve out of the 
Trash Can window to a location on the Desk­
top. 

3. Click on the close box to exit the Trash Can 
window. 

To empty the trash 

At the desktop, from the Special menu, select Empty 
Trash. 

You also can empty the trash by launching an appli­
cation or shutting down the Mac. 

This procedure is irreversible. 

To eject a floppy disk 
1. Drag the icon of the floppy disk to the trash. 

2. When the Trash Can icon reverses, release the 
mouse button. 

The data on the trashed disk remains intact. 

Notes 

You can retrieve a trashed item only if the trash can is 
bulging. 

To clear off space on a disk, you may drag items to the 
trash. However, the disk won't recognize that space 
as available until you "empty the trash." 

See also Deleting Files, Files, and Mouse. 
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_, Troubleshooting 1~~~~iiiiiiiiiiiiiii 
What do you do when things won't work? 

First, think about recent events. What has changed 
recently? Did you install a new program? Experience 
a crash? Add new !NITS, desk accessories, or games? 
Set the RAM cache? Delete an application or system 
file? 

Are you using new System software? Are you running 
Suitcase II? Did you download recently any files from 
a bulletin board? Did you rum on MultiFinder? Have 
you been playing with ResEdit? Are you running 
QuicKeys2 or Tempo II? 

The following is an attempt to help you when you get 
stuck. Keep in mind that most problems are easily 
solved, and that you are never alone in your suffering. 

If your computer won't start ... 
If your system won't start, ask yourself the following 
questions: 

• Is your computer plugged in? 

• Is your surge protector turned on? 

• If you have an external hard drive, is the hard 
drive rurned on? Did you turn it on prior to 
rurning on the Mac? 

• Are all your cables connected securely? 

• Are your peripheral devices turned on? 

• Is your monitor turned on? Is the brightness 
turned up? 

If your Mac is making unusual noises, take it to an 
authorized service facility. 
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If your hard disk won't boot .. . 

The blinking question mark doesn't go away. Your 
hard disk cannot seem to startup. One or more of the 
following situations may be the cause of the problem: 

• Damaged boot blocks on your hard disk. 

• A corrupted Desktop file . 

• A corrupted or incompatible System and/or 
Finder. 

• More than one System file or System Folder 
on your hard disk. 

• Corrupted PRAM. 

•A corrupted directory. 

• Incompatible INITs contained in your System 
Folder 

The first thing you should do is to rebuild the desk­
top. Hold the 00 and Option keys as you startup your 
Mac. 

If rebuilding the desktop doesn't work, try starting up 
from a floppy disk or any other startup device such as 
an external drive. 

If your Mac doesn't start from a hard disk or a floppy 
disk, you should have it serviced. Ask the service 
person to recover as many files as possible. 

If your Mac starts from a floppy disk, but not from 
the hard disk 

If your Mac starts up from a floppy disk, try the Restart 
command to see if the hard disk can now startup on 
its own. If you can boot up only from a floppy, and the 
icon for the hard disk appears on the desktop, back 
up as many files as you can. 

Remove the INITs from the System Folder on the hard 
disk. You don't have to delete them, just move them 
out of the System Folder (put them in a new folder 
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called "INITs"). Restart your Mac. If your hard disk 
now starts, an INIT is the culprit. Try putting one INIT 
at a time back into your System Folder and restarting. 
This technique isolates the conflicting INIT. 

If IN/Ts are not the problem 
If taking INITs out of the System Folder on your hard 
disk does not solve the startup problem, install new 
System files from copies of your original Apple System 
disks. Use the Installer program. After installing new 
System files, try Restarting. You also can drag the 
System Folder from your hard disk to the trash, and 
copy the System Folder from your startup disk onto 
your hard disk. 

Try using the Disk First Aid program that comes with 
your Mac. 

If problems continue, zap the PRAM. 

To zap your PRAM 
1. Press and hold the Option-3€-Shift. 

2. From the Apple s menu, select Control Panel. 

3. Click:Yes . 

If your Mac ejects your startup disks 
When your Mac starts up, it ejects disks that do not 
contain System and Finder files. 

Try a different startup disk. If the new startup disk 
works, copy the System Folder from the working 
startup disk to the ailing startup disk. If none of your 
startup disks work, you may have a problem with your 
disk drive. 

If you get a sad Mac face with a numerical error 
message beneath it 

Write down the message and take the Mac to your 
dealer or a computer technician. 
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To create an emergency startup disk 
For those times when your computer acts unpredict­
ably, you can be somewhat prepared by having an 
emergency startup disk ready. 

An emergency startup disk should contain a System 
Folder containing a System and a Finder, and Disk 
FirstAid, and possibly any hard disk utilities that came 
with your hard disk. If you purchase utility software, 
you may want your emergency startup disk to contain 
any utilities you're likely to use in an emergency 
situation. Some utility programs contain a log appli­
cation that records your Mac's activities. 

q your Mac asks you to initialize your bard disk 
DON'T! Rebuild the desktop by holding down the a€ 
and Option keys when restarting your Mac. If you 
don't get the alert box asking if you want to rebuild 
the desktop file, try starting up from a floppy disk. 

i;f youget the message" .. . not a Macintosh disk. Do you 
want to initialize?" 

All new unformatted 3 1/2-inch floppy disks will ask 
you to initialize them. If you are sure the disk is blank, 
you must initialize it in order to put data on the disk. 

However, IF THE DISK CONTAINS DATA, DO NOT 
INITIALIZE the disk, unless you're sure you want to 

erase all data on that disk. 

If the Mac cannot read that disk, ask yourself the 
following questions: 

• Are you inserting a high-density (HD) disk into 
a double-density (DD) disk drive? 

• Are you inserting a DOS-formatted floppy into 
a Mac disk drive? 

q you have a.floppy disk that won't work 
The floppy disk was fine yesterday, but it won't work 
today. Or, it's a new disk that won't initialize. The disk 
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may be damaged. Try a utility program (such as SUM 
II or Norton Utilities) to recover the data on that disk. 
If you come to terms with the fact that any data on the 
floppy disk may be lost, you can try to reinitialize the 
disk. If this procedure fails more than once, consider 
the disk destined for the trash heap-the real trash 
heap. 

If you have an application or desk accessory that 
continually crashes 

If crashes occur when using specific programs, try 
loading a fresh copy of the program onto your disk. 

If you get the message 'file . .. could not be opened/ 
printed ... the application is busy or missing" 

Chances are, you double-clicked on a System file, 
such as the Clipboard or LaserPrep file-something 
that you really can't launch. Try double-clicking on 
an application icon. Then open your document from 
within that application, or create a new document. 

If you can't find a file 
Use the Find File desk accessory to locate the file. 
Select Search Here from the Find File menu to scan 
a different disk. 

If you have a blank screen with a menu bar 
You are working on your Mac, and suddenly you find 
yourself staring at a blank screen with a menu bar at 
the top of the screen. You are in application limbo. 
Did you click the close box when you had a document 
on-screen? If so, the application is still active. From 
the File menu, select Quit You return to the desktop. 

If you can't print 
Check your cables. Check your power switches. If you 
have an ImageWriter, make sure the Select button is 
on. Check the Chooser desk accessory from the Apple 
9 menu. Are all three items selected: the printer icon, 
the printer name, and the user name? Try shutting 
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down and restarting your Mac and your printer. If you 
have a print spooler, such as SuperLaserSpool, did 
you select the Pause button? If so, click Resume. 

If what you see isn't what you get 
If your document prints sideways, check the Page 
Setup orientation selection from the File menu. If your 
page breaks in a strange place, check to see if you 
inserted a manual page break. Check the margin 
settings in your Page Setup dialog box. 

See also Backups, Crashes, Disks, Erasing Disks, Er­
ror Messages, Find File, IN/Ts, Printing, and System. 

Most Macintosh applications have an Undo com­
mand, generally accessed through the Edit menu, or 
activated through ~Z (see fig. U.1). Undo enables 
you to do just that: undo your last operation. For 
example, suppose that you deleted a paragraph of 
text in Microsoft Word and wanted to restore it. 
Under the File menu, the command reads as Undo 
Typing and, once selected, the deleted paragraph is 
restored. 

Cut X H 
Copy XC 
Paste X U 
Clenr 
Select Rll X R 

Show Clipboard 

Fig. U. 1. The Edit menu contains the Undo command. 

Many Mac users try to correct a mistake rather than try 

the Undo command immediately after making an 



======================== Macintosh Topics 

error. Remember, most undos work only on the last 
operation, so try Undo first. 

To undo a command or action 
Before you do anything else, from the Edit menu, select 
Undo ~Z) . 

Notes 
If you cannot "undo" your action, try quitting without 
saving your document. (An<?ther reason to save often.) 

Different applications enable you to undo different 
actions. For example, Microsoft Word enables you to 
undo a sort but will not allow you to undo the Go To 
command. 

Some applications allow for multiple undos- Nisus 
allows for up to 32,000 undos! 

See also Quitting and Saving. 

Upgrading is the process of enhancing the capabili­
ties of your computer system. You can upgrade your 
system by increasing the memory, the size of the hard 
disk, or even getting a new monitor. The most com­
mon upgrade is to increase the amount of RAM that 
your Macintosh can make available to applications 
and data. Generally, the more memory that your Mac 
has available, the faster the system can work and 
handle applications that require more "room" for 
specific operations. 

If you plan to do the upgrading yourself, remember 
to check your warranty first. If you are going to void 
your warranty, you might as well be aware of it. 

See also Buying Hardware, Monitors, RAM, and 
SIMMs. 
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A utility is a software tool that makes your Macintosh 
actiVities easier and more efficient. Although some 
software programs help you manage data or manip­
ulate words, utilities keep your system in tip-top 
shape through such tasks as compressing files, mov­
ing and copying files from one location to another, 
deleting files when necessary, creating charts, unde­
leting files, automating keystrokes, switching appli­
cations, optimizing your hard disk, saving screens, 
undeleting files, and searching for text phrases. Many 
utilities function as desk accessories; others may be 
Control Panel devices or separate applications. 

See also CDEVs, Desk Accessories, IN/Ts, Macros, 
Recovering Data, and Screen Savers. 

The View menu on the desktop enables you to decide 
how you want to view the contents of a Macintosh 
window or the contents of a disk. You can view files 
by small icon, icon, name (see fig. V.l) , date when 
they were last changed, size (from biggest to small­
est), and kind (based on the application used to 
create them or the type of file). 

To change the current view 

1. At the desktop, open the window you want to 
view. 

2. From the View menu, select how you want to 
view the file : by Small icon, Icon, Name, 
Date, Kind, or Size. 

On color machines, you also have a view by color 
option. 
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Fig. V.l . Viewingfiles by name. 

U you view by icon or small icon, you may find that 
icons overlap because too many are in one window. 

To make frequently usedfiles more accessible 
Drag the icon of the frequently used file onto the 
desktop. 

When you no longer need the icon to be readily 
available, select the icon. From the File menu, select 
Put Away. The file goes back to where it was before 
you moved it to the desktop. 

To makefiles appear at the top of an alphabetical file 
listing 

Change the first letter of the file to a space, dash, or 
bullet. 

To list files numerically 
To arrange numbered files in numerical order (1, 3, 
5, 10, 11, rather than 1, 10, 11, 3, 5), place a leading 
0 (zero) in front of the single-digit numbers. 

To align an icon to the invisible grid 
1. Select all the icons you want to snap to the 

invisible grid. 
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2. From the Special menu, select Clean Up 
Selection. 

To align an icon to the invisible grid 
l. Select the icon(s) you want to snap to the 

invisible grid. 

2. From the Special menu, select Clean Up 
Selection. 

To move together spread-out icons 
l. Press and hold the Option key. 

2. From the Special menu, select Clean Up. 

See also Files, Mouse, Opening Files. 

The Macintosh uses many types of memory, including 
RAM and ROM. One type of memory- virtual memo­
ry-enables you to use space on your hard drive as 
RAM. This method is slower than using RAM because 
data has to be transferred from the CPU to the hard 
disk and back again. Your application, however, does 
not know that it is accessing data from the hard disk 
versus the CPU's RAM. Virtual memory speeds up 
your work and increases the amount of RAM memory 
you have available to perform memory-intensive op­
erations. 

For example, if you have a 40M hard disk with at least 
lOM unused, you can use virtual memory to access up 
to BM (or as much as your Macintosh can handle) of 
additional RAM. 

The only caveat in this seemingly something-for­
nothing procedure, is that the more actual RAM you 
have, the better virtual memory works. So if you have 
lM of RAM and use virtual memory, your Macintosh 
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does not work as efficiently as if you were to have 2M 
or more of "real" RAM. The general rule is the more 
actual RAM you have, the better your system is able to 
work with virtual memory, and the less likely you are 
to notice your machine slowing down to go to the 
hard disk for data. 

You do not have to have System 7 in order to utilize 
virtual memory. You do, however, have to have a 
PMMU chip, and a 68030 processor. 

See also PMMU, RAM, RAM Cache, and "SYSTEM 7 
FIRST LOOK." 

A virus is a small computer program that attaches 
itself to another program and then causes damage. 
Although scores of viruses exist, the two most com­
mon are the Scores virus and the nVir, which have 
infected millions of files over the past few years. A 
Trojan Horse is a virus that does not reproduce itself 
once it attaches to another program. 

To protect against viruses 
You can reduce the possibility of contracting a viral 
infection by taking the following precautions: 

• Put a virus-protection program (such as SAM or 
Virex) on your Mac to scan all incoming disks 
for potential germs. (Lock the virus-protection 
disk before you insert it into your machine!) 

• Only use software that is available through 
conventional and commercial channels. When 
you borrow an application from a friend, you 
increase the risk of virus attacks (as well as the 
possibility of breaking the law) . 
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• If in doubt, don't copy applications that may 
be infected. -

• Be especially cautious (but not paranoid) 
about "new finds" on bulletin boards. 

How can you tell if you have a virus? 
The behavior of an infected system may mimic the 
behavior of a non-infected system. You may find your 
system crashing repeatedly, no matter which appli­
cation you use. You may see unfamiliar dialog boxes, 
altered icons, or unusual screen patterns. An applica­
tion may behave differently. Programs may disappear 
from your hard disk. You may have trouble opening 
and closing windows. You may be unable to print. 

If you haven't been "interacting" with bulletin board 
files or disks from someone else's machine, you can 
try the remedies discussed in the Crashes and 
Troubleshooting sections. If those procedures prove 
unsuccessful, scan your system with a virus-detection 
program. 

Virus protection software 

Virus protection utilities generally check files when 
you insert a floppy and enable you to repair the disk 
and destroy the detected virus. The best commercial 
products-such as Virex (from Microcom) , SAM II 
(from Symantec), and Antitoxin (from Mainstay)­
monitor your file activity and prevent any virus in­
fections. You first should check and repair (if 
necessary) files that already exist on your hard disk. 

As you read this, someone is creating a new virus. Be 
sure to keep up-to-date on your virus protection 
programs. If you purchase a subscription to Virex, 
Microcom sends you updated virus-protection soft­
ware as new viruses are discovered. 

See also Crashes and Troubleshooting. 
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A window is the Macintosh's primary tool for organiz­
ing information and displaying the contents of a file 
or a folder. A window is a separate workspace with its 
own title, and it is independent from any other 
windows that may be on the desktop. Although you 
can have more than one window open, you can have 
only one window active. The active window is always 
the one window that is front-most on your screen and 
has horizontal lines in the title bar. You can move, 
resize, and scroll through windows. 

Informa­
tion bar 

Icons 

Scroll 
arrow 

Close box Title bar Zoom box 

MEMOS 
2 13, 130K in disk 

LJ LJ 
APPLICATIONS DATA System Folder 

LJ 
GAMES UTILITIES 

Ftg. W.1. An active window. 

To open a window 

Scroll 
box 

Scroll 
bar 

Size 
box 

Double-click on the icon of the disk, file, or folder you 
want to open or press sg..o. 

To close a window 
Click the Close box in the upper left comer of the 
active window, or press 3&-W. 
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To close all open windows on the desktop 
Press and hold the Option key and click the Close 
box of the active window. 

To activate a window 
Click anywhere in the window. 

To move a window 
Drag the title bar of the window to the new location. 

To move a window without making it active 
Press and hold the 3C key and drag the window by the 
title bar to its new location. 

To change the size of a window 
Drag the size box in the lower right corner of the 
window. 

To enlarge a window to the full screen 
Click the Zoom box in the upper right comer of the 
window. Click the Zoom box again to revert to the 
Window's previous size. 

To scroll one line 
Click the scroll arrow in the direction you want to 
scroll (up, down, left, or right). 

To scroll up or down one screenjul 
Click in the gray scroll bars above or below the white 
scroll box, or use the Page Up and Page Down keys. 

To scroll in large increments 
Drag the white scroll box from one part of the scroll 
bar to another. 

See also Files, Mouse, Printing, Scrolling, Size Box, 
and Zoom Box. 
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-jword Processing ProgramsF 
Word processing programs enable you to create and 
manipulate text; store one paragraph or 100-page 
documents for later retrieval, review, and printing; 
and perform magical format changes to pro.duce 
attractive documents. Word processors come in all 
shapes and sizes, from a simple desk accessory you 
use to address an envelope to those designed specif­
ically for desktop publishing. The leading word pro­
cessor is Microsoft Word, followed by other contenders 
such as WordPerfect for the Mac (from WordPerfect), 
MacWrite II (from Claris), WriteNow (from T/Maker), 
Nisus (from Paragon), and FullWrite Professional 
(from Ashton-Tate). 

Basic word processors enable you to enter, edit, save, 
and print text. Most word processors let you check 
spelling, format text, number pages automatically, 
change margin and tab settings, select page orienta­
tion, apply headers and footers, select paragraph 
alignment, insert page breaks, and perform searches 
and replacements. • 

Powerful word processors enable you to sort alpha­
betically, find a synonym, use style sheets for specific 
formatting tasks, perform redlining procedures, use 
macros, generate tables of contents, indexes, foot­
notes and bibliographies, import graphics files, and 
create columns of text. 

Word processors are often powerful enough to sub­
stitute for sophisticated and costly page-layout pro­
grams. Also, look at integrated packages such as 
Microsoft Works and Ragtime (from Ragtime USA) 
that include powerful word processors, as well as 
database management systems, spreadsheets, graph­
ics (as with Ragtime), and communications capabili­
ties. 

See also Buying Software and Desktop Publishing. 
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, Zoom Box._, ___.___.___.___.___.;;;;;;; 

You can use the Zoom box located in the upper right 
corner of most active windows to enlarge or reduce 
the size of the window (see fig. Z.l). The Zoom box 
works like a toggle switch. Each time you click it, the 
window enlarges or decreases in size. 

Jen's Stuff 
5 items 78,536K in disk 201 K available 

CJ CJ 
HyperCard Utilities 

Fig. Z. 1. The Zoom box. 
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SYSTEM 7 FIRST LOOK 

As those wizards who originally brought us the Mac 
continue their research and development work, they 
offer new and more powerful Systems. The latest 
System enhancement is System 7. System 7 is Apple's 
first release of a major system enhancement in over 
three years. 

This section of The Little Mac Book discusses some of 
the new features in System 7. Many features-such as 
cutting and pasting and moving a file-remain the 
same between older Systems and System 7, but other 
features have changed. 

, What's New With System 7? J-

Many items are new to System 7, and several new 
features make your Macintosh a more useable and 
powerful machine. Note that all of the following 
features may not end up in the final release of the 
software. 

Here's a rundown of the features System 7 contains 
(as of the date of this printing): 

• A new Finder that enables you to place an 
unlimited number of DAs in the Apple Menu 
Folder (contained in the System Folder), rather 
than using the Font/DA mover. 

• A new system for installing fonts that enables 
you to drop them into a folder in the System 
Folder. 

• A new Trash Can that empties only when you 
tell it to (select the Empty Trash Can com­
mand), and not when you shut down or 
launch an application. 



The Little Mac Book==================== 

• You can make any item a selection on the 
Apple menu . You can access desk accessories, 
applications-even files-quickly and easily 
through the Apple menu. 

• Macintosh FileShare, which i.; a tool for sharing 
files over an AppleTalk network without a 
dedicated server. 

• Virtual memory, that enables your computer to 
use your hard disk as extra RAM. 

• A new printer architecture that enables you to 
create new printer drivers as well as back­
ground printing, so that you can print while 
you continue to work. 

• InterApplication Communication Architecture 
(IAC), for linking data between applications. 
IAC will eventually allow developers to design 
a system where every element is linked , 
thereby giving you control over how informa­
tion flows from one application to another. 

• A new font technology (TrueType) that enables 
you to produce high-quality output, even on 
your ImageWriter. You also can control such 
desktop publishing processes as kerning (the 
spacing between letters) , by using the Layout 
Manager. 

• Database Access Manager, for linking data to 
remote databases. 

, Should You Get System 7? J--
Should you make the switch? Here's the big plus: 
More power and tools to make your Mac life easier. 
Another favorable change is the ease with which o ld 
Mac features are now integrated into the Finder. 

However, there are minuses as well: 
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• You must have at least 2M of RAM. 

• You cannot use virtual memory on certain 
Macs without upgrading, which can be costly. 

Most people will not want to be pushed into spend­
ing a lot of money for more RAM before they see what 
they are buying and until Apple fixes any bugs found 
in System 7. This process will take some time. Until 
then, System 7 probably will not be required to run 
new applications. 

In the future, certain Mac applications may only run 
under System 7. That may leave lots of Mac users 
unable to keep up with software and system changes. 
There is talk, however, of creating applications that 
work with both Macs using System 6 and Macs using 
System 7. 

The gurus have mixed opinions. Many believe you 
should have System 7 available but should not yet get 
rid of System 6. Others believe you should go cold 
turkey and go to 7 as soon as it comes out, and you 
should pay the money for the disks and whatever else 
you might need to upgrade. There is one other 
option: you can wait until the dust settles. 

, How Do You Get System 7? J-
System 7 will come with Macintosh computers man­
ufacturered after the System 7 release date that 
can support the new operating system. User groups 
and bulletin boards will distribute System 7, and the 
software will be available on CD-ROM. You will be 
able to get System 7 at your local Apple dealer for 
approximately S49. 
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It's in Apple's best interest to get the word out 
quickly, so the company will make every effort to sell 
System 7 at the lowest possible price. 

Apple plans to make System 7 available to you some­
time in the Summer of 1991. 

, What Do You Need to Run System 7?1 
If you want to use Syste m 7 and have been putting off 
that memory upgrade, you now have the perfect 
reason: System 7 will not work with anything less than 
2M of RAM. 

To run System 7, you must have the following: 

• Any Mac from the Plus up 
• At least 2M of RAM 
• A hard drive 
• SOOK floppy drive to read the system disks 

You can get System 7 up and running on the old Macs, 
such as the 128K and 512K machines, but you will 
need a new motherboard, in addition to the items 
above. Adding these items to an old Mac is costly. For 
example, to get a 128K machine going, you can spend 
upwards of Sl,500-and even then the result is a 
relatively slow machine . Why not just put that money 
toward one of the new Macs that can run System 7 
with little modification? 

, System 7 vs. System 6 11;;~~ 

When you use System 7, you find that certain tasks are 
different. The following chart compares the new 
System 7 operating system to the old System 6 oper­
ating system. 
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Table 7.1 
System 7 vs. System 6 

You Used To ... 

Duplicate a file and 
get a file named 
Copy of filename. 

Install a font using 
the Font/DA Mover. 

See how a font 
looked by using it. 

Copy a file and place 
the copy in another 
location for easy access. 

Drag an INIT into 
the System Folder. 

Work with one 
control panel 
through which you 
access all CDEVs. 

Be limited to 15 fonts 
or desk accessories. 

Press Shift-3€-3 co 
create a screen dump. 

Empty the Trash Can 
by restarting your Mac, 
launching a new 
application, or 
selecting the Empty 
Trash command. 

Now You . .. 

Duplicate a file and 
gee a file named 
Filename #I. 

Drag fonts into the 
System Folder. 

Click on a font co see 
how it looks. 

Create an alias. 

The system directs 
the INIT to a folder 
named "Extensions." 

Each CDEV has its 
own control panel. 

Have no limit on fonts 
or desk accessories 
(other than disk space). 

Create a Picture file . 

Empty the Trash Can 
through the Empty 
Trash command only. 
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Table 7.1 (continued) 

You Used To ... 

Double-dick on a 
folder to view its 
contents 

Forego the active use 
of a Mac file server 
on a network. 

Select a file or 
folder by scrolling 
through a list. 

Shift-Click to 
select files. 

Use a special utility 
to display large fonts 
on-screen properly. 

Specify when to use 
MultiFinder as a 
startup option. 

Be limited by the 
physical memory of 
our Mac. 

Scream for help 
and no one answered. 

Now You . .. 

Click on the dot next 
to the folder icon. 

Use FileShare, which 
permits a server to 
be an active part of 
the network. 

Type the name of 
a file or folder. 

Use the Find and 
Find Again commands 
to locate and select 
files. 

Have TrueType, which 
makes all fonts in all 
sizes display accurately. 

MultiFinder operates 
automatically. 

Use virtual memory. 

Access on-line system 
help. 
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SYSTEM 7 TOPICS 

The following section contains an alphabetical listing 
of topics related to System 7 features . 

The information is based on a pre-release version of 
the software. There may be differences when the final 
product ships. 

You can assign an Alias (literally, the "same thing") to 

a file or a folder and place the alias anywhere on the 
desktop or in any folder. You are, in effect, creating 
multiple icons for the same file or folder. When you 
create (or in System 7 lingo, "make") an alias, you are 
placing only a reference to that file or folder in anoth­
er place-not the actual contents of that file or folder. 

In effect, System 7 enables you to organize the same 
information in different ways. For example, you can 
have all your folders organized by application (word 
processor, database, and so on) , and then have aliases 
in other folders that organize the same information 
by creation date. Or, you may have a cover letter for 
an annual report that contains documents you created 
using WriteNow and Microsoft Excel. Where should 
the letter go? You can place the letter in the WriteNow 
folder and an alias for that letter in the Excel file as you 
see in Figure 7 A. l. The information management 
schemes are endless; you can customize them to suit 
your needs. 

You can treat an alias as you would treat any other file. 
When you double-click on an alias, the original file­
not the alias--opens. 
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EHcel 
9 i.tem.s 15 .2M ill disk 4.?M avUW>lt 

iDS Wip20 :Excel 
Namt Size KW. L 

1K 
11{ Microsoft Eio:tl docu. 

D ch4 hard drivt com.p 3K Microsoft Eio:tl docu. 

Fig. 7A.1. An alias of a file in another folder. 

, Apple Menu 1--iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

Do you want instant access to any application, desk 
accessory, or alias? All you have to do is drop the file 
into the Apple Menu Folder in the System Folder. 

Notice the contents of the Apple menu in Figure 7 A.2 
You see some of the standard DAs such as the Alarm 
Clock, Chooser, and DiskTop, a Control Panel device. 
However, you see not-so-standard items as well. 

~ Alarm Clock 

~ Battery 
llifil Calculator 
:8 Chooser 
~ Control Panels 
~ DlskTop 
~ Find File 
~ Image Grabber•H 
(@)Key Caps 
IIiJ Scrapbook 
~Smart Art'"' 

Fig. 7A2. Items available under the Apple menu. 

Placing items in the Apple menu is a great way to have 
constant access to those applications, files, and other 
tools that you use often . 
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System Ts programming language is supposed to be 
the language (like the computer) for the rest of us. 
Like HyperCard's HyperTalk, AppleScript provides 
plain English commands that enable you to program 
the Mac. 

AppleEvents is a set of messages such as "Open File," 
that all applications understand. You can use Ap­
pleEvents to control the activities of one application 
from another application. For example, you can "pro­
gram" the Finder to open a document automatically 
upon starting up. 

See also IAC. 

Control panel devices located on the Apple menu 
operate like CDEVs of earlier systems. Previously, you 
accessed CDEVs through one control panel window, 
Each System 7 CDEV has its own window where you 
manage and change the settings. 

To select a particular CDEV 
1. From the Apple menu, open the Control 

Panels icon. All of the icons representing 
Control Panel devices are shown (see figure 
7C.l). 

2. Double-dick on the device you want to use. 

3. Make any desired adjustments. 

4. Click the close box to close the window. 
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~ Rlorm Clock 

~Battery 
~ Calculator 
8 Chooser 
~ Control Panels 
~ DiskTop 
~Find Fiie 
~Image Grabber•M 
[@)Key Cops 
mi Scrapbook 
~Smart Rrt•M 

Fig. 7C. l . All control panel devices appear on the Apple 
menu. 

, Control Panels l .. ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;; 

Remember the System 6 Control Panel? Say goodbye 
to it. You access the System 7 Control Panels folder 
from the Apple menu (see fig. 7C.2). The System 
stores control panel devices in the Control Panels 
folder. When you select Control Panels, you see all 
the Control Panel devices (CDEVs). You then need to 
select the device you want, whether you are setting 
the Alarm Clock or launching Microsoft Word. 

Ill Control Pnnels ell 
I OitHM 5 .IH in disk 13 .811 •v•iloblf 

~ GJ .. EJ m G1 ~ 
11>;;;;;,_;Jj 

c;.nenl Controls l~Mls Moun KOljboKd St•rtup Disk Yitws 

[Q] D ~ <J>») 
Monitors Nttwork Sttup Pot hblt So<Jnd 

'oi 
~ 10 '2:i 

Fig. 7C.2. The Control Panels folder. 

The Control Panels folder contains the following 
features : 
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• General contro ls the desktop pattern, the 
mouse blink rate, the menu blink rate, and the 
time and date. This control panel is similar to 
the General device in earlier systems. 

• Keyboard controls the keyboard repeat rate 
and the delay-until-repeat rate. You also use 
this option to set the keyboard for a foreign 
language. 

• Labels enables you to attach your own label to 
a particular file (see fig. 7C.3). 

figures 
Name Labe! 

~ MacPaint Vivacious 

D alias Optimal 

D apple menu icons Hip 

D dl contents None 

D find creation! None 

D hide hallo on Hip 

Fig. 7C.3. File names and labels. 

• Monitors controls the type of monitor you are 
using (black-and-white or color) . 

• Mouse controls basic mouse adjustments, 
including tracking and double-click speed. 

• Network Setup controls system accessability 
and verifies passwords. This device permits 
you to set the number of connections (nodes) 
on a network and whether you want to share 
files with o thers on the network. 

• Portable controls settings specific to the Mac 
Portable . 

• Sound enables you to select a sound (such as 
"Boing") and adjust the speaker volume. 

• Startup enables you to specify any disk as the 
startup disk. 
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• Views lets you control which information 
appears on the desktop and adjust the appear­
ance of this information (see fig. 7C.4). 

;:o Ulews 

Font,.,. vltvs: ...._G_en_e_u_a ___ ........ I !!:JG 
r-~ ~ndo~ll; ~:;:~~;:·-----·--·----·--------.. ---·---------, 
l O Rlweys grid drags 

0 O 0 O O Staggered grid 

j-llst Yl•ws 

I q. ~ ~ 
I ® o o 
I 0 Show folder sizes 
I 0 Show disk Info in header 
L 0 Show path name in heeder 

181 Show size 
181 Show kind 
181 Show l11bel 
181 Show d11te 
O Show uerslon 
O Show comment 

Fig. 7C.4. The Views Control Panels device. 

See also Desktop. 

, Database Access Manager F 
The Database Access Manager (no acronym?) enables 
you to connect your Macintosh applications with 
databases on other (host) computers. You can use a 
page layout program such as PageMaker, for example, 
and import data from an entirely different system. 
The success of this procedure depends on the ap­
plication importing the data. 

, Desk Accessories t~~~~iimiiiiiiiiiiii 
Desk accessories are still desk accessories, but System 
7 changes a few things. You no longer need to use the 
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Font/DA Mover to install or remove fonts or desk 
accessories. You simply drag fonts and DAs into (and 
out of) the Apple Menu folder. 

There is no limit to the number of items you can have 
on the Apple menu. You can put ten or one hundred 
DAs on the menu. If you have more DAs than can fit 
on the menu on one screen, you see an arrow at the 
bottom telling you to scroll to see the rest of the list. 

The System 7 desktop looks basically the same as the 
desktop from earlier systems (see fig. 7D.l) . Note, 
however, the following differences: 

• You can customize the desktop through the 
View and Label Control Panels. 

• You can view the contents of a folder in the 
same window as the folder containing those 
files. 

• fil e Edit Ulew Lobel SonJose Iii! 

IOhe:1ru1 

0 control 
D DtstTup ... 

D Pilebb 
0 D HupPlxet" 
o D Publr Domain 

o D s? rieares 
o D S,:,temPokler 

• lanuded folder I 
ODUlillw 
0 D VAOCIN!S 

Hord llsk 
12.SM indb k 

H a1110bk 
Sl:e KIDd 

13K TeechTt:r:tdocwmnt 
1411':-
16~ TeechTtxtdocament 

.• fo)!tr 

·- folder 
·- folder 
- folder 

- folder 
- Colder 
- fol4er 

Fig. 7D.1. The System 7 desktop. 
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With earlier versions of the System, to delete a file, 
you select the file and drag it to the Trash Can. When 
you delete a file in System 7, however, it remains in 
the Trash Can until you select the Empty Trash 
command from the Special menu. 

In earlier systems, the Trash Can emptied automati­
cally when you shut down your Mac or launched an 
application. With System 7, the Trash Can serves as a 
folder where you can store items as long as you like . 
You-not the System-are in control of your trash. 

, Extensions lliiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii-

Extensions is the name of a new folder contained in 
the System Folder. The Extensions folder holds INITs, 
which the System uses when you boot up your com­
puter. 

To install an INIT, drag the INIT into your System 
Folder. Your Mac automatically puts the INIT in the 
Extensions folder. System 7 is smart and self-sorting: 
it takes information and places the information where 
it belongs. 

The INIT loads when you restart your Mac. 

, FileSharel--~~~~~--
AppleShare, Apple's server product, requires a Mac 
dedicated to storing and distributing files. In contrast, 
Apple File Share, an integral part of System 7, is a non­
dedicated AppleTalk Filing Protocol server. What 
does that mean? Well, with Apple FileShare software, 
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a Mac specifically assigned to managing the network 
can now be used for other tasks. 

, Finding Files m;;;I ~~~~= 

Find File replaces the old desk accessory of the same 
name. The new Find File works the same way as the 
old Find File, but it is much faster-Apple claims it can 
search an SOM hard disk in three seconds. 

Find File is great for finding a particular file and the 
file 's location, but System 7 comes with other power­
ful search utilities. You invoke these utilities by select­
ing the Find command from the File menu. The Find 
command searches for and selects files that meet the 
user-defined criteria. 

You can search for file size, name, or version; whether 
the file is locked; or when the file was created or 
modified (see fig. 7F.l). After you search and find 
what you specified, you can use the Find Again 
command to resume the search. The system searches 
through the information in the Get Info windows 
(which contain the necessary information), rather 
than through the individual files. 

a llllJll Edit Ulew Lebel SenJose ~ 

Find items whose 

I._ _N_<1_rr_1e __ ......... I I contnins ""'l L~------~J 
@ One et e time 

0 Rll ot once 

(Fewer Choices J 

@ On I <1 11 di~ks ""'I 
O Within the front window 

O Within the selected Item 

( Cencel J K Find )J 

Fig. 7F.1. The More Cboices dialog box. 
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Toftnd aftle 
1. From the File menu, select Find. 

2. Click the More Choices button. 

3. Select the various criteria by which you want to 
search. The general categories of criteria are as 
follows: 

• Name, Size, Version, Comment, Label, Kind, 
Lock, Creation Date, and Modification Date. 

• A second qualifier based on the first criteri­
on you selected. Using this qualifier, you can 
find and select all files, excluding those files 
created on April 27, 1991, for example. 

• A third qualifier based on the second 
criterion you select. For example, if you 
select Creation Date, the third criterion is 
the actual date you set. 

• The disks you want to search. All Disks is 
the default. 

For example, to search for any files created after a 
particular date, you select the Creation Date option 
from the first list of criteria, Is After from the second, 
set the Date in the third, and then select All Disks. 
Once you click Find, the files meeting these specifi­
cation are found and selected. 

To Find Again using the same criteria 
Select Find Again on the File menu, or press ~-G. 

When you select the Find Again command, you do not 
see the search box as you did with the original Find 
operation. System 7 only searches through disks you 
define. 
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System 7 brings striking changes co the Finder, making 
ic more intuitive and easier co use. On che flip side, the 
new Finder takes twice the memory-almost 31 OK, as 
opposed to 150K for the old Finder. 

The new Finder enables you to locate a file through 
its select-by-typing option. You can select a file by 
using the keyboard. 

To select a folder or a.file by typing 
1. Open the window chat contains the file or the 

folder you want to select. 

2. Type the name of the folder of the file from the 
keyboard. 

The Finder searches automatically for the entry with 
the closest match. 

Notes 
There is a catch: you have to enter the keystrokes to 
search for a file or folder name using an even pattern 
of keystrokes. For example, if you are looking for the 
file named Annual Report, and you type the word 
Annual and then pause, the Finder goes co the first 
file beginning with "annual," whether "report" fol­
lows ic or not. If you type the words Annual Report 
and do not pause between the words, the Finder finds 
and highlights the file you want. 

, Folders 1-------iiiiiiiiiiiiiii---------~ 
The biggest change in the desktop is the way in which 
System 7 presents the folders. Each folder that con­
tains files has a small dot to the left of its name when 
folders are viewed by name (see fig. 7F.2) . This dot, 
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or control object, means that the folder contains files. 
lf there is no dot, the folder is empty. The dot, which 
is the current shape of the control object, may appear 
as a triangle with the final release of System 7. 

0 0 Word 
Fig. 7F.2. A icon of a folder containing files. 

When you do expand the contents of a folder (some­
what like an outline), tlle control object appears gray, 
indicating thatthe folder is expanded. You still double­
click on the original folder or file icon when you want 
to open a folder, so that the folder contents appear in 
a separate window. You also use this method to 
launch an application. 

As with earlier systems, folders can contain files and 
you may place folders within other folders. 

To see the contents of a folder in "outline" style 
1. Double-dick on the folder button or contro l 

object. The listing of files and other folders 
appears. 

2. Double-dick on the gray folder dot (or trian­
gle). 

To create a new folder 
From the File menu, select New Folder. 

The system creates a folder named Untitled Folder. The 
initial label is framed by a white line. If you create 
another folder, the system names it Untitled Folder 
#2, unless you rename the first new folder. 

To rename a folder 
1. Click once on the folder name. The highlight­

ed name is framed by a white line. 

2. Enter the new name for the folder. 
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To restore the original name of the folder 

l. Press Backspace until you delete all of the 
characters. 

2. Press Return or Enter. 

, Font/DA Mover IS;ii;;;;;--------= 
Don't look for this once-invaluable utility; it's not in 
System 7. Instead, you install fonts, desk accessories, 
and sound directly into the Apple menu in the System 
folder. 

To install a desk accessory, drag the desk accessory to 
the Apple Menu Folder located in the System Folder. 

To install a font, drag the font suitcase into the System 
Folder. 

To install a sound, drag the sound file into the System 
Folder. 

To hear a sound or see a font that you installed in 
System 7, double-click on the font or sound icon. 

Outline fonts technology, part of System 7, enables 
you to generate sharp text of any size on any Mac 
monitor and all printers. 

See also Font/DA Mover and TrueType. 
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You know how important help is when working with 
any application, and the wizards at Apple are includ­
ing what they call Balloon Help for System 7 (see fig. 
7H. l). Help is available whenever you need it . 

• Fiie Edit Ulew Lobel San.Jose llll 
Har d Disk 

••••J 13.4Mb.tisl' 
Hri t>ist 

llw. lilt l.W 

OCleu,r....- - row. 
OCJP .... - roUtr 

0 CJ PUlk Doat.ia - (0 Lk1 

00s7 [ip't1 - !oYitr 

OCJtyst,aFol&tt - Cow.t 

0 Cl Uilntt - ..... 
CJ VlltriM.,. - row. 

OClVori - loMtt 

Fig. 7H.l . Balloon Help. 

To get Help on any System 7 feature 
1. From the Apple menu, select Show Balloons. 

2. Move the mouse pointer to any part of the 
desktop. A balloon provides you with a short 
but helpful statement about that feature. 

You also can get help on any menu item by selecting 
that menu item after you activate Show Balloons. 

Notes 
Balloons continue to appear about one second after 
you stop moving the mouse pointer. Keep moving 
your mouse if you don't want help to appear, or you 
can select Hide Balloons (see fig. 7H.2). 
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Ttrns S.lloon 
help off. 

Rbout Help ... 

Fig. 7H.2. The Hide Balloons option. . 

InterApplication Communications (IAC) is a new 
data exchange format that provides links between 
applications and links between files. After you update 
a worksheet created using Excel, for example, the 
table based on those numbers that you imported into 
a Microsoft Word document changes to reflect the 
new data. 

IAC is not a System 7 feature that you need to interact 
with, because the benefits you reap are the result of 
redesign by application developers. Get set to deal 
with live links here: active fields placed into other files 
and those fields easily accessed for changes. 

Ignoring System 7 until all the bugs are worked out 
and until all the software that you want is available 
and compatible may be the best way to avoid the 
frustration that comes with any new software. Don't 
forget: the System is the brains of your machine. Once 
it gets a headache, you get a migraine. 

If you install System 7 on a floppy system, certain 
features, such as virtual memory, are unavailable . 
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Your best bet is to install System 7 on your hard drive 
and have System 6 (or the other system you were 
working from) available on a floppy. This setup 
enables you to take advantage of what System 7 has to 
offer, yet still use applications that won't work with 
System 7. 

If you have two hard drives, you can install System 6 
on one hard drive and System 7 on the other. Then 
keep all the applications that work with System 7 on 
one drive and applications that don't work with 
System 7 on the other drive. Hard drive prices are 
dropping; you can get a 20M hard drive for less than 
$300. 

To install System 7 
1. Back up all your hard disk files . 

2. Reformat-don't erase-your hard disk. To 
reformat, use the software that came with your 
hard disk. Be careful: reformatting erases 
everything on the disk. You can try installing 
the software without reformatting, but there 
may be hidden file spooks waiting to sabotage 
System 7. 

3. Install System 7 by following the directions 
that come with the System software. 

4. Drag the DAs, INITs, and CDEVs that you want 
on your system into the System Folder. These 
files may cause conflicts, so you might want to 
test each one as you add it. 

5. Create folders for the applications you want to 
use, and copy the programs to your hard disk. 

6. Back up your hard disk by using a commercial 
product (such as FastBack by Fifth Generation 
Software) or by copying files onto a floppy disk 
or another hard disk. 
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System 7 enables you to create and attach labels to 
files for identification and organizational purposes. 

To attach a label to a file 

I. From the Apple menu, select Control Panels. 

2. Double-click on Labels. 

3. Type the names of the labels you want to use 
as in Figure 7L. l. 

4. Select the file to which you want to attach a 
label. 

5. Select the label from the Label menu. To see 
the labels, you must select the Label box on 
the Views control panel (see fig. 7L.2). 

q. 

D 
D 
D 

D 
D 

ID labels 

• Jsplendi'4 

• JEHciting 

- JU1u11clous 
• !Euphoric 

• JNew 

• JOptlm11I 

• JHlp 
~-----~ 

Fig. 7L.l. Creating a label. 

figures 
~ 1...ao-e1 

MacPaint Vivacious 

alias Optimal 

apple menu icons Hip 

dt contents None 

find creation I None 

hide balloon Hip 

Fig. 7L.2. Viewingfiles with labels. 
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, Layout.Manager l------------
Layout Manager, part of Apple's new font technology, 
provides automatic support for kerning and creating 
ligatures (such as re and re). 

See also Fonts and TrueType. 

, .MultiFinder ll;i;iiiii;;;;;====~ 
MultiFinder, Apple's "multi-tasking" software intro­
duced with System 6, is standard with System 7. When 
you boot up, you see the MultiFinder icon in the 
upper right comer of the screen and a listing under 
that icon of all active applications. 

You cannot disable MultiFinder under System 7. The 
basic 2M of RAM needed for System 7 provides enough 
memory for you to start with MultiFinder. The 2M of 
RAM is not, however, enough to run more than one 
of the larger applications within MultiFinder. 

MultiFinder has one new feature under System 7. 
When you have several applications active, you can 
select the Show command to view only the applica­
tion, or select the Hide command to view the appli­
cation's windows. For example, if you select Show 
MacPaint Only from the MultiFinder menu, then the 
MacPaint icon will appear as the MultiFinder icon. If 
you select Hide MacPaint Windows, MacPaint re­
mains an open application, but all the MacPaint 
windows close. These new features help you manage 
a crowded desktop. 
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As with earlier systems, the dialog box that appears 
when you select Open permits you to open a file and 
navigate to other folders. The System 7 Open dialog 
box has two new parts (see in figure 70 .1). First, there 
is a button labeled Desktop. When you click this 
button, you return to the desktop, where you can see 
the contents of the desktop inside the dialog box. 

I 

The second feant're is a small black triangle above the 
file list box that points toward the bottom of the 
screen. Point to the triangle and press and hold the 
mouse button. The triangle reveals the contents of 
the desktop and all mounted drives. Releasing the 
button restores the original name above the the list 
box. 

le s7 figures~ c::i Hard Driue 

I.II ll!J 0 [ E:jPC1 l D apple menu Icons 

I I ( ) I D dt contents Desktop 
D find creationl 

,:i,!1 ·------
D hide balloon 
D labels I 

I 
[ Cancel ) 

D mouse cdeu ( ~ D Note -0 Open 

Fig. 70 .1. Features new to the Open dialog box . 

Quick.Draw is software built-in to the Mac's ROM that 
enables you to constrUctvarious typefaces and graphic 
images. System 7 contains a more powerful Quick­
Draw-one that enables you to produce high-quality 
type, similar to the quality output produced by Post-
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Script machines. How can System 7 achieve this 
quality? Like Postscript, QuickDraw uses a ma them at· 
ical formula. Unlike PostScript, the formula is based 
on "quadratic spline curves," instead ofBezier curves. 
Along with the Layout Manager, which provides con­
tro l over many different aspects of typography (such 
as kerning and spacing), the new QuickDraw program 
provides high-quality output from any printer you 
use. 

, San J ose l s-iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii___. 

Have you wondered why the Special menu on the 
screenshots in this section appears as "Sanjose?" The 
developers of the pre-release versions of System 7 
want to commemorate their May, 1989 meeting in 
Sanjose, where the developers released the System 7 
standards. 

, Screen Dumps 1..-;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;iiiiiiiiiiiiiiiiiiiiiiiiiiiiii= 

With System 6, you capture the contents of the screen 
as a Paint file by pressing Shift-3C-3. This procedure 
produced a Paint file labeled "ScreenO." When you 
use the Shift-3C-3 key combination with System 7, 
your Mac produces a Teach Text file labeled "Picture. " 

TeachText is a general utility developed by Apple 
Computer that saves text and graphic files in a format 
that many different applications can read. By creating 
a TeachText file, rather than a Paint file, you have 
more flexibility regarding the type of application you 
can use to modify captured screens. 
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You can create as many Teach Text files as you want (at 
least up to 999-after that, my fingers got tired). No 
more starting over after 10 screen captures! 

Select is a new menu item that enables you to select 
files based on a criterion. For exam pie, you may want 
to select all files larger than 20K. System 7 enables you 
to specify the criterion, and then your computer 
performs the searching and selecting work for you. 

, System Folder l .. iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiimiiiii 

The System Folder contains the familiar System and 
Finder files, but has the capability to sort new folder 
additions and place items where they belong. For 
example, if you place an INIT in the System Folder, 
the System automatically moves the INIT to the Ex­
tensions Folder. 

See also Desk Accessories and Font/DA Mover. 

True Type is Apple's new outline font technology that 
provides you with more flexibility and cleaner type­
both on the screen and on paper. TrueType improves 
the relationship between what you see on your 
Macintosh screen and your final output. 

TrueType offers font options similar to the current 
standard: Adobe Postscript fonts. The two font op­
tions, however, use different technologies. You need 
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a conversion program to use an Adobe font with 
Apple's new font technology. The new technology 
uses "quadratic line curves," which are computed 
quickly and easily. PostScript uses Bezier (pronounced 
"bez'-ee-ay") curves. Beziercurves must be converted 
before you can use a font developed by one company 
on the other company's technology. With TrueType, 
the Font Manager computes these equations. 

TrueType attaches an instruction set to each font. 
This instruction set provides what Apple calls "hints." 
Hints help maximize the screen or printer output. 
Hints maximize output according to the high-quality 
model dictated by the equation defining the charac­
ter's shape. There is a down side to this new tech­
nology: it is unclear whether current applications will 
operate under the new font technology without re­
quiring a software rewrite. The need won't be clear 
until the applications are tested with the final release 
of System 7. 

Views is a Control Panel Device that enables you to 
control the appearance of information the desktop 
displays. If you are tired of the typeface Geneva, 
rejoice! You really can spruce up your desktop. 

The example in Figure 7V.l uses 14-point Times 
Roman, which provides large, easy-to-read letters. 
The new Control Panel view options are a real boon 
to the visually impaired. 

The options that you select appear on the View menu, 
from which you can select any or all to organize how 
your files are arranged. For example, unless you 
select view-by-date, you will not be able to organize 
your files by date on the desktop. 
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20M 

lillm Siu Kind Uj 

O 0 System Folder -- folder 
0 Note 3K MacPaint document 
0 views 9K document 

0 networking 7K doaument 

0 labe!J 7K document 

0 keyboard 7K document 
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Fig. 7V. 1. A customized listing of files. 

To change the font or the size of text on the desktop 
1. From the Apple menu, select Control Panels. 

2. Double-click on Views . 

3. Select the font name and size that you want to 
use. 

To change the way icons are staggered 
1. From the Apple menu, select Control Panels . 

2. Double-click on Views. 

3. Select Normal grid if you do not want the 
icons staggered, or Staggered grid if you do. 
The staggered option avoids overlap when 
names of files and folders are too close 
together. 

To change the view of lists 
I. From the Apple menu, select Control Panels. 

2. Double click on Views . 

3. Check off the box (as many as you want) in the 
List Views box to show the following: 
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• Folder sizes 
• Disk information in the window header 
• Path name in the window header 
• Size of the selected item 
• Kind of the selected item 
• Labels associated with the selected item 
• Date of the selected item 
• Version 
• Any comments entered in the associated Get 

Info box 

, Virtual Memory .. ,~~~~ 

Virtual memory is a System 7 feature that permits 
certain Macintosh computers to use more RAM than 
is physically available. Virtual memory takes advantage 
of available space on the hard disk and transfers 
("pages") often-needed information from the hard 
disk to the computer, rather than from RAM. 

You easily can modify your Mac II to use virtual 
memory by installing a Paged Memory Management 
Unit (or PMMU) for about $190. Adjustments to the 
actual use of virtual memory are made through the 
memory control panel device that allows you to turn 
virtual memory on and off and make other memory 
settings including the cache setting. Therefore, even 
if you buy hardware modifications, you need to have 
virtual memory (the PMMU chip). 

Virtual memory makes System 7 improveme nts come 
alive. First, you can simply do more. More applica­
tions can operate simultaneously and you can pro­
cess more information within those applications. But 
what does it mean in terms of actual RAM needed and 
used? First, because your hard disk picks up some of 
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the load, you need less RAM for equivalent operations 
using just physical memory. For example, you might 
have up to 14M of RAM available (much of it virtual) 
on a standard system! That's quite a bit of RAM at no 
increase· in cost. You have to make sure that you have 
a hard disk that can handle the flow of information 
and the other data tasks that your machine demands. 

You do not have to have System 7 in order to utilize 
virtual memory. You can use "Virtual" from Con­
nectix. 
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QUICK KEY GUIDE 

There's more to your keyboard than meets the eye. 

By using simple key combinations, you can create 
characters and perform certain functions quickly. 

Every Mac comes with fonts. Each font contains 
special characters. The first section of the Quick Key 
Guide shows you how to create hundreds of spe­
cialized characters. These characters are not specific 
to a particular application; you can use these characters 
within any Macintosh program. 

The second section of this guide shows you how to 
perform routine and specialized functions from the 
keyboard in your favorite applications. 

To help you distinguish between the letter "O" and a 
zero, a zero is represented as "0." 
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, Creating Special Characters t 
You can use the following key combinations to insert 
specialized characters into your Mac documents. You 
create the characters by using standard fonts, com­
mon to all Mac systems. 

A dash(-) between keystrokes means you press those 
keys simultaneously. A comma means that you should 
press the first set of keys simultaneously, release 
those keys, and then press the next set of keys 
simultaneously. 

Your Mac stores a listing of special characters. This 
listing is available whenever you use your Mac. To see 
these characters, select the Key Caps desk accessory 
from the Apple 9 menu. 

Unless otherwise indicated, you can create these 
characters using standard fonts, such as Times, Hel­
vetica, Geneva, Courier, etc. Certain characters, how­
ever, are only available in a particular font. If you 
need to change the font to Chicago, Symbol, or Zapf 
Dingbats in order to create a character, you see the 
font name below the key combination. Some char­
acters are enlarged to show detail. 

See also Fonts, Font/DA Mover, Highlighting Text, 
and Mouse in the "MACINTOSH TOPICS" section of 
this book. 
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Description Symbol Key(s) 

AE ligature JE Shift-Option-' 

:e Option-' 

Aleph ~ Shift-Option-/ 
Symbol 

Alpha A Shift-A 
Symbol 

ex A 
Symbol 

Angle L Option--
Symbol 

Apostrophe Shift-Option-] 

Apple • Shift-Option-K 
Chicago 

Approximately ::::: Option-X 

Arrow <=> Shift-Option-2 
Symbol 

v. Shift-Option-6 
Symbol 

<= Shift-Option-3 
Symbol 

11 Shift-Option-4 
Symbol 

11• Shift-Option-7 
Zapf Dingbats 

C) Shift-Option-I 
Zapf Dingbats 

¢ Shift-Option-S 
Zapf Dingbats 

t;;;> Shift-Option-D 
Zapf Dingbats 

~ Shift-Option-F 
Zapf Dingbat 
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Description Symbol Key(s) 

Arrow (cont.) 0 Shift-Option-G 
Zapf Dingbats 

0 Shift-Option-H 
Zapf Dingbats 

0 Shift-Option·] 
Zapf Dingbats 

c> Shift-Option-L 
Zapf Dingbats 

:) Shift-Option-; 
Zapf Dingbats 

H Option-E, Space bar 
Symbol 

Option-' 
Symbol 

Option-Z 
Symbol 

J, Shift-Option-0 
Symbol 

f- Option-U, Space bar 
Symbol 

--7 Shift-Option-' 
Symbol 

i Option-= 
Symbol 

-+ Option-] 
Zapf Dingbats 

-~ Shift-Option-] 
Zapf Dingbats 

• Shift-Option-U 
Zapf Dingbats 

~ Option-/ 
Zapf Dingbats 
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Description Symbol Key(s) 

Arrow (cont.) ... Shift-Option-V 
Zapf Dingbats 

~ Shift-Option--
Zapf Dingbats 

.... Option-U, Y 
Zapf Dingbats 

_,, 
Shift-Option-I 
Zapf Dingbats 

~ Shift-Option-2 
Zapf Dingbats ... Shift-Option-3 
Zapf Dingbats 

• Shift-Option-Y 
Zapf Dingbats - Shift-Option-9 
Zapf Dingbats 

-+ Shift-Option-4 
Zapf Dingbats 

-+ Shift-Option-5 
Zapf Dingbats .. Shift-Option-Z 
Zapf Dingbats 

>+ Shift-Option-B 
Zapf Dingbats .. Shift-Option-X 
Zapf Dingbats 

?" Shift-Option-N 
Zapf Dingbats 

H Shift-Option-, 
Zapf Dingbats ..,. Shift-Option-M 
Zapf Dingbats 

-+ Option-H 
Zapf Dingbats 
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Description Symbol Key(s) 

Arrow (cont.) .. Shift-Option-. 
Zapf Dingbats .. Option-K 
Zapf Dingbats 

>- Shift-Option-E 
Zapf Dingbats 

Arrowhead )> Shift-Option-0 
Zapf Dingbats 

> Shift-Option-W 
Zapf Dingbats 

Asterisk * Shift-Q 
Zapf Dingbats 

* Shift-R 
Zapf Dingbats 

* I 
Zapf Dingbats 

* Shift-S 
Zapf Dingbats 

• Shift-Z 
Zapf Dingbats 

Bar I z 
Zapf Dingbats 

y 

Zapf Dingbats 

Beta B Shift-B 
Symbol 

~ B 
Symbol 

Box • N 
Zapf Dingbats 

D N (outline) 
Zapf Dingbats 

0 0 
Zapf Dingbats 
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Description Symbol Key(s) 

Box (cont.) 0 p 

Zapf Dingbats 

0 Q 
Zapf Dingbats 

D R 
Zapf Dingbats 

• u 
Zapf Dingbats 

·:· v 
Zapf Dingbats 

Brace Shift-Option-} 
Symbol 

Breve Shift-Option-. 

Bullet • Option-8 

Cedilla <; Option-C 

Caret 
A 

Option-I, Space bar 

Carriage return .J Option-0 
Symbol 

Check mark ./ 3 
Zapf Dingbats 

t/ 4 
Zapf Dingbats 

Chi x Shift-C 
Symbol 

x c 
Symbol 

Circle 0 Shift-Option-• 

Zapf Dingbats 

G) Option-Z 
Zapf Dingbats 

@ Option-\ 
Zapf Dingbats 
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Description Symbol Key(s) 

Circle (cont.) @ Option-. 
Zapf Dingbats 

• L 
Zapf Dingbats 

0 M 
Zapf Dingbats 

Club ... Option-S 
Symbol 

• Option-R 
Zapf Dingbats 

Cluster ~ G ,,, 
Zapf Dingbats 

* ' H 
Zapf Dingbats 

Congruent - Shift-2 
Symbol 

Copyright © Option-G 

© Shift-Option-W 
Symbol 

© Shift-Option-[ 
Symbol 

Cross Botonee + Shift-E 
Zapf Dingbats 

Cross Formee ffi Shift-2 
Zapf Dingbats 

Cross + Shift-; 
Zapf Dingbats 

+ 9 
Zapf Dingbats 

A • Shift-, 
Zapf Dingbats 

+ ; 
Zapf Dingbats 
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Description Symbol Key(s) 

Crux t = 
Zapf Dingbats 

t Option-/ 
Zapf Dingbats 

'11' Shift-. 
Zapf Dingbats 

Dagger :j: Shift-Option-7 

t Option-T 

Degree 0 
Shift-Option-8 

Delta ~ Option-} 

~ Shift-D 
Symbol 

8 D 
Symbol 

Diaeresis Option-U, space bar 

Diamond • Option-R 
Symbol 

• Option-G 
Zapf Dingbats 

Dies is :j: Shift-Option-7 

Divide Option-/ 

Dot accent Option-ff 

Element E Shift-Option-Q 
Symbol 

Ellipsis Option-; 

Em dash Shift-Option--

Empty Set 0 Option-J 
Symbol 

En dash Option-

Epsilon E Shift-E 
Symbol 
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Description Symbol Key(s) 

Epsilon (cont.) E E 
Symbol 

Eta H Shift-ff 
Symbol 

Tl H 
Symbol 

Exclamation • Option-3 • 
heart Zapf Dingbats 

Exclamation • Option-4 • 
point Zapf Dingbats 

Option-I 

Existential 3 Shift-4 
Symbol 

Feet Option-4 
Symbol 

fl ligature fi Shift-Option-5 

fl ligature fl Shift-Option-6 

Florin f Option-F 

Flower 0 Shift-
Zapf Dingbats 

~ 
Zapf Dingbats 

Flower 0 A 
Zapf Dingbats 

Gamma r Shift-G 
Symbol 

y G 
Symbol 

German double S B Option-S 

Gradient v Shift-Option-
Symbol 

Greater than ~ Option-. 
or equal to 
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Description Symbol Key(s) 

Guillemot « Option-\ 

» Shift-Option-\ 

Shift-Option-3 

Shift-Option-4 

Heart • Option-G 
Symbol 

• Option-2 
Zapf Dingbats 

• Option-6 
Zapf Dingbats 

• Optlon-8 
Zapf Dingbats 

Inches " Option-, 
Symbol 

Index -- Shift-8 
Zapf Dingbats 

fbJ Shift-= 
Zapf Dingbats 

Infinity 00 Option-5 

Intersection n Option-\ 
Symbol 

Iota I Shift-I 
Symbol 

l I 
Symbol 

Jet + Shift-9 
Zapf Dingbats 

Kappa K Shift-K 
Symbol 

K K 
Symbol 
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Description Symbol Key(s) 

Lambda A Shift-L 
Symbol 

A. L 
Symbol 

Leaf 'i Option-7 
Zapf Dingbats 

~ Option-S 
Zapf Dingbats 

Less than < Shift-, 

Less than ::; Option-, 
or equal to 

Line break .J Option-0 
Symbol 

Logical and /\ Shift-Option--
Symbol 

Logical not -, Option-L 

Logical or v Shift-Option-1 
Symbol 

Lozenge 0 Shift-Option-V 

Macron Shift-Option-, 

Minutes Option-4 
Symbol 

Mu µ Optlon-M 

Multiply ® Option-F 
Symbol 

Shift-Option-9 

x Option-Y 
Symbol 

N with tilde fl Option-N, N 

Not an element ~ Option-Q 
Symbol 

Not equal * Option-= 
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Description Symbol Key(s) 

Not subset (/:. Option-- or Shift-A 
Symbol 

Nu N Shift-N 
Symbol 

v N 
Symbol 

0 slash 0 Shift-Option-0 

0 Option-0 

Obelisk t Option-T 

OE ligature CE Shift-Option-Q 

re Option-Q 

Omega n Shift-W 
Symbol 

(J) w 
Symbol 

m v 
Symbol 

Omicron 0 Shift-0 
Symbol 

0 0 
Symbol 

Ord, feminine a 
Option-9 

Ord, masculine 0 
Option-0 

Paragraph 11 Option-7 

~ Shift-Option-8 
Zapf Dingbats 

Partial differential a Option-D 

Peace ~ 
' Zapf Dingbats 
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Description Symbol Key(s) 

Pen nib ~ 2 
Zapf Dingbats 

~ 1 
Zapf Dingbats 

Pencil ~ 
Zapf Dingbats 

©> I 
Zapf Dingbats 

ef? 0 
Zapf Dingbats 

Perpendicular J_ Option-I, Space bar 
Symbol 

Per thousand %0 Shift-Option-E 

Petal cross + Shift-C 
Zapf Dingbats 

+ Shift-D 
Zapf Dingbats 

+ Shift-8 
Zapf Dingbats 

Phi <I> Shift-F 
Symbol 

<I> F 
Symbol 

<p J 
Symbol 

Pi n Shift-P 
Symbol 

7t p 

Symbol 

Plus or minus ± Shift-Option-= 

Plus Et) Option-X 
Symbol 

Pound sterling £ Option-3 
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Description Symbol Key(s) 

Product rr Shift-Option-P 

Proper subset c Option-N, Shift-A 
Symbol 

Proper superset :::.> Option-; 
Symbol 

Proportional oc Option-M 
Symbol 

Psi 'I' Shift-Y 
Symlol 

"' y 

Symbol 

Question mark, l Shift-Option-/ 
inverted 

Quotation mark, ,, Shift-Option-W 
baseline 

Quotation mark, Shift-Option-[ 
closed 

" Shift--
Zapf Dingbats 

Quotation mark, " Option-[ 
open .. Shift-[ 

Zapf Dingbats 

Quotation, single, Shift-Option-0 
baseline 

Quotation, single, Shift-Option-] 
closed 

' Shift-\ 
Zapf Dingbats 

Quotation, single, Option-] 
open 

• Shift-[ 
Zapf Dingbats 
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Description Symbol Key(s) 

R fraktur ~ Option-I 
Symbol 

Radical extension 
Symbol 

Radical initiate .J Option-V 

Receiver ({) Shift-7 
Zapf Dingbats 

Reflexive subset c Option-N, Shift-0 
Symbol 

Reflexive superset ;;;;2 Option-Space bar 
Symbol 

Registered ® Option-R 
trademark 

® Shift-Option-0 
Symbol 

® Option·[ 
Symbol 

Rho p Shift-R 
Symbol 

p R 
Symbol 

Ring diacritic 
0 

Option-K 

Scissors ~ Shift-I 
Zapf Dingbats 

~ Shift-3 
Zapf Dingbats 

~ Shift-4 
Zapf Dingbats 

Seconds 
II 

Option-, 
Symbol 

Section § Option-6 

Semicircle • w 
Zapf Dingbats 
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Description Symbol Key(s) 

Sigma :E Shift-S 
Symbol 

cr s 
Symbol 

<; Shift-V 
Symbol 

Snowflake * D 
Zapf Dingbats 

$ E 
Zapf Dingbats 

Spade • Option-2 
Symbol 

~ Option-E, Space bar 
Zapf Dingbats 

Star cross • Shift-F 
Zapf Dingbats 

~ Shift-G 
Zapf Dingbats 

Star of David * Shift-A 
Zapf Dingbats 

Star 0 Shift-} 
Zapf Dingbats 

* Shift-ff 
Zapf Dingbats 

* Shift-L 
Zapf Dingbats 

* Shift-N 
Zapf Dingbats 

* Shift-M 
Zapf Dingbats 

* Shift-0 
Zapf Dingbats 

* Shift-P 
Zapf Dingbats 
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Description Symbol Key(s) 

Star (cont.) * Shift-K 
Zapf Dingbats 

1:l Shift-I 
Zapf Dingbats 

* I 
Zapf Dingbats 

* [ 
Zapf Dingbats 

* c 
Zapf Dingbats 

~ Option-I, Space bar 
Zapf Dingbats 

* \ 
Zapf Dingbats 

* Shift-V 
Zapf Dingbats 

* K 
Zapf Dingbats 

~1'.. 
'•' J 

Zapf Dingbats 

• Shift-X 
Zapf Dingbats 

* Shift-U 
Zapf Dingbats 

* Shift-T 
Zapf Dingbats 

• Shift-W 
Zapf Dingbats 

• Shift-Y 
Zapf Dingbats 

Summation I Option-W 

Sun 0 B 
Zapf Dingbats 
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Description Symbol Key(s) 

Tau T Shift-T 
Symbol 

't T 
Symbol 

Telephone '21" Shift-5 
Zapf Dingbats 

Therefore \ 
Symbol 

Theta e Shift-Q 
Symbol 

e Q 
Symbol 

~ Shift-} 
Symbol 

Tilde Shift-Option-M 

Trademark TM Option-2 

Triangle ... T 
Zapf Dingbats .. s 
Zapf Dingbats 

Umlaut Option-U, Space bar 

Union u Shift-Option-\ 
Symbol 

Upsilon \JI Shift-Y 
Symbol 

I Shift-Option-8 
Symbol 

'I' y 

Symbol 

Victory ~ 
Zapf Dingbats 

Weierstrass f.J Option-V 
Symbol 
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Description Symbol Key(s) 

Writer's hand {l;u 

Zapf Dingbats 

Xmark • 6 
Zapf Dingbats 

x 5 
Zapf Dingbats 

x 7 
Zapf Dingbats 

" 8 
Zapf Dingbats 

Xi .. Shlft-X ~ 

Symbol 

~ x 
Symbol 

Yen ¥ Option-Y 

Zeta z Shlft-Z 
Symbol 

~ z 
Symbol 
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PROGRAM-SPECIFIC 
QUICK KEYS 

Ever find yourself with that certain keystroke combi­
nation or command on the tip of your tongue but not 
quite there? Relax. If you use one of the major 
applications such as Excel, FileMaker, MacDraw, 
PageMaker, SuperPaint, or Word, this shortcut guide 
may be all you need. 

Note: The "universal" quick keys are available in each 
of the preceding applications, unless noted other­
wise. 

, Universal Quick Keys liiil iiiiiiiiiiiiiiiiiiiiiiiiiiiiii-

The following key combinations are available in most 
applications. 

Action Key(s) 

Cancel :i&. (period) or Esc 

Close 3&-W 

Copy 3&-C 

Cut 3&-X 

New 3&-N 

Open 3&0 

Paste :l&V 

Print 3&-P 

Quit 3&-Q 

Save 3&-S 

Select all 3&-A 

Undo :l&Z 
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, Excel Quick Keysl~-----------
The following key combinations are available when 
using Microsoft Excel Version 2.2. 

Action Key(s) 

Activate formula bar ag.u 

Bold ag.e 

Calculate Shift-F9 

Create names ag. . 

Date, current ag.. 

Delete selected cells ag.K 

Equal to = 
Extract ag.E 

Fill down ag.o 

Fill left a&Shift-R 

Fill right ag.a 

Fill up a&Shift-D 

Find next ag.f 

Find previous record a&Shift-F 

Go to cell or named area a&G or F5 

Help 3&/ or Help 

Help, context-sensitive Shift-Fl 

Insen ag.1 

Maximize window ag.flO 

Move window 3&F7 

Newchan Fll 

New macro sheet a&Fll 

Paste special a&Shift-V 

Plain text Shift-P 
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Action (continued) 

Reference, convert formula 

Repeat last operation 

Show information 

Size active window 

Time, current 

Underline 

Key(s) 

:l&T 

:l&Y 

:l&F2 

:i&FS 

a&Shift-U 

, Filemaker Quick Keys l'"" == 
The following key combinations are available when 
using Filemaker Pro Version 1.0 from Claris. 

Action Key(s) 

Add record :!&A 

Align center a&Shift-C 

Align left a&Shift-L 

Align objects :l&K 

Align right a&Shift-R 

Align to grid :l&Y 

Alignment a&Shift-K 

Bold a&Shift-B 

Underline a&Shift-U 

Borders, format a&Option-B 

Browse :l&B 

Center a&Shift-C 

Create macro :l&H 

Date, current II 

Date, paste current a&- (hyphen) 

Delete :i&D 
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Action (continued) 

Delete record 

Define field 

Duplicate record 

Equal to 

Exponential 
(to the power of ... ) 

Field, format 

Find again 

Find all specified criteria 
and add them to browsing 
routine 

Format date 

Format number 

Greater than 

Greater than or equal to 

Grid 

Group 

Help 

Italic 

Layout mode 

Left-justify 

Less than 

Less than o r equal to 

Lock 

Multiplication 

Next field 

Not equal to 

Omit multiple records 

Omit record 

Key(s) 

3fl. E 

3fl.Shift-D 

:l&D 

= 

a&Option-F 

3fl. F 

~J 

a&Shift-D 

a&Shift-N 

Shift-. 

Option-. 

3fl. y 

3fl.G 

3fl.? 

a&Shift-1 

3fl. L 

a&Shift-L 

Shift-, 

Option-, 

:l&H 

Shift-8 

Tab 

Option-= 

a&Shift-M 

~M 
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Action (continued) Key(s) 

Outline ~Shift-0 

Page number ## 

Paste current date ~Shift--

Plain text ~SJlift-P 

Previous field Shift-Tab 

Preview 31:- u 

Print (bypass dialog box) ~Option-P 

Record number @@ 

Refind 31:-R 

Replace fie ld 31:- = 

Right-justify ~Shift-R 

Script most recent 31:-H 
actions 

Send backward ~Shift-J 

Shadow ~Shift-S 

Son 3&-S 

Tsquares 31:-T 

Time, current .. 
Time, paste current 3&- ; 

Underline ~Shift-U 

Ungroup ~Shift-G 

Unlock ~Shift-ff 

Zoom ~Shift-Z 
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, MacDraw Quick Keys l .. iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

The following commands are based on MacDraw II 
Version 1.1. 

Action Key(s) 

Align 3&-K 

Autogrid 3C-Y 

Bold text 3&-B 

Current 100% view a&Shift·M 

Down one layer a&Down arrow 

Fit to window 3&-M 

Group e le ments 3&-G 

Help 3C-! 

Italic :It-I 

Library 3&-1 

Lock a&H 

Magnify view a&Right arrow 

Move backward 3C-J 

Move forward 3f:.F 

Move to back a&Shift·J 

Move to front a&Shift-F 

New layer a&Shift-N 

Paste and rescale a&Shift-V 

Plain text a&Shift· P 

Reshape 3C-R 

Rotate 3&-T 

Select all a&Shift-A 

Select all on active layer 3C-A 

Smooth 3&-E 
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Action (continued) 

Spelling 

Underline 

Un group 

Unsmooth 

Up one layer 

Key(s) 

:I&= 

3&-U 

:l&Shift·G 

:l&Shift·E 

:!&Up arrow 

, PageMaker Quick Keys ... , iiiiiiiiiiiiiiiiiiiiiiiii 

The following key combinations are available when 
using Aldus PageMaker Version 4.0. 

Action Key(s) 

25% view x.o 
50% view X.5 

75% view X.7 

100% view X.1 

200% view X.2 

400% view X.4 

Actual size X.1 

All caps :l&Shift-K 

Align center :l&Shift-C 

Align left :l&Shift-L 

Align right :l&Shift-R 

Auto leading :!&Shift-A 

Bold :l&Shift-B 

Bring to front X.F 

Center :l&Shift-C 

Change X.9 

Circle tool Shift-F7 
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Action (continued) Key(s) 

Color pale tte ~K 

Cropping tool Shift-PS 

Define styles ~3 

Diagonal line tool Shift-F2 

Edit story ~E 

Find ~8 

Find and change ~9 

Find next ~. 

Fit in window 3CW or XOption-click 

Force justify XShift-F 

Go to page ~G 

Guides ~J 

Help ~? 

Hyphenation ~H 

Increase point size XShift-. 

Indents ~· 
Index entry ~; 

Italic XShift-1 

justify XShift-J 

Line tool, perpendicular Shift-F3 

Line tool, diagonal Shift-F2 

Links ~ = 

Move window Option-drag 

Move window, constrained Shift-Option-drag 

Next page a&Tab 

Nonbreaking hyphen aGOption- (hyphen) 

Outline text :l&Shift-D 

Page number marker XOption-P 
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Action (continued) 

Paragraph 

Perpendicular line tool 

Place 

Point size, larger 

Point size, smaller 

Point size, standard, larger 

Point size, standard, smaller 

Pointer tool 

Previous page 

Rectangle tool 

Reduce type size 

Replace 

Rounded rectangle tool 

Ruler 

Select layer 

Send to back 

Shadow text 

Small caps text 

Snap to guides 

Snap to rulers 

Spelling 

Strikethru text 

Style palene 

Subscript text 

Superscript text 

Tabs 

Text tool 

Toolbox 

Key(s) 

3€-M 

Shift-F3 

3€-D 

3€ -Shift-Option-. 

3€-Shift-Option-, 

3€-Shift-. 

3€-Shift·, 

Shift-Fl or 3€-Spacebar 

3€-Shift-Tab 

Shift-F5 

3€-Shift-, 

3€-D 

Shift-F6 

3€-R 

3€-click 

3€-B 

3€-Shift-W 

3€-Shift-H 

3€-U 

3€-[ 

3€-L 

3€-Shift-/ 

3€-E 

3€-Shift-

3€-Shift-= 

3€-1 

Shift-F4 

3C6 
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Action (continued) 

Type specs 

Underline text 

Undo/redo last operation 

Zoom in/out 

Key(s) 

3C-T 

3C-Shift-U 

ac.z 
:JCQption -click 

i superPaint Quick Keys la-~;;;;;; 
The following key combinations are available when using 
SuperPaint 2.0 from Silicon Beach Software. 

Action Key(s) 

Actual size :JCShift-R 

Align objects 3C-M 

Autotrace bit map 3C-T 

Bold 3&8 

Bring to front 3& = 

Change current layer 3&/ 

Duplicate element 3C-D 

Fit in window :JCShift-W 

Full screen 3C-F 

Grid :JCShift-G 

Group 3C-G 

Hide/show all palettes 3C-H 

Hide/show back layer 3C-L 

Increase one point size :JC Shift-. 

Italic 3&1 

Left-justify :JCShift-L 

Nudge Up ag.y 

Nudge Down 3C-M 
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Action (continued) Key(s) 

Nudge Left a&J 

Nudge Right a&K 

Object info 3&1 

Outline text a&Shift-0 

Plain ag.p 

Print 3& ; 

Reduce one point size a&Shift-, 

Reduced view ac.w 
Right-justify 3G-Shift-R 

Scrolling on/off 3G- ' 

Send to back ag. . 

Underline a&Shift-U 

Ungroup ac.u 
Zoom in a&E 

Zoom in 800% :J&Shift-E 

4word Quick Keys a;;;I ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;; 

The following key combinations are available when 
using Microsoft Word Version ·4.0. 

Action Key(s) 

Activate next window Option-OOW 

Add to menu Option-00+ 

Again 3G-A 

All caps :J&Shift-K 

Assign style :J&Shift-S, type name 

Bold :J&Shift-8 

Calculate 3& = 
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Action (continued) 

Center text 

Change 

Character 

Define styles 

Delete next character 

Delete next word 

Delete previous word 

Dotted-underline 

Double space 

Double-underline 

Find 

Find and Change 

Find formats 

First line indent, 
nudge 1/2 inch 

Font 

Footnote 

Glossary 

Go to page 

Hanging indent, 
nudge 1/2 inch 

Help 

Hidden 

Hide symbols 

Italic 

justify text 

Left-justify text 

Left margin, indent, 
nudge 1/2 inch (nest) 

Key(s) 

:l&Shift-C 

3&-H 

:l&D 

Shlft-F3 

Option-3&-F 

Option-3&-G 

Option-3&-Backspace 

:!&Shift-\ 

:l&Shift-Y 

:!&Shift-[ or Shift-F12 

3&-F 

3&-H 

:l&Option-R 

:l&Shift-F 

:l&Shlft-E, type name 

3&- E 

3&-K 

:l&G 

:l&Shlft-T 

:!&/ or Help 

:l&Shift-X 

ag.y 

:!&Shift-I 

:!&Shift-] 

:l&Shift-L 

:l&Shlft-N 
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Action (continued) 

Left margin indent, 
nudge 1/2 inch (unnest) 

Menu mode 

Normal text 

Normal style sheet, 
change selection 

Outline 

Outlining 

Page view 

Paragraph 

Plain text 

Point size, increase 

Point size, decrease 

Preview 

Remove from menu 

Re paginate 

Right-justify text 

Ruler 

Show symbols 

Small caps 

SpeUing 

Split window 

Strikethrough 

Style 

Styles, define 

Symbol character 

Underline 

Underline word 

Zoom 

Key(s) 

S&Shift-M 

. (numeric keypad) 

S&Shift-Spacebar 

S&Shift-P 

:l&Shift-D 

ac.u 
S&B or F13 

a&M 

:l&Shift-Spacebar 

S&Shift-> 

S&Shift-< 

a& I 

Option-a&- (minus) 

a&J 

:l&Shift-R 

a&R 

ag.y 

:l&Shift-H 

a&L 

Option-S&S 

S&Shift-/ 

:l&Shift-S, type name 

a&T 

a&Shift-Q 

a&Shift-U 

:!&Shift-] 

Option-a&] 
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Accelerator board. An option card that enables your Mac to operate and 
manipulate data at a faster rate. 

Active window. The copmost window on the desktop, deno ted by a 
highlighted title bar. 

ADB. See Apple Desktop Bus. 

American Standard Code for Information Interchange (ASCII). A 
standard computer text format in which each character is represent· 
ed by seven bits. See also Text file. 

Apple Desktop Bus (ADB). The connectors on the back of the Macin­
tosh that allow connection of the keyboard, mouse, joysticks, 
graphics tablets, touch screens, track balls, and so forth , up to 16 
input devices. See also Input device. 

AppleShare. An operating system designed to enable a Macintosh co 
become a server co other Macintosh computers on the same network. 

AppleTalk. A local area network standard used to connect Macintosh 
computers and to allow sharing of peripheral devices, such as 
printers. AppleTalk is the communication protocol by which data is 
transferred. See also Protocol. 

Application. A program that allows the user co create, enter, and design 
information. Examples are word processors, spreadsheets, and 
paint programs. 

ASCII. See American Standard Code for Information Interchange. 

Assembler. A program that translates symbolic codes, o r assembly 
language, to machine language. 

Asynchronous communication. A means of transmitting data between 
computers. A special signal indicates when each character starts and 
scops. 

BBS. See Bulletin Board System . 

Background execution. A program that can continue operating without 
user commands and without interrupting a procedure operating in 
the foreground. See also MultiFinder, Multitasking, and Spooler. 

BASIC. See Beginner 's All-purpose Symbolic Instruction Code. 

Baseline. In typography, the lowest point characters reach (excluding 
descenders). See also Descender. 

Baud rate. A measure of speed equal to one signal per second. Common 
baud rates are 1,200 and 2,400. 
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BBS. See Bulletin Board System. 

Beginne.r's All-purpose Symbolic Instruction Code (BASIC). A com­
mon programming la nguage that is easy to learn but relatively 
inflexible. 

Beta test. The first test outside of the laboratory of a new product. This 
test is the final step before a full market release. 

Bezier curves. (Pronounced bez '·ee·ay) Mathematical equations that 
describe the out.lines that create PostScript fonts. 

Binary. A numbering system based on a series ofones (ls) and zeros (Os) 
used to encode text and numerical infonnation. 

Bit. A binary digit; the smallest unit of computer infonnation. A I or a O 
code electronically represents, respectively, on o r off. 

Bit-mapped image. An image consisting of dots, in which one dot 
represents one or more bits of the image (depending on whether 
color or other attributes arc used) . A Mac Classic uses one b it per dot. 
See also Font. 

Bomb. An abnonnal tennination of a program. A bomb occurs when a 
program unexpectedly halts due to a bug, or it encounters data 
conditions it cannot handle. See also Bug. 

Boot. To start a computer by loading the operating system (the System 
and Finder) into memory. The operating system software tells the 
Macintosh how to load other programs. 

Bridge. A device that lets you connect networks so that members on one 
network can communicate with members on another network. See 
also Gateway. 

Buffer. A section of memory that temporarily holds information from 
1/0 (input/output) communications, including data transfer via 
modem, or reading and writing to your disk. The buffer holds 
information when the computer is sending infonnatlon faster than 
the device can receive it. See also Spooler. 

Bug. A problem in a software program. An inappropriate or inaccurate 
line of programming code that causes the program to halt execution 
or respond incorrectly. Initially named after a moth that caused the 
failure of an early computer at Harvard University in 1945. See also 
Bomb. 

Bulletin Board System (BBS). A telecommunications facility used to 

share infonnation with others through the use of a modem and 
specialized communications software. 

Bus. A path through which information is shared between one part of a 
computer and another. See also Apple Desktop Bus. 
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Byte. A measure of the amount of information equivalent to the memo ry 
needed to store a character of the alphabet. 1,024 bytes are equiva­
lent to IK of memory. A byte is made up of eight bits; it has eight Is 
and Os per byte. See also Bit. 

Cache. (Pronounced "cash.") A special section of RAM memory reserved 
for frequently used applications and utility information. 

CDEV. See Control Panel Device. 

Central Processing Unit (CPU). The computer's main information pro­
cessing unit. In a Macintosh, the CPU is a single silicon chip called the 
microprocessor. 

Chip. A tiny piece of silicon with an integrated eleccronic circuit o n its 
surface. 

Chooser. A desk accessory that allows you to select a printer on which to 
print. For the Chooser to functio n, the printer resource files must be 
present in the System Folder. In a networking environment, the 
Chooser can be used to connect and disconnect from the network 
as well as to choose among devices connected to the network. 

Click. A quick press-and-release of the mouse butto n. 

Clip art. Artwork purchased on disk. Clip art can be a bit-mapped graphic 
image, an object graphic, or even an Encapsulated PostScript file. 

Clipboard. A temporary storage location, which holds cut and copied 
information. See also Scrapbook. 

Close box. A small box located at the upper left corner o f a document 
window. Clicking inside the close box causes the program to prompt 
the user to save changes to the document and close the current 
window. 

CMYK. The four colors used in the color separatio n p rocess that can be 
combined to form any other color: Cyan, Magenta, Yellow, and 
Black. 

Cold boot. Turning o n your Macintosh with the power switch. 

Color separations. A process used in offset printing in which separate 
plates are used to print different colors of lnkon a page with multiple 
colors. As the name implies, each color has its own plate. 

Computer-aided design (CAD). Applications that take advantage of the 
power of the computer to design architectural, mechanical, electri­
cal, civil, schematic, IC, and various other types of drawings. 

Control Panel. A desk accessory used to personalize such features as the 
pattern on the desktop, the speed of the mouse movement, and the 
volume of the warning beep. 



The Little Mac Book ===================== 

Control Panel Device (CDEV). A utilicy program placed in the System 
Folder and controlJed from the Control Panel. 

Coprocessor. A microchip that assis!S the main microprocessor with 
data-imensive tasks such as large spreadsheet, large database, com­
plex statistical analysis, or graphics activities. 

Copy. A command used to make an exact replica of anything-a lener, an 
entire document, a graphic, an application, or even a disk. The Copy 
command is located under the Edit menu. Using Copy does not 
modify or delete· d1e original. See also Clipboard, Cut, Paste, and 
Scrapbook. 

Copy protection. A method of preventing unauthorized duplication o r 
use of software. See also Write-protect tab. 

CPU. See Central Processing Unit. 

Crash. When your Macintosh gives you that dreaded "bomb"-forcing 
you to restart; or when the Mac keyboard freezes up and won't do 
anything. 

Cursor. An icon indicating the current mouse location on your screen. 
The Macintosh has a variecy of cursor shapes including a vertical bar, 
I-beam, pointer, and wristwatch. See also Insertion point. 

Cut. A command that removes selected information from a document and 
temporarily places it in the Clipboard. See also Clipboard, Copy, Paste, 
and Scrapbook. 

DA. See Desk Accessory. 

Data. The information processed by a computer application. 

Database. A collection of related information organized fo r storage and 
retrieval. For example, a database may contain nanJes, addresses, 
and phone numbers. 

Delete key. A key you press to remove information from a document. See 
also Cut. 

Descender. The portion of a lowercase lener that hangs below the 
baseline. Five letters of the alphabet have descenders: g , j, p, q, 
and y. 

Density. A measurement of the amount of information (in bi!S) that can 
be packed reliably into a square inch of magnetic media, such as a 
floppy disk. See also Disk and Floppy disk. 

Desk Accessory (DA). A small application located in the System file , that 
is accessible from the Apple menu. Examples are the Alarm Clock, 
Chooser, and Control Panel. 
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Desktop. The work area of the Macintosh. The screen, d isk icons, trash 
can , and menu bar that you see when you first start your Mac. 

Desktop file . An invisible file on all Macintosh disks that contains the 
information the Finder uses to locate files, folders, and ico ns. 

Desktop publishing. A package that combines page layout, text entry, 
and graphics design into one application. 

Dialog box. A message from the Macintosh requesting further action or 
information fro m the user . In most instances, the user responds by 
typing a response or dicking a button . 

Disk. A device utilizing a magnetic medium designed to store infom1a­
tion. The Macintosh uses 3 1/2-inch hard-case floppy disks. Disks can 
be floppy disks or hard disks. A typical floppy disk can be single­
density (400K), do uble-density (SOOK), or high-density (l.4M). Hard 
d isks can range from lOM to more than a gigabyte. 

Disk drive. A disk drive holds the disk and retrieves and sto res informa· 
tion. A floppy d isk drive (3 1/2-inch) ho lds the floppy disk that the 
user inserts. A hard disk is a high performance storage device 
consisting of planers coated with magnetic media. A hard d isk is 
protected by a scaled case . 

Document. A generic term describing whatever the user creates using an 
applicatio n o n the Macintosh. A document can be a letter, ankle, 
picture, table, o r spreadsheet worksheet, among others. A document 
cont.a.ins the information the user has entered and saved . 

Dot-matrix printer. A printer that forms cha.racters and graphics out of 
dots. 

Dots per inch (dpi). A measure of screen and printer resolutio n . The 
higher the number the better the resolution. The ImageWrite r 11 
operates at 144 dpi, and the LaserWriters operate at 300 dpi. See also 
Resolution . 

Double-dick. Used to open applications, d ocuments, or fo lders. Dou· 
ble-clicking is performed by clicking the mouse button twice in rapid 
succession. 

Download. A procedure in which a u ser transfers data from a remote 
computer 's database to the u ser's computer and sto res the data on 
a hard or floppy disk. 

Downloadable font . A font that is sent from your Macintosh to your 
printer. 

Dpi. See Dots per inch. 



The Little Mac Book ==================== 

Drag. A technique used to move ico ns from one location to another, such 
as moving a file from one folder to another. To drag an item, move 
the mouse to position the cursor over an ilem. Press and ho ld the 
mouse button, and move the mouse tO position the item in the 
desired location. Release the mouse button to "plant" the item in that 
location. 

Driver. Software that tells the Macintosh how to operate an external 
device, such as a printer. A driver is located in the System Folder. 

E-Mail. A messaging system that enables users to send and receive .. mail .. 
to and from other people o n the electro nic network. 

Emulation. A fearure that enables o ne device to imitate another. 

Encapsulated PostScript (EPS). A file format that uses PostScript lan­
guage to store an image. 

Encryption. The substitution of characters to hide the contents of a 
document. 

EPS. See E11capsu/ated PostScript . 

Ethernet. A standard for local area network hardware. 

Expansion card. An internal board you attach to your system that enables 
features to be added to improve processing capability, telecommu­
nications capability, and so on. 

Expansion slot. A location inside your Macintosh that allows you to 
install a card to perform additional functions. 

FAX (facsimile transmission). The transmission of informatio n fro m 
printed page to printed page through a telecommunications device. 

File. Information stored on a disk. Also called a document. 

File format. The set of instructions or pattern used to store information. 

File server. An item o n a network that makes available ro all users a disk 
drive and software. File-server software contro ls access to individual 
files and multi-user software allows several users simultaneous 
access to the same file. 

Finder. Pan o f the Macintosh operating system that keeps the desktop 
organized , allowing the user to find and o pen files or folders. The 
Finder file must be present in the System folder o n a startup disk. 

Fkey. A utility program executed by pressing o ne of the function keys at 
the top of an extended keyboard. 

Floppy disk. A 3 1/2-inch flexible disk contained within a semi-rigid 
plastic casing. See also Disk. 
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Folder. An item on the desktop that holds icons for related information 
in one location-just like the folder.; you have in your file cabinet at 
the office. A folder can contain files, other folders, graphics documents, 
or any type of information. 

Font. A collection of letters, puncruation marks, numbers, and symbols 
that appear in the same typeface, style, and size. The Macintosh 
comes with a number of different fonts, such as Monaco, Chicago, 
and Geneva. Sec also Bit-mapped image, Outline fonts, and Post­
Script. 

Font/DA Mover. A Macintosh utility that moves fonts and desk accessories 
from one system to another or from a floppy disk t0 a system. 

Font substitution. A Macintosh activity that substirutes one font for 
another when the font required by a particular application is not 
available. 

Format. See Initialize. 

Freeware. Macintosh software shared without cost tO the user, with the 
intention that the software will be shared by others and distributed 
throughout a large network of users. 

Function key. A key that you can program to perform a particular 
function. 

Gateway. In a compute.r network, the hardware and software used to 
connect two different types of computer networks. Sec also Bridge. 

Gigabyte (G). One billion bytes (1 ,073,741 ,824 bytes). 

Graphical User Interface (GUI). A description of an interface between 
a user and a computer that uses menus and icons to represent 
commands and Ales. 

Hard copy. A printout on paper, as opposed to data stored in memory or 
on disk. 

Hard disk. A disk housed inside or outside a system unit that contains 
permanently installed disks. A hard disk ho lds much more informa­
tion than a floppy disk and operates faster. 

Hardware. The physical parts of the Macintosh. The screen, keyboard, 
mouse, disk drives, casing, cables, and all the electronic mechanisms 
and boards inside the Macintosh. 

Highlight. To select something so that it appears different from the 
surrounding information. When a piece ofinformation is highlighted, 
the user can initiate a command to modify that information. For 
example, you highlight a word and change the font. 
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HyperCard. A user-modifiable, object-oriented environment. With a 
scripting language called HyperTalk, you program HyperCard co 
create applications called stacks. Stacks are made up of cards chat 
have buttons, ico ns, and fidds which can perform o ther functions or 
can be linked to other stacks or cards. See also HyperTalk. 

HyperTalk. "The programming language used to program HyperCard 
stacks and create user-defined functions. HyperTalk is an English­
like scripting language. See also HyperCard. 

Hypertext. The retrieval of text and ideas throughout various documents 
and files without regard co order. 

I-bea m. The shape of the cursor when you enter or edit text. 

Icon. A graphic representation of a file, folder, disk, o r command. An icon 
is simi.lar to a sign representing information. For example, a file is 
generally represented as a sheet of paper, and a folder looks like a 
manila fo lder. 

lmageWriter. A dot-matrix printer designed specifically fo r use with a 
Macintosh. 

Initialize. To prepare a disk fo r use o n your~-ystem. Generally, initializing 
a disk means that the Macintosh will clear off any data on the disk and 
structure the disk into sectors and tracks. Also called "formatting." 

INIT. A utility file located in the System Folder that executes during a 
system start or rescan. 

Input device. A device that inputs info rmation into your Macintosh such 
as mouse, keyboard, trackball, o r graphics tablet. 

Insertion point. The locatio n in a document where the user may insert 
something. The insertion point is designated by positioning the 
cursor where you want the insertion to occur and clicking o nce. A 
blinking I-beam appears at that point. See also Cursor. 

Integrated software. A software package containing a spreadsheet, 
database, word processor, and telecommunications in which the 
component p rograms can freely exchange data. 

Interface. An electronic link between different computer devices such as 
the compute r and a mouse. 

Invisible file. A file that does not appear on the desktop and cannot be 
copied, erased, or moved . 

K.. Sec Kilobyte. 

Kerning. Adjusting the spacing between letters. Typically used to reduce 
the space between pairs of letters. 
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Kilobyte (K). One thousand (1,024) bytes. A common measure of file 
size. A typical page of plain text is 2K. 

LAN. See Local Area Network. 

Landscape. A page orientation in which the printer prints the image 
horizontally. The page top is the longest side of the paper. 

Laser font. An easily scaled font defined by mathematical formula. 

Laser printer. A printer that forms characters and graphics by moving a 
laser beam across a photoconductive drum. The printer then projects 
the image onto paper. Macintosh laser printers are called LaserWrit­
ers. See also Toner. 

Launch. To start an application. 

Leading. The amount of vertical spacing, in points, between baselines of 
type. 

Lisa. The first computer that used the Mac interface induding the mouse 
and icons but that was no t successful because of its high costs. 

Local Area Network (LAN). Computers linked with cables and software. 
The computers can share files and e.xternal devices, such as printers 
and disk drives. Many offices are linked with LANs to improve 
communication and efficiency. 

LocalTalk. The hardware portion of Apple's lAN system used to connect 
Macs to LaserWrlters and other Macs. 

Logic board. The board inside the Macintosh responsible for organizing 
and executing instructions. 

M. See Megabyte. 

MacBinary. A format that enables Macintosh files to be stored on non-Mac 
machines without any loss of informatio n. 

Macro. A small co mputer program, usually developed with a macro 
maker application, that you program to do repetitive tasks simply by 
typing a key combination. 

Marquee. The doned box drawn with a mouse around items to highHght 
the items. 

Megabyte (M). A measure o f size representing one million (1,048,576) 
bytes of storage capacity o n a disk or in RAM. 

Memory. The primary location within the computer that stores internal 
instructions. 

Menu. A list of commands available to the user. 
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Menu bar. An area at the top of your Macintosh screen that Lists available 
commands. 

Microprocessor. A small silicon chip containing a huge number of 
electronic components. The microprocessor chip can operate on 
large amounts of information when used with other computer 
components. 

Modem (modulator/demodulator). A peripheral device that allows 
computers to communicate by telephone lines. 

Moire. (Pronounced "mwah ' ray.") An optical illusion perceived as 
flickering, that occurs when high-contrast line patterns ace too close 
together. 

Monitor. A color or monochrome screen associated with a computer. 

Motherboard. The main board (also called the logic board) in the 
Macintosh that contains the central processing chips, RAM, and 
expansion slots. 

Mouse. A device used to navigate on the Macintosh screen. You use a 
mouse to select information and issue commands. When you move 
the mouse, the cursor moves on-screen In the corresponding di­
rection. 

MultiFinder. Part of the system that allows the user to load into memory 
multiple applications and switch between them. MultiFinder also 
allows for concurrent tasks to take place at (seemingly) the same 
time. This process is also known as multitasking. 

Multimedia. Information presented combining graphics, text, and sound. 

Multitasking. A computer capability in which two or more programs are 
loaded into memory simultaneously. The CPU attends to all pro­
grams at once by switching back and fonh between them, which is 
called time slicing. See also MulttFinder. 

Nanosecond. One billionth of a second. 

Network. A communications pathway using hardw.ire and software that 
links multiple computers and peripheral devices so that each com· 
puter or device shares information. See also Node. 

Node. A de"ice on a network that can send and receive information. See 
also Network. 

NuBus. A high-speed information pathway for the Mac ll family of 
computers. 

Null modem. A cable connecting two computers. Used instead of a 
modem for communication purposes. 
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Object-Oriented Programming (OOP) A programming language in 
which program elements are conceprualizcd as objects that can pass 
messages to each other. 

OCR. See Optical Character Recognftion. 

On-line help. A file contained within an application that provides help 
while you operate the application. 

Open. The act of accessing a document for modification or viewing. 

Operating system. The software that controls the functioning of the 
Macintosh and the direction of information flow among computer 
components. 

Optical Character Recognition (OCR). A technology by which printed 
characters are optically scanned and translated into software text 
that the computer can process. 

Optical disc. A disc on which data (or music) is recorded in the form of 
small deformations. The data is retrieved with a laser beam. 

Outline font. A PostScript font formed of outlines, which arc then filled 
in. See also Bit-mapped image, Font , and PostScript. 

Page Description Language (PDL). A language used to affect printer 
output. 

Parallel port. A connection to a computer through which eight or more 
bits are transmined simultaneously in one direction. See also Disk 
drlue. 

Parameter RAM (PRAM). Memory devoted to certain system settings 
such as the time, date, and the alarm clock. PRAM is stored in a battery 
inside your system. 

Parity bit. An extra bit appended to a character whose value is used to 
check for errors in the transmission of data. 

Partition. A physically separate section on a hard disk that you can use 
with the same o r a different operating system. 

Paste. A command that places a copied or cut piece of information at the 
insertion point in a document. The Paste command retrieves from 
the Clipboard information that has been copied or cut. 

Path. The hierarchical directions to a folder, application, or document 
file . 

Peripheral. A unit of hardware, such as a primer, modem, or hard disk 
drive. Cables connect peripheral devices to your Macintosh. 

Pica. A unit of measure equal to 12 points, or approximately 1/6th inch. 
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Phosphor. A chemical material used to coat the inside of cathode ray 
tubes on which electrons are targeted to produce images. 

PICT. An object-oriented graphic format used to store documents. 

Pixel. A single dot or picture element on the Macintosh display. 

Platform. A computer hardware standard, such as Macintosh or IBM PC-
compatible, in which there is a comprehensive approach to the 
computer solution of a problem. 

Platter. The glass or metal circular component o f a hard disk that spins 
and on which information is written and from which information is 
read. 

Point. A unit of measure used to indicate size ofline or type. There are 72 
points in an inch. 

Pointer. One of the shapes of the cursor. Usually, the pointer is an arrow 
pointing upward and to the left. 

Port. A socket on the back of the Macintosh that allows you to connect a 
printer cable, hard disk drive, modem, keyboard, or mouse to your 
Macintosh. 

Portrait mode. A page orientation in which the top of the printed image 
is along the short side of the paper. 

PostScript. A page description language written by Adobe Systems, Inc. 
that prepares an image for printing o n a laser printer. PostScript 
fonts--widely recognized as the standard in near-typeset quality 
printing-are used with PostScript-compatible printers only. 

PostScript interpreter. A code built into PostScript-compatible printers 
that converts PostScript commands into a language the printer can 
process to create an image or character. 

PRAM. See Parameter RAM. 

Printer driver. The software containing the instructio ns that enable the 
compucer to communicate with a particular type of printer. 

Printer foot. A font des igned for printing rather than just for d isplay. 

Print-spooling. The process by which documents to print are stored in 
a memory outside o f the computer's RAM, enabling computer 
processing to continue. 

Program. A set of instructions that tells a computer what to do. 

Programmer's switch. A plastic switch that comes with aJJ Macs. You can 
place the switch on the side of your Macintosh to enable you to 

reboot the computer and access the Macintosh debugging utility. 
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Programming language. A language used to write programs for the 
Macintosh. There are many languages, including Object Pascal, 
C++, BASIC, FORTRAN, and SmaJITalkN. 

Proportional spacing. In cypesening o r printing, a sening that allows 
wider letters to take up more space than narrower letters. 

Protocol. In computer telecommunications, the set of rules and proce­
dures determining how information travels bet:wcen computers. 

Public domain software. Software that can be copied without copyright 
infringement. 

QuickDraw. A computer code that resides in the Macintosh's ROM and 
facilitates the generatio n of images for the screen and printer. 

RAM cache. (Pronounced "cash.") A portio n ofRANl that you can designate 
to hold disk information. You change RAM cache senings from 
within the Control Panel. 

RAM disk. A program that fools your computer into recognizing disk 
space as additional memory. 

Random-Access Memory (RAM). The part of the Macintosh's memory 
that allows for the temporary storage of information. Informacion 
left in RAM is lost when you turn off your Macintosh. 

Read-Only Memory (ROM). Memory that scores permanent system in­
formation and contains the information needed to start up your 
machine. 

Reboot. To restart the computer. 

ResEdit. A utility that enables you to edit application resources. ResEdit 
allows you to customize appl ications, change menu commands, or 
modify the appearance o f the trash can icon. 

Resolution. The number of dots per inch displayed on a screen o r 
printer. The Macintosh Classic screen, for example, has a resolution 
of72 dpi. A LaserWriter has a resolution of300 dpi. Sec also Dots per 
inch. 

Restart. To reset a compucer to ics start-up state without turning off the 
power. The Macintosh has two procedures for restart: menu com­
mand and the p rogrammer's switch. Also referred to as a warm boot. 

Re turn key. The key located on the right side of the main keyboard. 
Similar to the Enter key. 

ROM. See Read-Only Memory. 

Run. To execute a program or an application. 
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Sans se.rif. (Pronounced "san -serr ' -if.") A typeface that lacks fine cross 
strokes across the ends of the main strokes. Helvetica and Geneva 
are examples of sans serif typefaces. See also Serif 

Save. To store information on a disk. 

Save As. To store the current document using a different name o r file 
format. 

Scanner. A device used to capture graphics and text on paper to a disk 
format for use in Mac applications. See also Optical Character 
Recognitio11. 

Scrapbook. A desk accessory used to score pictures and 1ext. You access 
the Scrapbook at any time through the Apple menu. In contrast to the 
Clipboard, the Scrapbook stores information permanently. 

Screen dump. A picture of the contents of the screen sen! to a file or 
printer. 

Screen font. A font used for on-screen display. 

Screen saver. A utility that prevents image "bum in" by automatically 
filling the screen with animatio n during a period of user inactivity. 

Script. A series of commands written in a programming language. 

Scrolling.A method of moving within a document. You use 1hc scroll bars 
located on the right and bottom o f the screen, to navigate to view 
different ponio ns of a window or document. 

SCSI. See Small Computer System Interface. 

SCSI port. A pon located on the back of the Macintosh that allows the user 
to connect a SCSI interface cable from a peripheral device to the 
Macintosh. 

Sector. On a disk, the smallest continuous physical space for saving data. 
See also Track. 

Select. To designate where an action should occur. 

Serial interface. A fo rm of data transmission in which the bits of each 
character are transmitted sequcntiaUy one at a time over a single 
channel or wire. The most common serial interface is RS-232. 

Serial port. A connector on the back of the Macintosh, that allows for the 
connection of serial devices using a serial interface. 

Serif. (Pronounced "serr ' -if.") A small crossbar added to a typeface. 
Courier and Times are examples of serif typefaces. See also Font 
and Sans serif. 
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Server. Any device on a network chat can be shared by all network users. 

Shareware. Copyrighted computer programs that users can try on a trial 
basis. 

Shut down. The process of saving all work, closing all folders and fi les, 
ejecting a ll disks, and turning off the power co the computer. 

Single In-line Memory Module (SIMM). A memory module that con­
tains the chips needed to add 256Kor t M of random-access memory 
to your computer. ASIMM plugs into a mo therboard ora logic board. 

Size box. A box located in the lower right corner of the active window that 
contains two overlapping smaller boxes. Drag the box to increase the 
size of the window, or shrink the window to its previous size. 

Slot. The part of an internal board that can hold a card. 

Small Computer System Interface (SCSI). Pronounced "scuzzy." A 
standard interface that allows the user to connect a peripheral device 
to the Macintosh. 

Software. A generic term fo r computer programs. Software tells hard­
ware how to perform casks. Categories of software include systems 
software, utilities, and specific applications (such as financial pro­
grams, spreadsheet programs and word processors). 

Spooler. A printer softw.ire utility that enables you to send multiple 
documents to a printer and continue working while the printer 
receives each spooled document for printing. 

Star network. A network with the central p rocessor at the center of the 
network and a series of nodes surrounding it in a star pattern. 

Startup disk. A disk that contains the System files the Macintosh needs 
to start itself up. Ascanup disk must contain a System file and a Finder 
file, and generally contains printer resources and desk accessories. 
The startup disk is the first disk Inserted into a floppy disk system. In 
a hard disk system, the hard disk becomes the startup disk and 
automatically boots when you turn on the Macintosh. Sec also Boot. 

Startup screen. The opening screen you see when you boot up your 
Macintosh. You can custo mize the startup screen using most paint 
programs. 

Stop bit. A bit of information that indicates the transmission of a byre is 
completed. 

Style . A format variatio n ofa font that Includes boldface, italic, shadow, 
outl!ne, underline, and strike through, to name a few. 

Style sheet. A set of predefined formats and text commands that you can 
quickly and easily incorporate into a new document. 
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SYLK (Symbolic Link) . A file format developed by Microsoft for spread­
sheets and databases. Used for transferring data between applica­
tions. 

System. A file that contains information the Macintosh uses to operate 
and start up. The Macin1osh will not operate withou1 a System file. 

System Folder. The folder that contains the important System and Finder 
files necessary to boot up and run the Maci ntosh. 

System heap. The area o f memory set aside for s1o ring Sys1em informa­
l ion about files and resources. 

Tab-delimited file. A data file in which tabs separate individual records 
or data elements. 

Telecommunications. Sharing informatio n over phone lines through 
the use of a modem and communicatio ns software. Sec also Modem. 

Tempi.ate. A document tha1 you create for repeated use. Using the Save 
As command, you save each file created wi1h a templa1e 10 a unique 
name. The original 1emplate remains intact for future use. 

Te.rminal emulation. Enables a computer to act Like a terminal for use 
with a hos1 compu1er such as a mainframe. Terminal emulation 
software enables you tu cuslomize the Macintosh to recognize and 
use the control codes required 10 access the host's data. 

Text file. A file tha1 contains sequences of bits that represent characters. 
Also known as an ASCII file. See also A501. 

Thermal-transfer printer. A dot-matrix printer that uses heated pins 10 
melt dots of pigment on paper. 

TIFF (Tagged Image File Format). A file format for scanned images. See 
also Optical Cbaracter Recognition. 

Token-ring network. A network in which information passes from o ne 
node to ano1her through a ring-like shape. See also Star 11etwork. 

Toner. A black powder used in laser printers and photocopy machines. 
The powder serves as an ink in the printing of charac1ers and images. 
Sec also Laser printer. 

Touch screen. A computer screen that allows 1he user to !Ouch the screen 
(rather than use a keyboard or mo use) to activate computer actions 
and commands. 

Track. Concentric circles o n the surface of a d isk that contain darn. One 
or more tracks make up a cylinder of disk space. Sec also Sector. 
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Trackball. A pointing device similar to a mouse. A trackball is essentially 
an inverted mouse; the ball is located on the top of the device, and 
you move the ball. The device remains stationary. See also Mouse. 

Tractor-feed. A device that advances paper by using pins that fit into 
formed holes along the edges o f fanfold computer paper. 

Trash can. An icon on the desktop used to discard files, folders, and 
applications. 

Typeface. The basic font family design such as Times o r Monaco. See also 
Font. 

Type s ize. The height in points of the characters in a font. See also Font 
and Point . 

Typestyle. Versions of a typeface that have become known as separate 
fonts. Examples include italic and boldface. Sec also Font. 

Typography. The science and art of design.Ing aesthetically pleasing and 
readable typefaces. 

UNIX. An operating system developed by Bell Laboratories. UNIX enables 
you to run Severa.I programs at once and is regarded as a powerful 
genera.I-purpose operating system. UNIX is a multiple-platform 
operating system-it runs on different types o f computer systems. 

Upload. A procedure in which you transfer information from your 
computer to a remote computer. 

User group. A group of people who have an interest in a particular 
computer ora particular type of application such as desktop publish­
ing. You find user groups throughout the country. Many groups are 
based at universities and large corporations. 

Video card. A circuit board containing a video controller and related 
components that you connect or plug into your computer tO control 
the video display. 

Video RAM. A section of RAM devoted to screen information. Video RAM 
stores a bit-mapped image of the screen display. See also Random­
Access Memory (RAM). 

Virtual memory. Available space on your hard disk that your computer 
uses to increase the RAM available for application use. 

Virus. A program designed tO alter the normal functioning of your 
computer system. A virus can destroy data, corrupt system files, or 
lock you out of your computer. In many cases, you may be unaware 
that a virus exists on your system until it is too late to pro tect existing 
data. A virus genera.lly passes from disk to disk and from computer 
t0 computer through disk sharing or electronic file transfers from 
bulletin board systems. 
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Virus-protection software. A program that checks existing files and 
applications for the presence of a virus. Some protection p rograms 
ide ntify the strain of virus and attempt to erndicate it. Other software 
just informs you that a virus exists. 

Warm boot. Rescaning your computer without turning the power off and 
on. Yo u can restart your Mac by selecting the Rescan co mmand from 
the Special menu, o r by pressing the Reset butto n on the Programmer's 
Switch. See also Programmer's Switch. 

Window. An area o n the desktop that displays informatio n. 

Word wrap. ln word processing, a text-en try feature that auto matically 
advances your cursor to the next line when text reaches the end of 
a line. Word wrap eliminates the need for p ressing the Return key at 
the end of each line. 

WORM (Write Once Read Many) disk. An optical disk that sto res large 
amounts of information. That info rmation, however, can o nly be 
accessed-no t changed . You cannot write data to a WORM disk. 

Write-protect tab. A small plastic switch built into the casing of a d isk to 
prevent you from accidentaJly erasing or overwriting the contents of 
that disk. When the switch is closed , the d isk is unlocked . You 
thert:fore can write data co that disk. If !he switch is open (or if there 
is a ho le where the switch should be), the disk is locked . Sec also 
Copy protection . 

Zoom box . A box located in the upper right comer of the active window. 
The zoom box enables you to expand and shrink the window. 
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from hard disk to floppy disk, 11 
more than one file , 11 
software, 11 

Ballon Help System (System 7), 
236-237 

batteries, 14 
checking, 15 
replacing, 15-16 

baud rates (modems), 132 
BBS (bulletin board systems), 18 
beep sounds, 16 

adjusting the volume, 16 
changing, 17 
eliminating, 17 

bit-mapped fonts, 9, 92·93 
jaggies, 93 

boing sound, 17 
bombs, 42 
booting, 24 
boxes 

see alen boxes or dialog boxes 
brightness, 35-36 
b ulletin board systems (BBS), 18 

c 
cache, 167-168 

selling amount of memory, 
168-169 

calculator, 22 
cancelling printing, 160 
CDEV (Control Panel Device), 23-24 

changing settings, 24 
copying to your system, 24-25 
System 7. 225-226 

centering text, 25-26 
uncentering texr, 26 

changing 
beep sounds, 17 
fonrs, 94 

size, 94 
styles, 94 

printers, 27-28 
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characters 
special, 189 

quick keys, 249-267 
viewing, 189-190 

Cheshire !NIT program, 109 
Chooser, 27 

checking settings, 27-28 
Claris FileMaker Pro Version 1.0 

quick keys, 270-272 
cleaning mouse, 138 
clink-clank sound, 17 
clip an, 28-30 

copying to scrapbook, 30 
Cllpboard, 31 

pasting from, 153 
viewing contents, 153 

clipboard, 31 
clock, 4-5, 14, 32 

sening, 32 
close box, 33-34 
closing 

active window, 33 
windows, 214 

color monitors, 133-134 
colors, 24, 34 

brightness, 35-36 
changing on the desktop, 34 
hue, 35-36 
saturation, 35-36 
swi1ching IO black and while, 35 

commands 
selecting from menus, 130 
undoing, 206-207 

comments 
attaching 

to files, 97 
to folders, 97 

compressing files , 67-68 
connecwrs, 8 
context-sensitive help, 99-100 
Control Panel, 14, 36 

changing settings, 37 
mouse settings, 137-138 
seuing cache size, 168-169 
System 7, 226-228 

Contro l Panel Devices (CDEVs) , 
23-24 

changing settings, 24 
copying to your sys1em, 24-25 
System 7, 225-226 

convening DOS files into Mac flies, 
48 

Copy command, 38 
copying, 39 

between applica1ions, 39 
CDEVs to your system, 24-25 
clip an to scrapbook, 30 
disks, 11-14 
existing files from desktop, 63 

flies, 11 
from desktop, 77, 63 
from one disk to another, 
76-77 

graphics, 38 
multiple files from one disk to 

another, 77 
!ext, 38 
to clipboard, 31 

correcting typographical errors, 40 
crashes, 43-45 

possible causes, 42 
cutting, 46-47 

cutting and pasting text, 152-153 

D 

data conversio n, 47 
data recovery, 170-171 
Database Access Manager (System 

7) , 228 
databases, 48 

fields , 48 
records, 48 

deactivating INITs, 110 
defaults (alen boxes), 6 
deleting 

applications, 50 
desk accessories, 90 
files, 49, 78, 199 

accidentally, 50 
multiple files, 199-200 

folde rs, 199 
multiple folders , 199-200 

fonts, 90 
items from a folder, 86 
items from Scrapbook, 178-179 
locked files , 50 
text, 40-41 

density, 60 
deselecting objects with mouse, 

136-137 
desk accessories (DAs) , 51 

alarm clock, 4-5 
calculator, 22 
Chooser, 27-28 
Control Panel, 36 
Find File, 81 
installing, 52-53, 87-89, 111-112 

System 7, 235 
Key Caps, 116-117 
Note Pad, 144-145 
removing, 90 
Scrapbook, 177-179 
Svs1em 7, 228-229 

desktop 
color, 34 
copying files from, 77 
files, 53 



copying, 63 
duplicating, 63 
rebuilding, 54 

launching applications, 147 
opening files, 74, 147 
panem, 14, 24 
placing fil es upon, 79 
priming files, 75, 160 
rebuilding, 169-170 
renaming files from, 76 
storing files, 209 

desktop publishing, 9, 55·56 
destination disks, 14 
dialog boxes, 56-57 
directories, printing, 161 
disabling MultiFinder temporarily, 

143 
disk drives, 58 

floppy, 58 
hard, 58·59 
purchasing considerations, 59 
speed, 58 

disks, 60 
copying, 11-14 
densities, 60 
destination, 14 
ejecting, 12·13, 64-65 
erasing, 66 
floppy, 60-61 
hard, 60-61 
initializing, 106-108 
insening, 11 O· I 11 
locking, 120 
recovering data, 170-171 
reinitialiZing, 108 
saving files to , 75 
saving files to alternate disks 

175 ' 
source, 12-14 
unlocking, 120 

DiskTop lNIT program, 109 
documents 

opening auto matically with 
Multifinder, 141 

orientation, 148-150 
DOS files , convening into Mac files 

48 ' 
do t matrix printers, 157 
dots per inch (DPI), 62 
double-clicking with mouse, 137 
DPI (dots per inch), 62 
dragging objects with mo use, 137 
draw programs, 62-63, 99 
drawing marquees with mouse, 

136-137 
drives, 48 
duplicating 

existing files from desktop, 63 
fil es from within an application, 

78 

E 

E-Mail (Electronic Mail), 65 
Edit Copy command, 38 
editing icons with ResEdit, 

172-173 
ejecting floppy disks, 12-13, 64-65, 

200 
Electronic Mall (E·Mail). 65 
emptying Trash, 50, 78, 200 

System 7, 230 
Encapsulated PostScript files (EPS) 

29 • 
erasing 

desk accessories, 90 
disks, 66 
fonts, 90 
items from a folder, 86 

error messages, 67 
Excel Verion 2.2 quic.k keys, 

269-270 
Express !NIT program, 109 
external modems, 132 

F 

fields, 48 
file servers, 8 
FileMaker Pro Version 1.0 quick 

keys, 270-272 
files 

attaching comments, 97 
compressing, 67-68 
copying, 11 

from desktop, 63, 77 
;i~7 one disk to anothe r, 

from one fo lde r to another 
77 • 
from within an application 
78 ' 

creating, 72.73 
within applications, 73 

deleting, 49-50, 78, 199 
multip le, 199·200 

duplicating 
from desktop, 63, 77 
from within an application 
78 ' 

finding, 81-82 
System 7, 231-232 

formats, 68-69 
opening, 7 1-72 
saving, 72 

getting info, 79 
labels (System 7), 239 
locking, 78-97, 120 
moving from one folder to 

another, 76 
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names, recovering, 79 
opening 

from desktop, 74, 147 
fro m within applications, 
147-148 
System 7, 241 

placing on the desktop, 79 
printing, 75 

from desktop, 75 
fro m within applications, 75 

recovering names, 79 
renaming 

from desktop, 76 
from within applications, 76 

retrieving from Trash Can, 200 
saving, 74, 174 

saving as, 80, 175-176 
to ano ther disk, 75, 175 
to anot11er folder, 74 
to fo lders, 175 

screen dumps, 160-161 
searching, 82 
storing on desktop, 209 
troubleshooting , 205 
unlocking, 98, 121 
viewing, 78, 97, 208-209 

System 7, 244-246 
FileShare (System 7), 230-231 
financial programs, 80-81 
Find File desk accessory, 81 
Finder, 83 

installing, 195-196 
mounting, 84 
System 7, 233 
version numbers, 195 

finding fi les, 81-82 
Syste m 7, 231-232 

Fkeys, 84 
predefined, 84-85 

noppy disks, 58, 60-61 
backing up, 12-13 

hard disks, 11 
drives, 58 
ejecting, 64-65, 200 
initializing, 106-108 
insening, 110- 111 
locking, 120 
reinitializing, 108 
troubleshoo ting, 204-205 
unlocking, 120 

folders, 85-86 
attaching comments, 97 
copying files from one folder to 

another, 77 
deleting, 199 

multiple, 199-200 
locking, 97 
moving, 86 
new, 86 

opening, 86 
placing ite ms in, 86 
re naming, 87 
saving Illes to, 74, 175 
System 7. 233-234 

creating new, 234 
renaming, 234-235 

unlocking, 98 
viewing, 97 

Font/DA Mover utility, 87 
fonts, 9, 91 

bit-mapped, 9, 92-93 
changing, 94 

size, 94 
styles, 94 

installing, 87-88 
System 7, 235 

jaggies, 93 
o utline, 93 
pic:is, 91 
po ints, 91 
removing, 90 
screen, 92 
System 7, 243-244 
type size, 9 1 
viewing, 116-117, 189-190 

fonnatting disks, 106-108 
freezing, 42 

G 

games, 95-96 
Get Info box, 96 
graphics 

H 

copying. 38 
file fonnats , 69 
programs, 62-63, 98-99 

hard disks, 58, 60-6 1 
backing up to noppy d isks, 11 
drives, 58 
installing software, 11 2-113 
installing System 7, 237-238 
troubleshooting, 202-204 

hardware 
buying, 18-19 

mail o rder, 127-1 28 
modems, 132-133 

maintenance, 128-129 
monitors, 133-134 
mouse, 134-139 
peripherals, 153-154 
tequiremems 

memory, 166 
MultiFinder, 140 
System 7, 218-219 



res1aning Macs, 173, 185-186 
SCSI devices, 182-183 
shuui ng down Macs, 165 
SIMMs, 186-188 
telecommunica1ions, 197-198 
upgrading, 207 
virtual me mory, 2 I 0-211 

heap, 44 
help, 99 

context-sensitive, 99-100 
Sysiem 7, 236-237 

highlighting text, 101-103 
hue, 35-36 
HyperCard, 103-104 

I 

IAC (System 7) , 237 
icons, 104-105 

aligning, 210 
ediling with ResEdi1, 172-173 

Image Grabber !NIT program, 109 
lmageWriter printers, 105, 106 

printing active window, 160 
printing screen to, 160 

initializing disks, 106-108 
INITs, 108-109 

deactivating, 110 
instaJJing, 109-112 
System 7, 230 

ink je1 prime.rs, 158 
inserting disks, 110-11 1 
installing 

desk accessories, 52-53, 87-89, 
I 11-11 2 
System 7, 235 

Finder, 195-196 
fonts, 87-88 

System 7, 235 
JNITs, 109-112 
SIMMs, 187 
soft,vare, 111-112 

o n hard disks, 1 12-113 
Syste m software, 195-196 
System 7, 237-238 

internal modems, 132 
Isobar, 138-139 

J 
jaggics, 93 

K 

Key Caps desk accessory 
viewing fonts, 116-117 
viewing special characters, 189-

190 

Index 

keyboards, 24, 114-116 
highlighting ICXt, 103 

keyboard shortcuts, 115-11 6 
au applications, 268 

L 

E..xcel Version 2.2, 269-270 
FileMakcr Pro Version 1.0, 

270-272 
MacDraw II Version 1.1 , 273-274 
Microsoft Word Version 4.0, 

278-280 
PagcMaker Version 4.0, 274-277 
special characiers, 249-267 
Supe rPaint Version 2.0, 277-278 

labels (System 7), 239 
landscape orientation, 148-150 
laser printers, 158 
LaserWriter printers, 118 

printing screen m, 161 
launching applications, 119-120 

from desktop, 147 
from Multifinder, 141 

L'lyou1 Manager (System 7) , 240 
letter-quality printers, 105-106 
local area networks 

see networks 
locking 

files, 78-97, 120 
deleting locked files, 50 

floppy disks, 120 
folders, 97 

locking up, 42 

M 

Mac Tools Deluxe utili ty programs, 
170 

MacDraw II Version 1.1, 273-274 
macros, 126-127 
Macinsmsh computers 

choosing, 18-19 
Mac Classic, 125 
converting DOS files into Mac 

files, 48 
Mac 11, 122 
Mac llci, 125 
Mac flex, 124 
Mac HIX, 125 
Mac llsi, 126 
Mac 11.x, 122 
Mac LC, 125-126 
Mac Plus, 121 
Mac Portable, 124 
Mac SE, 121 
Mac SE/30 , 122-124 
maintenance, 18-19 
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pe ripherals, 18· 19 
shopping for, 18-19 
u pgrading, 18-19 

mail, clec1.ro nic, 65 
mail order 

buying hardware, 127-128 
buying software, 127-128 

mainte nance, 18-19 
hardware, 128-129 
mouse, 138 

margins, aligning, 6 
marquee, drawing with mouse, 

136-137 
memory, 44-45, 165 

allocation for MultiFinder, 142 
PMMU (Paged Memory 

Mangement Unit), 154 
RAM cache, 167-168 

setting, 168-169 
requirements, 166 
SIMMS, 186·188 
virtual, 154, 210-211 

System 7, 246-247 
menus, 129-130 

changing blinking rate, 37 
moving between, 130-131 
selecting commands, 130 

messages, 18 
Microsoft Excel Versio n 2.2 quick 

keys, 269-270 
Microsoft Word Versio n 4.0 quick 

keys, 278-280 
mode ms, 18, 132-133, 197-198 

buying, 132-133 
mo nitors, 24, 133-134 

color, 24 
monochrome, 133-134 
switching from colo r to black 

and white, 35 
monkey screech sound, 17 
monochrome monitors, 133-134 
mouse, 24, 134 

cleaning, 138 
deselecting objects, 136·137 
double-clicking, 137 
dragging objects, 137 
drawing marquees, 136-137 
Isobar, 138-139 
mo use pads, 139 
optical mouse, 138-139 
poiming to objects, 135 
repeat rate, 137-138 
selecting objects, 136 

multiple objects, 136 
shift-clicking, 136 
trackballs, 138-139 
tracking rate, 137-138 

moving 
between menus, 214 
calculator computed value, 23 
files from one filder to another, 

76 
folders, 86 
windows, 214 

MultiClip !NIT program, 109 
MultiFinder, 143 

N 

activating, 140 
disabling temporarily, 143 
hardware requirements, 140 
launching applications on 

startup, 141 
memory allocation, 142 
opening documents automati­

cally, 14 1 
switching applications, 140-141 
System 7, 240 

networking, 8, 144 
Norton Utilities for the Macintosh 

utility p rogram. 170-17 1 
Note Pad desk accessory, 144-145 

removing text, 145 
replacing text, 145 
turning pages, 145 

0 
OCR (Optical Character Recogni­

tion), 146 
opening 

documents automatically with 
Multifinder, 141 

files 
from desktop, 147 
with applications, 147- 148 

file formats , 71-72 
fo lders, 86 
windows, 33, 214 

operating systems 
see System 

Optical Character Recognition 
(OCR), 146 

scanning, 176-177 
o ptical mouse, 138-139 
o rientatio n, 148-150 
o utline fo nts, 92-93 

p 

page orientation, 148-150 
Page Serup command, 149-151 
Paged Memory Management Unit 

(PMMU), 154 



PageMaker Version 4.0 quick keys, 
274-277 

paint programs, 98 
paper sizes, 151-152 
parameter RAM (PRAM), 14 
pasting, 39, 46-47 

items from Scrapbook, 178 
text, 152-153 

from Clipboard, 153 
from the Scrapbook, 153 
into the Scrapbook, 153 

peripherals, 18-19, 154 
Personal LaserWriter NT printer, 

119 
Personal LaserWriter SC printer, 

118 
picas, 9 1 
placing 

files , 79 
items in folders, 86 

PMMU (Paged Memory Mangement 
Unit), 154 

pointing to objects with mouse, 135 
points, 91 
portrait orientation, 148-150 
PostScript, 155 

see also fonts 
Encapsulated PostScript (EPS) 

files, 29 
fonts, 10, 92 
printers, 155 

PRAM (parameter RAM), 14 
prede finded !keys, 84-85 
Print Monitor program, 156 
printers 

changing, 27 
dot matrix, 157 
lmageWriter, 105-106 
lmageWriter LQ, 105-106 
inkjet, 158 
laser, 158 
LaserWriter UNT, 118 
LaserWriter llNTX, 118 
LaserWriter SC, 118 
letter-quality, 105-106 
page orientation, 148-150 
paper size, 151-152 
Personal LaserWriter NT, 119 
Personal LaserWriter SC, 118 
PostScript, 155 
printer drivers, 158-159 
QulckDraw, 163-164 
selecting, 27, 159 
test pages, 161 
troubleshooting, 161-162, 

205-206 
printing 

active window, 160 
cancelling, 160 

Index 

directories, 161 
fil es from desktop, 75 
files from within an application, 

75 
from an application, 159-160 
from desktop, 160 
list offiles, 161 
multiple files, 75 
Page Setup command, 

149-151 
paper size, 151·152 
Print Monitor, 156 
print screen 

lmageWrite r, 160 
laserWriter, 161 

print spooler, 156-157 
printer drivers, 158·159 
QuickDraw, 163-164 
screen dump files, 160-161, 179 
selecting printers, 159 
troubleshooting, 161-162 

Programmer's Switch, 45, 163 
programs 

draw, 62-63, 99 
financial, 80-81 
graphics, 62-63, 98·99 
paint, 98 

Pyro! !NIT program, 180 

Q 

quick keys 
all applications, 268 
Excel Version 2.2, 269-270 
FileMaker Pro Version 1.0, 

270-272 
MacDraw U Version 1.1, 

273-274 
Microsoft Word Version 4.0, 

278-280 
PageMaker Version 4.0, 274-277 
special characters, 249-267 
SuperPaint Version 2.0, 277-278 

QuickDraw, 163-164 
System 7 , 241-242 

quitting applications, 165 

R 

RAM (Random Access Memory), 
44-45, 165 

allocation for MultiFinder, 142 
PMMU (Paged Memory 

Mangement Unit) , 154 
RAM cache, 167-168 

Setting, 168-169 
requirements, 166 
SIMMs, 186-188 
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virtual memory, 154, 210-211 
System 7, 246-247 

rebuilding 
desktop files, 54 
desktop, 169-170 

records, 48 
recovering 

data, 170-171 
file names, 79 

reinitializing disks, 108 
removing 

desk accessories, 90 
fonts, 90 
Items from a folder, 86 
text from Note Pad desk 

accesory, 145 
renaming 

files from desktop, 76 
files within an application, 76 
folders, 87 

System 7, 234-235 
repeat rate (mouse), 137-138 
replacing 

batteries, 15-16 
text with Note Pad desk 

accesory, 145 
ResEdit program, 171-173 

editing icons, 172-173 
resizing windows, 214 
resolution, 62 
restarting Macs, 173 

setting starrup, 184-185 
retrieving files from Trash can, 200 

s 
saturation, 35-36 
saving files, 74, 174 

file formats, 71 
saving as, 80, 175-176 
to another disk, 75, 175 
to folders, 74, 175 

scanners, 176-177 
OCR, 146 

Scrapbook desk accessory, 177-179 
deleting items, 178-179 
pasting items from, 178 
pasting text from, 153 
pasting text into, 153 
storing items, 178 

screen dumps, 160-161 
printing, 179 
saving, 179 
System 7, 242-243 

screen fonts, 92 
screen saver programs, 180 

After Dark, 180 
Pyro! , 180 

scrolling, 181-182 
scroll bars, 181-182 
scroll box, 181-182 
windows, 214 

SCSI (Small Computer System 
Interface) devices, 182-183 

searching and replacing text, 
183-184 

searching for files, 82 
System 7, 231-232 

selecting 
commands from menus, 130 
defaults in alert boxes, 6 
Crom Control Panel, 17 
printers, 27-28, 159 
objects with mouse, 136 

multiple objects, 136 
Sec Starrup, 184-185 
setting alarm c.lock, 4-5 , 32 
shift-clicking with mouse, 136 
shutting down Mac, 165, 185-186 
Silicon Beach Software SuperPaint 

Version 2.0 quick key., 
277-278 

SIMMs (Single In-Line Memory 
Modules) , 186-188 

installing, 187 
speed, 186 

size box, 188 
Small Computer System Interface 

(SCSI) device, 182-183 
software 

buying, 20-21 
mail order, 127-128 

database programs, 20-21 
desktop publishing, 20-21 
financial programs, 20-21 
installing, 111-112 
launching applications, 119-120 
locking, 120 
OCR, 146 
Print Monitor, 156 
spreadsheets, 192-193 
System, 194-195 

version numbers, 195 
telecommunications, 197-198 
trojan horse programs, 

211-213 
unlocking, 121 
utility programs, 20-21 , 208 
viruses, 211-213 
word processing programs, 

20-21 , 2 15 
sounds 

beep, 17 
boing, 17 
clink-clank, 17 
monkey screech, 17 



source disks, 12-14 
speaker volume bar, 17 
special charac1ers, 189 

quick keys, 249-267 
viewing, 189·190 

spooler (printing), 156-157 
spreadsheet programs, 192-193 
s1anup, 24 

screen, 193· 194 
setting, 184-185 

storing 
files on desktop, 209 
i tems in Scrapbook, 178 

SUM 11 utility programs, 170 
SuperClock lNIT program, 109 
SupcrPaint Version 2.0 quick keys, 

277-278 
switching applicatio ns with 

Muhifinder, 140.141 
System, 194·195 

installing, 195·196 
multiple Systems, 196 
version numbers, 195 

System 7 
aliases, 223-224 
Apple menu, 224 
AppleScript programming 

language, 225 
CDEV's, 225-226 
compared to System 6, 

220-222 
Control Panels, 226-228 
Database Access Manager, 228 
desk accessories, 228-229 
fileShare, 230·231 
Finder, 233 
finding files, 231·232 
folders, 233-234 

creating new, 234 
renaming, 234-235 

fonts, 243-244 
hardware requirements, 

2 18-220 
help, 236-237 
!AC, 237 
lNITs, 230 
installing, 237·238 

desk accessories, 235 
fonts, 235 

labels, 239 
Layout Manager, 240 
Multifinder, 240 
new features, 217-218 
opening files, 241 
QuickDraw, 241-242 
screen dumps, 242-243 
System Folder, 243 

lndex 

Trash Can , 230 
TrueType, 243-244 
viewing files, 244-246 
virtual memory, 246-247 

systems 

T 

crash, 42 
crashes, 43-45 
heap, 44 

tall orientation, 148-150 
telecommunications, 197·198 

modems, 132-133 
text 

centering, 25-26 
copying, 38 
cutting and pasting, 152-153 
deleting, 40-41 
formats, 70 
highlighting, 101-103 
searching and replacing, 183-184 
uncentering, 26 

time setting, 14 
trackballs, 138·139 
cracking rate (mo use), 137·138 
training, 19 
Trash Can, 13, 198-199 

deleting files, 199 
multiple files, 199-200 

deleting folders, 199 
multiple folders, 199·200 

ejecting floppy disks, 200 
emptying, 49-50, 78, 200 
retrieving files, 200 
System 7, 230 

trojan horse programs, 2ll-2 13 
troubleshooting, 19, 201 

applications, 205 
floppy disks, 204-205 
hard disks, 202-204 
lost files, 205 
printers, 161-162, 205-206 

TrueType (System 7), 243-244 
Type Reunion INIT program, 109 
typefaces see fonts 
typographical errors, correcting, 40 

u 
undoing operations, 206-207 
unlocking 

files, 98, 121 
floppy disks, 120 
folders, 98 

upgrading Macs, 18-19, 207 
utility programs, 208 
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v 
version numbers, 195 
viewing 

Clipboard, 153 
files, 97, 208-209 
folders, 97 
fonts, 189-190 

Key Caps desk accessory, 
116-117 

list of files, 78 
special characters, 189-190 

Virex JNIT program, 109 
virtual memory, 154, 210-211 

System 7, 246-247 
viruses, 211-213 
volume, 16, 24 
volume bar, 17 

w 
warranties, 16, 19 
wide orientation, 148-150 
windows 

activating, 214 
closing, 33-34, 214 
moving, 214 
opening, 33-34, 214 
resizing, 214 
scrolling, 214 
size box, 188 
Zoom box, 216 

word processing programs, 215 
Word Version 4.0 quick keys, 

278-280 

z 
Zoom box, 216 






